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ABSTRACT 
The report documents the user guide and technical basis (models and methods) for the 
NRCDose3 computer code.  This manual provides the end user with instructions to use the 
NRCDose3 code and the bases on updates made to the previous version of the NRCDose 
2.3.20 code.  The NRCDose3 code is a software suite that integrates the functionality of three 
individual LADTAP II, GASPAR II, and XOQDOQ Fortran codes that were developed by the 
NRC in the 1980’s and have been in use by the nuclear industry and the NRC staff for 
assessments of liquid radioactive releases and offsite doses, gaseous radioactive effluents and 
offsite doses, and meteorological transport and dispersion, respectively.  These codes are 
primarily used to support reactor licensing in the evaluation of the safety and environmental 
dose impacts from liquid and gaseous radiological effluent releases.  In general, the basic 
calculation methods (algorithms) of the Fortran codes have not been changed.  In addition to a 
more user-friendly graphic user interface for inputting data, significant changes have been made 
to the data management and operation to support expanded capabilities. 
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1.0 INTRODUCTION 
The NRCDose3 computer code is a software suite that integrates the functionality of three 
individual Fortran codes developed for the U.S. Nuclear Regulatory Commission (NRC) under a 
unified graphical user interface (GUI).  The original development of the NRCDose code (version 
2.3.20 and earlier) was performed by an NRC contractor, Chesapeake Nuclear Services (CNS), 
Inc. for end users including the NRC staff, applicants, and licensees.  The original NRCDose 
code contained the LADTAP II, GASPAR II, and XOQDOQ Fortran codes that were developed 
by and for the NRC in the 1980’s.  These codes have been in use by the nuclear industry and 
the NRC staff for assessments and evaluations of liquid radioactive releases and offsite doses, 
gaseous radioactive effluents and offsite doses, and meteorological transport and dispersion, 
respectively.  These codes are primarily used to support domestic and international reactor 
licensing in the assessment and evaluation of the safety and environmental dose impacts from 
liquid and gaseous radioactive effluent releases associated with routine (normal) plant 
operations and anticipated operational occurrences (AOOs). 

The NRCDose3 code, with its underlying LADTAP, GASPAR, and XOQDOQ Fortran codes, 
implement the calculation methodologies as described in this manual and following NRC 
Regulatory Guides (RGs): 

• RG 1.109, “Calculation of Annual Doses to Man from Routine Releases of Reactor 
Effluents for the Purpose of Evaluating Compliance with 10 CFR Part 50, Appendix I,” 
Revision 1 [Ref. 1]. 

• RG 1.111, “Methods for Estimating Atmospheric Transport and Dispersion of Gaseous 
Effluents in Routine Releases from Light-Water-Cooled Reactors,” Revision 1 [Ref. 2]. 

• RG 1.113, “Estimating Aquatic Dispersion of Effluents from Accidental and Routine 
Reactor Releases for the Purpose of Implementing Appendix I,” Revision 1 [Ref. 3]. 

These dose assessment methods are applied by the NRC staff in its safety and environmental 
reviews and evaluations as prescribed in: 

• RG 4.2, “Preparation of Environmental Reports for Nuclear Power Stations”, Revision 3 
[Ref. 4]. 

• NUREG-1555, “Standard Review Plans for Environmental Reviews for Nuclear Power 
Plants: Environmental Standard Review Plan”, Revision 1 [Ref. 5]. 

• NUREG-0800, “Standard Review Plan for the Review of Safety Analysis Reports for 
Nuclear Power Plants: LWR Edition,” Revision 6 [Ref. 6]. 

1.1 LADTAP II Code 

The LADTAP II Fortran code, described in NUREG/CR-4013 [Ref. 7], implements the liquid 
pathway modeling described in RG 1.109 and RG 1.113.  The LADTAP II Fortran code 
estimates the radiation dose to individuals, population groups, and biota from ingestion (aquatic 
foods, water, and terrestrial irrigated foods) and external exposure (shoreline, swimming, and 
boating) recreational pathways.  The calculated doses provide information for National 
Environmental Policy Act (NEPA) evaluations and for determining compliance with the “As Low 
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As is Reasonably Achievable” (ALARA) philosophy of Appendix I of 10 Code of Federal 
Regulations (CFR) Part 50 [Ref. 8]. 

1.2 GASPAR II Code 

The GASPAR II Fortran code, described in NUREG/CR-4653 [Ref. 9], implements the 
atmospheric pathway modeling described in RG 1.109 and RG 1.111.  The GASPAR II Fortran 
code estimates the radiation doses to individuals and population groups from inhalation, 
ingestion (terrestrial foods), and external-exposure (ground and plume) pathways.  The 
calculated doses provide information for NEPA evaluations and for determining compliance with 
the ALARA philosophy of Appendix I of 10 CFR Part 50.  The GASPAR II Fortran code does not 
estimate radiation doses to biota. 

1.3 XOQDOQ Code 

The XOQDOQ Fortran code described in NUREG/CR-2919 [Ref. 10] implements the 
atmospheric pathway modeling described in RG 1.111.  XOQDOQ calculates the relative 
atmospheric dispersion (X/Q) and relative atmospheric relative deposition (D/Q) values at 
locations specified by the user, and at various standard radial distances and distance segments 
for downwind sectors.  The model is based on a straight-line Gaussian model and the code can 
account for variation in the location of release points, additional plume dispersion due to building 
wakes, plume depletion via dry deposition and radioactive decay, and adjustments to consider 
non-straight trajectories. 

1.4 NRCDose3 Code Update 

The basic calculation methods (algorithms) of the LADTAP II, GASPAR II, and XOQDOQ 
Fortran codes have not been changed with this update to the NRCDose code.  In general, this 
update to the code improves upon the GUI to make it more user-friendly for inputting data while 
also including significant changes to the data management and code operation to support 
expanded capabilities for the NRCDose3 code.  The more significant changes and revisions to 
the NRCDose3 code are summarized below and explained in greater detail in Section 4 of this 
manual. 

1. Support for updated Dose Conversion Factor (DCF).  Previous versions of the NRCDose 
code containing the LADTAP II and GASPAR II Fortran codes only utilized one set of DCF 
values, largely those contained in RG 1.109 and based on International Commission on 
Radiological Protection Report No. 2 (ICRP-2) [Ref. 11] methodology.  The NRCDose3 code 
allows the user to select the ICRP-2 (Default) DCF values, those for exposure to workers 
from ICRP Report No. 30 (ICRP-30) [Ref. 12], or those for public exposure from ICRP 
Report No. 72 (ICRP-72) [Ref. 13]. 

2. Updated age groups.  ICRP-72 uses 6 age groups (infant, 1-year, 5-year, 10 year, 15-year, 
and adult).  RG 1.109 the original basis for LADTAP II and GASPAR II uses 4 age groups 
(infant, child, teen, and adult).  The NRCDose3 code utilizes all 6 age groups, when ICRP-
72 DCF values are selected. 

** User Note ** ─ ICRP-30 based DCF values are only provided for the adult worker; other 
age group DCF values are not provided.  Use of ICRP-72 DCF values by an applicant or 
licensee for a proposed NRC licensing action request (LAR) should be discussed with the 
NRC staff prior to submitting the license request. 
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3. Updated default usage factors.  When ICRP-72 DCF values are selected, the NRCDose3 
code utilizes updated usage (consumption and exposure) factors based on data in the U.S. 
Environmental Protection Agency’s (EPA) EPA/600/R-090/052F (EFH), “Exposure Factor 
Handbook; 2011 Edition” [Ref. 14]. 

** User Note ** ─ The EPA EFH usage factors are different than those in RG 1.109.  Use of 
EPA EFH usage factors by an applicant or licensee for a proposed NRC LAR should be 
discussed with the NRC staff prior to submitting the license request. 

4. Updated LADTAP biota dose calculations.  The LADTAP II Fortran code had limited 
provisions and was revised to update the biota dose model for estimating the radiation dose 
to biota from liquid radioactive effluent releases.  Updated in NRCDose3 are effective radius 
dose factors (as used for calculating the internal doses to biota) and ability for inclusion of 
user defined biota.  For every special location defined in LADTAP, biota doses may be 
calculated for the following species: 

• Fish, 
• Muskrat, 
• Raccoon, 
• Duck, 
• Heron, and 
• User Defined species. 

Refer to Section 6.3 and Appendix D of this manual for technical basis of the biota dose 
model applied in the NRCDose3 code for estimating the radiation dose to biota from liquid 
effluent releases. 

5. Added GASPAR biota dose calculations.  The GASPAR II Fortran code was revised to 
include biota dose models for estimating the radiation dose to biota from gaseous 
radioactive effluent releases.  The GASPAR II Fortran code had no provision for estimating 
biota doses.  For every special location defined in GASPAR, biota doses are calculated for 
the same species as those defined in LADTAP above: 

• Muskrat, 
• Raccoon, 
• Duck, 
• Heron, 
• Cow, 
• Fox, and 
• User Defined species. 

Refer to Section 6.3 and Appendix D of this manual for technical basis of the biota dose 
model applied in the NRCDose3 code for estimating the radiation dose to biota from 
gaseous radioactive effluent releases. 

6. In addition to the changes and revisions described above, other functional improvements to 
the NRCDose3 code include: 

• Updated VBNet GUI, 
• Radionuclide library expanded to 203 radionuclides, 
• Fully user-modifiable parameters for LADTAP, GASPAR, and XOQDOQ, and 
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• Compatibility using Windows 7 and above, and Internet Explorer Version 7 and 
above. 

1.5 Software Quality Assurance and Configuration Management Plans 

CNS-19001, “NRCDose3 Computer Code: Software Quality Assurance Plan,” issued July 2019 
[Ref. 15] documents the NRCDose3 code software quality assurance plan (SQAP).  CNS-
19003, “NRCDose3 Computer Code: Configuration Management and Maintenance Plan,” 
issued July 2019 [Ref. 16] documents the NRCDose3 code configuration management and 
maintenance plan (CMMP).  The NRC has defined three levels of software, per NUREG/BR-
0167, “Software Quality Assurance Program and Guidelines,” issued February 1993 [Ref. 17]: 

(1) Level 1─technical application software used in a safety decision by the NRC. 

(2) Level 2─technical or nontechnical application software not used in a safety decision by 
the NRC. 

(3) Level 3─technical or nontechnical application software not used in a safety decision and 
having local or limited use by the NRC. 

The quality assurance documents are written to conform to the Level 2 requirements.  Code 
development on the NRCDose3 code has proceeded under the SQAP and code CMMP.  CNS-
19004, “NRCDose3 Computer Code: Validation and Validation Report,” issued July 2019 [Ref. 
18] describes the work done to verify proper implementation of the new coding. 

In addition to the SQAP and CMMP described above, the NRCDose3 code was developed 
under a software design document (SDD).  CNS-19002, “NRCDose3 Computer Code: Software 
Design Document,” issued July 2019 [Ref. 19] presents detailed information on the code and 
databases structure, integration of the modified Fortran codes, and definition of 
the supplemental databases used for program operation, data management, and generation of 
reports. 
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2.0 INSTALLATION 
This section describes how to obtain and install the NRCDose3 code along with the required 
computing requirements. 

2.1 Distribution 

The NRCDose3 code is available for download from the NRC’s Radiation Protection Computer 
Code Analysis and Maintenance Program (RAMP) web site (https://ramp.nrc-gateway.gov/).  
The RAMP website also provides NRCDose3 users with access technical references, training 
and presentation material and code support (forum boards). 

2.2 Installation 

The NRCDose3 code can be installed on a single computer running Windows operating 
systems 7.0 or later with administrative privileges and compatible with Internet Explorer (IE) 
version 7.0 or later.  The code is available through the RAMP web site (https://ramp.nrc-
gateway.gov/) where a user registration is required.  Text reports are used for generating 
outputs such as the traditional, supplemental, and FSAR reports from the LADTAP, GASPAR, 
and XOQDOQ calculations. 

The initial install will create a user-specified directory (e.g., C:/NRCDose3 used as default) for 
use by the NRCDose3 code.  If installing an updated version, the install routine will 
automatically delete the current version before installing the updated version.  Only the updated 
program files are replaced.  User created cases files (“*.lnp,” “*.gnp”, or “*.xnp” files) will not be 
deleted from the directory; however, as a back-up, it is recommended that all case files be 
saved to a different folder or storage device. 

The NRCDose code (version 2.3.20 or earlier) is a separate program.  LADTAP and GASPAR 
files created in NRCDose (version 2.3.20 or earlier) are not compatible with the NRCDose3 
code.  However, XOQDOQ files created in NRCDose (version 2.3.20 or earlier) are compatible 
with NRCDose3.  Existing NRCDose code installations are not affected by installing NRCDose3, 
so both NRCDose and NRCDose3 may be installed and used on the same computer. 

2.2.1 Installation Process 

1. Download and save the NRCDose3 installation file, NRCDose3_v113_Setup.exe, from 
the RAMP web site (https://ramp.nrc-gateway.gov/).  To start the installation process 
double click (open) NRCDose3_v113_Setup.exe file, which will start the installation 
process and open the Welcome Screen as shown in Figure 2-1.  Select the “Next” button 
to continue with the installation process. 

https://ramp.nrc-gateway.gov/
https://ramp.nrc-gateway.gov/
https://ramp.nrc-gateway.gov/
https://ramp.nrc-gateway.gov/
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Figure 2-1 Installation Welcome Screen 

2. The NRCDose3 installer will then allow a user-specified destination folder for the 
installation of the NRCDose3 program as shown in Figure 2-2.  By default, the code will 
install on the root directory (i.e., C:/NRCDose3); however, a user defined directory can 
be designated.  The installer will create the directory, as needed, for the installation or 
install using the default directory.  Additionally, the installer will display the computer 
hard drive space needed for the NRCDose3 code and the available space on the drive 
selected for installation (i.e., “C:/”).  Select the “Next” button to continue with the 
installation process. 

 

Figure 2-2 Installation Folder Screen 
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3. The NRCDose3 installer will then request the user select the location of the folder where 
the NRCDose3 shortcut icons will be created and installed as shown in Figure 2-3.  The 
installer defaults to the installation directory (i.e., C:/NRCDose3) and the user may select 
a different directory using the dropdown menu arrow next the file directory name.  
Additionally, the user can select whether to make the NRCDose3 icon available to either 
the current user or all users.  The default option is to make the shortcut icon available to 
all users.  Select the “Next” button to continue with the installation process. 

 

Figure 2-3 Shortcut Folder Screen 

4. The NRCDose3 installer now has enough information to install the code and will display 
settings used to install the code on the computer as shown in Figure 2-4.  Select the 
“Next” button to continue with the installation process.  The user should see the 
installation progress screen as shown in Figure 2-5.  If the user decides to terminate the 
installation of NRCDose3 at this point they can do so by selecting the “Cancel” button 
shown in Figure 2-5. 
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Figure 2-4 Installation Confirmation Screen 

 

Figure 2-5 Installation Progress Screen 

5. When the installer has completed installing NRCDose3, the Installation Completion 
Screen as shown in Figure 2-6 will appear.  Select the “Finish” button to exit the installer. 
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Figure 2-6 Installation Completion Screen 

6. The NRCDose3 shortcut icon will appear on the Windows operating system (OS) 
desktop as shown in Figure 2-7.  Double click on the NRCDose3 shortcut icon to open 
the code and display the NRCDose3 Main Selection Screen as shown in Figure 2-8. 

 

Figure 2-7 NRCDose3 Shortcut Icon 
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Figure 2-8 NRCDose3 Main Selection Screen 

7. As shown n Figure 2-8, the NRCDose3 Main Selection Screen shows the LADTAP, 
GASPAR, and XOQDOQ Modules, and the toolbar on top of the screen containing three 
tool/menu options for NRCDose3.  These three tool/menu options are: 

• Quit ─ Select this tool to exit out of the NRCDose3 code. 

• About ─ Select this tool to open the About NRCDose3 Screen as shown in 
Figure 2-8.  This displays information about the version of the NRCDose3 code.  
Select the “OK” button to return to the NRCDose3 Main Selection Screen as 
shown in Figure 2-9. 

• Manuals ─ Select this tool to open a dropdown menu as shown in Figure 2-10 
listing the following technical references included with NRCDose3: 

 NRCDose3 Quick Start Guide 
 User’s Manual (for Draft NUREG-XXXX, NRCDose3 Code: User Guide 

and Technical Manual) 
 GASPAR II Manual, NUREG/CR-4653 
 LADTAP II Manual, NUREG/CR-4013 
 XOQDOQ Manual, NUREG/CR-2919 
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Figure 2-9 About NRCDose3 Screen 

 

Figure 2-10 Manuals Tool dropdown menu 
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2.2.2 Code Support 

Any questions, suggestions, corrections or comments concerning the NRCDose3 code or its 
documentation should be submitted via the NRCDose3 Support link on the RAMP website 
(https://ramp.nrc-gateway.gov/content/nrcdose-support). 

2.2.3 Code Error and Problem Reporting 

While extensive testing has been performed and effort directed toward minimizing (non-
computational) errors in NRCDose3, there may be unanticipated circumstances that lead to 
errors and problems (bugs).  To report errors and bugs with the program, first collect as much 
information as possible about the error or bug.  This information should include answers to the 
following questions: 

• What computer OS is NRCDose3 being executed on? 
• Is the error or bug reproducible? 
• What are the steps leading up to the problem? 
• What are the exact symptoms (e.g., program crash, error message, etc.)? 
• Save the case files and attach them to if possible. 

To report a problem, send a zip file with the case files and answers to the above questions to 
the NRCDose3 Forum webpage under the NRCDose3 Support link on the NRC RAMP website 
(https://ramp.nrc-gateway.gov/content/nrcdose-support). 

 

https://ramp.nrc-gateway.gov/content/nrcdose-support
https://ramp.nrc-gateway.gov/content/nrcdose-support
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3.0 LADTAP 
The LADTAP Module within the NRCDose3 code executes a modified version of the LADTAP II 
Fortran code.  The basic calculation methods (algorithms) of the LADTAP II Fortran code, as 
described in NUREG/CR-4013, have not been changed with this update to the NRCDose3 
code, except as needed to accommodate the use of different DCFs with different age groups.  
However, significant changes have been made to the data management and operation to 
support expanded capabilities of NRCDose3.  The LADTAP II Fortran code performs the 
environmental dose assessments for releases of liquid radioactive effluents from NPPs in 
surface waters and implements the dose assessment methods described in RG 1.109.  The 
LADTAP II Fortran code calculates the radiation dose to individuals, population groups, and 
biota from ingestion of aquatic foods, water, and terrestrial irrigated foods.  Additionally, 
LADTAP II calculates external exposure from boating, swimming and shoreline recreational 
activities.  The calculated doses provide information for NEPA evaluations, and for determining 
compliance with the NRC public dose limits in 10 CFR Part 20 [Ref. 20], the EPA public dose 
limits in 40 CFR Part 190 [Ref. 21], and the NRC ALARA design objectives and numerical 
guides in 10 CFR Part 50, Appendix I. 

The following sections will discuss the steps for establishing and conducting LADTAP dose 
calculations using NRCDose3.  The user is directed to NUREG/CR-4013, for the LADTAP II 
Fortran code user guide and technical bases, which provides additional detailed discussion on 
the assumptions, limitations, and methods for the LADTAP dose calculations. 

On the NRCDose3 Main Selection Screen as shown in Figure 3-1, select the “LADTAP Liquid 
Pathway Dose Assessment” button to open the LADTAP Module Main Screen as shown in 
Figure 3-2. 
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Figure 3-1 NRCDose3 Main Selection Screen (LADTAP Module) 
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Figure 3-2 LADTAP Module Main Screen 

The LADTAP Module Main Screen as shown in Figure 3-2 opens with the case data as last 
saved in the database.  On initial install, the program loads with an example test case.  Three 
main functional areas for inputting data and performing LADTAP dose calculations shown are: 
(1) the toolbar and initial setup area, (2) data input tabs area and (3) code execution and reports 
area.  Each of these functional areas of the LADTAP Module Main Screen is discussed in the 
following sections with a description of the options and capabilities contained therein. 

3.1 Toolbar and Initial Setup Functional Area 

This portion of the LADTAP Module Main Screen contains three tools and three initial setup 
input fields as shown in Figure 3-2.  The menu three tools are the File, Quit and About.  The 
initial setup fields include the Scenario, Source Term, and Dose Factors (dropdown menu). 

3.1.1 File Menu Tool 

The File Menu Tool provides the functionality to manage the LADTAP files as shown in 
Figure 3-3.  The File Tool dropdown menu options are: 

• New ─ Select this option to begin a new LADTAP case.  This will clear the database 
from any previously input information. 
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• Open LN3 File ─ Select this option to access and open a “*.LN3” file that was previously 
created with NRCDose3. 

• Save to Database ─ Choose this option to save the current case to the database.  When 
LADTAP starts, it loads the data that was last saved (typically from the last, previous 
run), populating all LADTAP screens and windows. 

• Save to LN3 File ─ Choose this option to save the completed case to a “*.LN3” file.  This 
allows the file to be saved for later use, or for sharing with others. 

• Delete ─ Choose this option to open an explorer window that will allow the user to delete 
any previously saved “*.LN3” files. 

** User Note ** ─ The “*.LN3” file type and format is used for NRCDose3 LADTAP files.  
Files of other formats for example “*.LNP” files generated under the NRCDose (version 
2.3.20 and earlier) of LADTAP (i.e., NRCDose 2.3.20 LADTAP II files) are not compatible 
with NRCDose3. 

 

Figure 3-3 LADTAP Toolbar with File Tool dropdown menu 
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3.1.2 Quit Tool 

Selecting the Quit Tool from the toolbar as shown in Figure 3-3 will terminate the LADTAP 
Module operation.  There is a Question prompt screen as shown in Figure 3-4 to ensure that the 
user wants to quit and exit the module.  If the “Yes” button is selected the LADTAP Module will 
terminate and any unsaved changed/edited data will not be saved.  Select the “No” button and 
then the appropriate entry from the File Tool dropdown menu to ensure that any information has 
been saved (to the database and/or a *.LN3 file) prior to quitting. 

 

Figure 3-4 LADTAP Module Quitting Tool Screen 

3.1.3 About Tool 

Selecting the About Tool from the Toolbar the About LADTAP screen as shown in Figure 3-5.  
This displays information about the LADTAP II code.  Select the “OK” button as shown in 
Figure 3-5 to return to the LADTAP Module Main Screen as shown in Figure 3-2. 

 

Figure 3-5 About LADTAP Screen 

3.1.4 Scenario Input Field 

Enter a title in the Scenario Field for the LADTAP case.  This is a descriptive text field only and 
the data in this field are not used for any LADTAP dose calculations.  Appropriate text should be 
selected to assist user in identifying the facility/site and release point information (i.e., Facility 
XYZ and Miscellaneous Waste Discharge).  As shown in Figure 3-2, the scenario title for the 
initial install is “NUREG/CR-4013 Sample Problem 1 – ICRP-2,” which is included in the 
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installation and loaded as the initial test case.  Subsequent opening of LADTAP will show the 
last saved case scenario. 

3.1.5 Source Term Input Field 

Enter a descriptive name for the Source Term in this field.  This is a text field only and the data 
in this field are not used for any LADTAP dose calculations.  Appropriate text should be selected 
to assist user in identifying the facility/site and release point information (e.g., Facility XYZ and 
Miscellaneous Waste Discharge).  As shown in Figure 3-2, the source term is “Test #1,” which is 
the source term name from “NUREG/CR-4013 Sample Problem 1 – ICRP-2.ln3” test case file.  

3.1.6 Dose Factors Dropdown Menu 

As shown in Figure 3-6, the Dose Factors dropdown menu allows the user to select the DCF 
values to be used for the LADTAP dose calculations.  The options available are “ICRP-2 
(Default),” “ICRP-30,” or “ICRP-72” DCF values.  The user should note that if the DCF values 
are changed, the assumed source term (if any has been entered) will be cleared.  In addition, 
the assumed usage and consumption factors will update to the DCF values associated with the 
selected ICRP methodology.  Test cases using the ICRP-30 and ICRP-72 DCFs are included in 
the installation, having the same data, except for the DCFs, as the “NUREG/CR-4013 Sample 
Problem 1 – ICRP-2.ln3” test case file. 

** User Note ** ─ For purposes of demonstrating compliance with 10 CFR Part 50, Appendix I, 
and 40 CFR Part 190, the ICRP-2 DCF values should be selected.  Likewise, for demonstrating 
compliance with 10 CFR Part 20, the ICRP-30 DCF values should be selected.  Use of ICRP-72 
DCF values by an applicant or licensee for a proposed NRC LAR request should be discussed 
with the NRC staff prior to submitting the license request. 
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Figure 3-6 LADTAP Dose Factors dropdown menu 

3.2 Data Input Tabs 

The six LADTAP Data Input Tabs as shown in Figure 3-2 are: 

1. Selections 

2. ALARA Locations 

3. Fish/Population/Biota 

4. Irrigation Food Data 

5. Dose Factors 

6. Pathway Factors 

Though not required when generating the input for LADTAP, it is recommended that the user 
enter the necessary parameters and data to the case in order of the Data Input Tabs as they are 
listed in the LADTAP Module Main Screen as shown in Figure 3-2. 
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3.2.1 Selections Tab 

The Selections Tab is used to enter the basic parameters for the LADTAP dose calculations.  
The Selection Tab includes a combination of input fields, selection radio buttons and three data 
specific input sections as shown in Figure 3-7.  Refer to NUREG/CR-4013 for additional 
information on the input values in this tab. 

 

Figure 3-7 Selections Tab 

 Input fields and Radio Buttons 

3.2.1.1.1 Discharge Flow Rate 

This field is used to enter the liquid effluent discharge flow rate in units of cubic feet per second 
(cfs).  The value from “NUREG/CR-4013 Sample Problem 1.ln3” is “3150” cfs.  The allowable 
range for values in this field is greater than 0 cfs. 

3.2.1.1.2 Source Term Multiplier 

This field is used to enter, if desired, a multiplier to the source term entered on this Selections 
Tab.  The default value is 1 and the allowable range for values in this field is 1 or greater.  
Typically, this will remain at 1.0, but can be adjusted to account for multi-unit sites, if the entered 
source term is on a per unit basis. 
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3.2.1.1.3 50 mi Population 

Enter the total human population within 50 miles of the site, as specified in 10 CFR 50, 
Appendix I.  The value from the “NUREG/CR-4013 Sample Problem 1.ln3” is “2200000” with the 
allowable range for values in this field being greater than 0. 

3.2.1.1.4 Print Dose Factors 

This check box is to be selected by the user if DCF values are to be listed and printed in the 
LADTAP output file.  The default value for this box is unchecked. 

3.2.1.1.5 Site Type 

This setting selects either “Fresh water” or “Saltwater” as appropriate for the site.  This selection 
controls the identification of the bioaccumulation factors that are to be used as different sets 
exist for fresh and saltwater species, as well as certain consumption values, e.g., saltwater 
invertebrate.  The value from the “NUREG/CR-4013 Sample Problem 1.ln3” for this setting is 
“Fresh water,” which is also the selection when creating a new case/file. 

3.2.1.1.6 Dose Contributions 

This setting determines if the dose contribution per radionuclide in percent is printed in the 
LADTAP output file.  The value from the “NUREG/CR-4013 Sample Problem 1.ln3” for this 
setting is “No,” which is also the setting when creating a new case/file. 

 Population Fractions Section 

As shown in Figure 3-7, this section gives the population age-group fractions with the default 
value setting of “No.”  The default population fractions are shown in Table 3-1.  These values 
are from Section 2.1.1 of NUREG/CR-4013 and represent U.S. averages at the time of RG 
1.109 development. 

Table 3-1 LADTAP Age-Group Population Fractions 

Population Age-Group Age Range 
(years) 

Default Age-Group 
Fractions 
(percent) 

ICRP-30 Age-Group 
Fractions 
(percent) 

Children 0 ─ 11 18 0 

Teens 11 ─ 17 11 0 

Adults 17 and older 71 100 

If the user needs to change or adjust these default values, select the “Yes” button and the “Edit” 
button on the Populations Fraction Section of the Selections Tab becomes active (not greyed 
out).  This will open the Population Fractions Screen shown in Figure 3-8 where the age group 
fraction of the total population can be adjusted.  A justification should be provided when any 
default NRCDose3 parameter is modified.  As noted in Table 3-1, if the LADTAP dose 
calculation to be performed is using the ICRP-30 DCF values, the age-group fractions are 
automatically set to 1.00 for adults, and 0 for teens and children.  This is because ICRP-30 
contains DCF values only for an adult age range; therefore, only adult doses are calculated. 
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Figure 3-8 Population Fractions Screen 

 Reconcentration Section 

This section of the Selections Tab provides information on the reconcentration factor (R-Factor) 
in the LADTAP dose calculation as shown in Figure 3-7.  The R-Factor is used to account for 
any recirculation that may occur in the receiving water body, which could increase the 
environmental concentrations above that as calculated directly from the effluent activity and the 
discharge flow rate.  As shown in Figure 3-9, one of four impoundments or reconcentration 
models can be selected. 

• None ─ This model assumes no additional decay or dilution of the liquid effluents, prior 
to them reaching the main receiving water body.  The discharge point radioactivity 
concentration is determined simply by the activity release rate and the discharge flow 
rate. 

• Completely Mixed ─ This model estimates the effluent reconcentration at the midpoint of 
the plant life and assumes complete mixing within a closed impoundment volume.  This 
model assumes negligible radioactivity loss due to leakage or evaporation. 

• Plug-Flow ─ This model assumes that radioactive effluents are released to an 
impoundment system (pond), where it is naturally diluted and delayed until it is released 
to the main receiving water body.  The degree of dilution and decay is proportional to the 
relative size of the impoundment system.  This model assumes no radioactivity loss due 
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to leakage or evaporation.  When this model is selected a comparison is made between 
the blowdown rate and the reactor effluent discharge rate (entered at the top of the 
Selections Tab).  If the blow-down rate is less than 99 percent of the effluent discharge 
rate, an error message is printed.  However, the run is not stopped, and the values given 
are used.   

• Partially Mixed ─ This model is derived from a mass balance for steady-state conditions 
described in RG 1.113.  This model assumes no radioactivity loss due to leakage or 
evaporation. 

Impoundment systems delay release to the main receiving water body allowing additional 
dilution or time for radiological decay.  The option from the “NUREG/CR-4013 Sample Problem 
1” for this setting is “Partially-Mixed.”  The calculated R-Factor is site and radionuclide specific 
and a detailed description of each of these models can be found in Section 3.3.3 of 
NUREG/CR-4013. 

 

Figure 3-9 R-Factor Model Options 

Additionally, for all the impoundment or reconcentration models except for the “None” option 
requires the user to input two additionally parameters as shown in Figure 3-7.  Those 
parameters are: 
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• Effluent discharge rate from impoundment system to the receiving water body in units of 
cfs.  The value from the “NUREG/CR-4013 Sample Problem 1” is “200” cfs, and the 
allowable range for values in this field is greater than 0 cfs. 

• Impoundment total volume in units of cubic feet (ft3).  The value from the “NUREG/CR-
4013 Sample Problem 1” is “50000” ft3, and the allowable range for values in this field is 
greater than 0 ft3. 

 Source Term Section 

The final section on the Selections Tab is the Source Term Section as shown in Figure 3-7.  The 
user can enter the annual released activity in units of curies (Ci) and R-Factor (if desired) for 
each radionuclide.  The R-Factor, as entered here, would be a value derived using a site-
specific model, which can be manually entered for each radionuclide.  Only enter the R-Factors 
if the reconcentration model option of “None” has been selected in the Reconcentration Section 
(Section 3.2.1.3).  Selecting any other reconcentration model (“Completely Mixed,” “Plug-
Flow,” or “Partially Mixed”) will override any manually entered R-Factors. 

 

Figure 3-10 DCF Warning Message 

Additional radionuclides can be added to the bottom of the list by selecting “Add Nuclide” button, 
which will flash the DCF Warning Screen Message as shown in Figure 3-10 and then open the 
Select Nuclide Screen as shown in Figure 3-11.  Select the radionuclide (highlighting the 
radionuclide) to be added to the source term by and then click the “Add” button as shown in 
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Figure 3-11 to add the radionuclide to the source term on the Selections Tab.  Holding the “Ctrl” 
key during radionuclide selection will allow for the selection of multiple radionuclides. 

** User Note ** ─ Prior to adding any additional radionuclides the user should ensure that the 
proper ICRP methodology is properly selected so that the proper forms of the radionuclides are 
selected by the code. 

Likewise, the user can remove radionuclides from the Source Term Section by selecting the 
radionuclide to be removed (highlighting the radionuclide) and then clicking the “Delete Nuclide” 
button as shown in Figure 3-7.  Selecting the “Clear” button clears out all source term data 
(Nuclide, Quantity and R-factor) for all radionuclides in the Source Term Section of the 
Selections Tab. 

 

Figure 3-11 Select Nuclide Screen 

** User Note ** ─ The input data should be periodically saved, using the “Save” at bottom of the 
LADTAP Module Main Screen as shown in Figure 3-2.  This will save the inputted data to the 
database as well as the file name, as designated by the user.  Saved values (and the saved file) 
are then available should the program inadvertently terminate or otherwise quit.  Remember that 
upon initial opening of the LADTAP Module (and XOQDOQ and GASPAR Modules), the data, 
which is loaded, is whatever data was last saved to the database.  Additionally, for this situation 
it will not be linked to any file name; data should be saved to an existing or new file depending 
on the situation.  To ensure the data is what desired, the user should open the case (file name) 
corresponding the case desired, edit an existing case and save under a different file name, or 
create a new file name. 
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3.2.2 ALARA Locations Tab 

The ALARA Locations Tab is used to enter the parameters used for the calculation of the 
maximum exposed individual (MEI) in the LADTAP dose calculation.  As shown in Figure 3-12, 
the ALARA Location Tab contains two sections: (1) the ALARA - Max Individual Section and (2) 
the Additional Usage Locations Section, with the ALARA - Additional Location Section being 
used to enter the exposure assumptions for the Additional Usage Locations. 

 ALARA – Max Individual Section 

The ALARA – Max Individual Section of the ALARA Locations Tab is subdivided into four data 
input sections.  These data input sections are: (1) the Shore-Width Factor options, (2) the 
Dilution Factor Section, (3) the Transit Time Section, and (4) the Change Default Usage and 
Consumption Data Section. 

 

Figure 3-12 ALARA Locations Tab 

3.2.2.1.1 Shore-Width Factor Option 

The shore-width factor represents a fraction of the dose from an infinite plane source that would 
be received from the shoreline geometry at the location of interest.  Select the location that will 
be used to determine the shore-width factor.  The exposure situations and the assumed shore-
width factors from RG 1.109 are shown in Table 3-2. 
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Table 3-2 Shore-Width Factors 

Exposure Situation Shore-Width Factor 

Discharge Canal Bank 0.1 

River Shoreline 0.2 

Lake Shore 0.3 

Nominal Ocean Site 0.5 

Tidal Basin 1.0 

3.2.2.1.2 Dilution Factor Section 

The dilution factors represent the amount of dilution expected between the discharge point to 
the receiving water body and the usage location for the pathway.  In practice, the radionuclide 
concentration, as calculated from the Source Term (activity released), the Discharge Flow Rate, 
and any R-Factor, is divided by the dilution factor to determine the concentration at the point of 
exposure.  There are three Dilution Factor pathway types: (1) “Aquatic food and boating,” (2) 
“Shoreline and swimming,” and (3) “Drinking water.”  A known value may be manually inputted.  
Alternatively, a value may be calculated using characteristics of the receiving water body.  For 
each pathway type, select the “Calc” button to open the Dilution Factor Calculation Screen as 
shown in Figure 3-13.  Section 3.1 of NUREG/CR-4013 provides additional information 
regarding the calculation of dilution factors based on applicable parameters and a hydrological 
surface water model. 

 

Figure 3-13 Dilution Factor Calculation Screen 

As shown in Figure 3-13, depending on the model selected the user must input the parameters 
discussed below to calculate a dilution factor: 
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• Surface Water Model ─ Select the appropriate hydrological model by clicking on either 
the “River” or “Lake” model option. 

• Surface Water Velocity ─ This field is used to enter surface water velocity in units of feet 
per second (ft/s) and the allowable range for values in this field is greater than 0 ft/s. 

• Surface Water Depth ─ This field is used to enter surface water depth in units of ft and 
the allowable range for values in this field is greater than 0 ft. 

• Downstream Distance ─ This field is used to enter downstream distance in units of ft and 
the allowable range for values in this field is greater than 0 ft. 

• Offshore Distance ─ This field is used to enter offshore distance in units of ft and the 
allowable range for values in this field is greater than 0 ft. 

• River Width/Lake Discharge Depth ─ This field is used to enter either the river width or 
lake discharge depth depending on the model selected in units of ft and the allowable 
range for values in this field is greater than 0 ft. 

The calculation of dilution is based on user input of receiving water body characteristics (flow, 
depth and downstream distance) in the selected water model. 

** User Note ** ─ If the discharge flow rate is large compared to those receiving water body 
characteristics, the LADTAP code could return a dilution calculation with a value less than 1, 
which reflects that the defined parameters are not compatible with the selected water model.  If 
this occurs, dose calculations would not be correct.  The LADTAP output will issue the following 
error message and the program will terminate at that point. 

“WARNING: PARAMETER VALUES INPUTTED FOR THE DILUTION CALCULATION ARE 
INCOMPATIBLE WITH THE MODEL.  TERMINATING PROGRAM” 

3.2.2.1.3 Transit Time 

This section is used to enter the transit time in units of hours (hrs) from the discharge point of 
the receiving water body to the usage location.  As shown in Figure 3-12, one transit time can 
be entered for the drinking water pathway, while all other pathways have the same transit time.  
The value from the “NUREG/CR-4013 Sample Problem 1” is “1” for the drinking water pathway 
and “3” for the other pathways.  The allowable range for values in this field is greater than 0 hrs. 

3.2.2.1.4 Change Default Usage and Consumption Data Section 

This section allows the user the option to change the default usage and consumption data for 
the MEI.  The default usage and consumption data are taken from RG 1.109, Revision 1, when 
using the ICRP-2 (Default) and ICRP-30 DCF values and from EPA EFH when using the ICRP-
72 DCF values.  To change usage and consumption data information, select the “Yes” radio 
button and the “Edit” button shown in Figure 3-12 to open the Max Individual Consumption 
Screen as shown in Figure 3-14. 
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Figure 3-14 Max Individual Consumption Screen 

Using the drop-down menu, select the appropriate age group from RG 1.109, and enter the 
applicable consumption rates of Fish, Invertebrates, Aquatic Plants and Drinking Water in units 
of kilograms per year (kg/yr) for the assumed maximum individual.  Also, enter the assumed 
Usage/Exposure Time (hr/yr) for Shoreline, Swimming, and Boating recreational activities.  
Select the “Save” button when edits are completed to save the revised usage and consumption 
data.  Save each age group separately while progressing through the different age groups.  
Selecting the “Defaults” restores the default usage and consumption data from RG 1.109. 

 Additional Usage Locations Section 

As shown in Figure 3-12, the Additional Usage Locations Section in the ALARA Location Tab 
allows the user to enter additional locations for calculating doses.  The user can add and 
remove usage locations to the LADTAP dose calculation.  The value from the “NUREG/CR-
4013 Sample Problem 1” displays the information for two additional usage locations (i.e., “At 
outfall” and “Downstream”).  To add an additional ALARA usage locations select the “Add” 
button to activate the ALARA - Additional Location Section below as shown in Figure 3-15.  To 
remove an ALARA usage locations select the location to be removed (highlighting the location) 
and click the “Remove” button. 
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Figure 3-15 Additional Location Section activated screen 

 ALARA - Additional Location Section 

Once the ALARA - Additional Location Section of the ALARA Location Tab is activated by 
selecting the “Add” button in Section 3.2.2.2, the user can input the information required for the 
ALARA usage location.  As discussed in Section 3.2.2.1, enter the name of the “Location”, the 
pathway “Dilution Factor,” the “Transit Time,” and the “Shore-width Factor.  Only a single 
pathway “Dilution Factor” and “Transit Time” can be entered for additional ALARA usage 
locations.  Additionally, location specific usage and consumption data can be entered by 
selecting the “Yes” radio button then the “Edit” button as shown in Figure 3-15 to open the Max 
Individual Consumption Screen as shown in Figure 3-16. 
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Figure 3-16 Add. Locations Usage/Consumption Screen 

Similar to Section 3.2.2.1.4, enter the required usage and consumption information and select 
the “Save” button when edits are completed to save the revised usage and consumption data. 
Save each age group separately while progressing through the different age groups. 

3.2.3 Fish/Population/Biota Tab 

The Fish/Population/Biota Tab is used to enter the parameters used for the annual aquatic 
animal harvest and consumption as well as the total population drinking water consumption and 
recreation time for the LADTAP dose calculation.  As shown in Figure 3-17, the 
Fish/Population/Biota Tab contains three sections: (1) the Fish Usage Section, (2) the 
Population Usage Section, and (3) the Biota Locations Section.  Figure 3-17 also displays the 
four menu dropdown options for the Fish Usage Section (sport/commercial fishing and 
sport/commercial invertebrate harvest and the four menu dropdown options for the Population 
Usage Section (drinking water and recreational activities). 
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Figure 3-17 Fish/Population/Biota Tab 

 Fish Usage Section 

This section is where the total fish and invertebrate harvests at user designated locations are 
entered for determination of population doses.  From the displayed options, select the usage 
type from one of the four options as shown in Figure 3-17: 

• Sport Fishing 

• Commercial Fishing 

• Sport Invertebrate Harvest 

• Commercial Invertebrate Harvest 

Once selected, the user can enter data, adding or editing an existing location identification and 
entering the annual harvest (catch), dilution and transit time, unique for each location, as shown 
in Figure 3-18.  To define a new fishing or invertebrate harvesting location select the “Add” 
button, which will activate the fishing/harvesting location at the bottom of the Fish Usage 
Section.  For each type of fishing or invertebrate harvesting location, enter the name of the 
location, the amount of the annual harvest in units of kg/yr, a dilution factor (unitless) and the 
transit time in unit of hours (hrs).  The values from the “NUREG/CR-4013 Sample Problem 1” 
are “Fish Downstream,” “70000” kg/yr, “4” hr and “1” hr, respectively.  If necessary, select the 
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“Calc” button to open Dilution Factor Calculation Screen as shown in Figure 3-13 and enter the 
parameters required for the code to calculate a dilution factor as discussed in Section 3.2.2.1.2 
above. 

 

Figure 3-18 Fish Usage Section of the Fish/Population/Biota Tab 

When the required input parameters have been entered for the type of fishing or invertebrate 
harvesting location, select the “Save” button to add to the location to the LADTAP dose 
calculation input file.  To remove a type fishing or invertebrate harvesting location, select 
(highlight) the location from the “Records” (upper) portion of the Fish Usage Section and select 
the “remove” button to delete the location.  Repeat this process for any additional locations for 
the types (sport or commercial) of fishing or invertebrate harvesting. 

 Population Usage Section 

This section is where the total drinking water usage and recreation (shoreline, swimming and 
boating) times at locations are entered for determination of population doses.  From the menu 
choices, select the desired population usage parameter from one of the four options as shown 
in Figure 3-17: 

• Drinking Water 

• Shoreline 
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• Swimming 

• Boating 

Once selected, the input parameters for the selected pathway can be entered by the user, as 
shown in Figure 3-19.  To define a new population usage location, select the “Add” button to 
activate the usage location at the bottom of the Population Usage Section. 

 

Figure 3-19 Population Usage Section of the Fish/Population/Biota Tab 

The input required in the usage location sections are different depending upon the population 
usage option chosen from the dropdown menu. 

• When the “Drinking Water” option is selected enter the name of the drinking water 
location, the total population, the dilution factor (unitless), and the transit time in unit of 
hrs.  The default average individual consumption rates will be used along with the 
population age group distribution for the dose calculation.  Alternatively, the user can 
enter the supply rate in units of gallons per day (gpd) and an average individual usage in 
gpd.  The code will then calculate the exposed population for the calculation.  The values 
from the “NUREG/CR-4013 Sample Problem 1” are “Water at 16 mi downstream,” 
“2200000,” “4” hr and “1” hr, respectively.  If necessary, select the “Calc” button to open 
Dilution Factor Calculation Screen as shown in Figure 3-13 and enter the parameters 
required for the code to calculate a dilution factor as discussed in Section 3.2.2.1.2 
above. 



 

3-23 

• When the “Shoreline” option is selected enter the name of the shoreline location, the 
annual usage in units of person-hr per year (person-hr/yr), the dilution factor (unitless), 
the transit time in unit of hrs, and shore-width factor from the dropdown menu.  The 
shore-width factor dropdown menu options are listed in Table 3-2 and described in 
Section 3.2.2.1.1.  The values from the “NUREG/CR-4013 Sample Problem 1” are 
“Downstream Shore,” “83000” person-hr/yr, “4” hr and “1” hr, respectively.  If 
necessary, select the “Calc” button to open Dilution Factor Calculation Screen as shown 
in Figure 3-13 and enter the parameters required for the code to calculate a dilution 
factor as discussed in Section 3.2.2.1.2 above. 

• When the “Swimming” option is selected enter the name of the swimming location, the 
annual usage in units of person-hr/yr, the dilution factor (unitless), and the transit time in 
unit of hrs.  The values from the “NUREG/CR-4013 Sample Problem 1” are “Water at 16 
mi downstream,” “120000” person-hr/yr, “4” hr and “1” hr, respectively.  If necessary, 
select the “Calc” button to open Dilution Factor Calculation Screen as shown in 
Figure 3-13 and enter the parameters required for the code to calculate a dilution factor 
as discussed in Section 3.2.2.1.2 above. 

• When the “Boating” option is selected enter the name of the boating location, the annual 
usage in units of person-hr/yr, the dilution factor (unitless), and the transit time in unit of 
hrs.  The values from the “NUREG/CR-4013 Sample Problem 1” are “Downstream 
boating,” “520000” person-hr/yr, “4” hr and “1” hr, respectively.  If necessary, select the 
“Calc” button to open Dilution Factor Calculation Screen as shown in Figure 3-13 and 
enter the parameters required for the code to calculate a dilution factor as discussed in 
Section 3.2.2.1.2 above. 

When the required input parameters have been entered for the type of population usage 
location, select the “Save” button to add to the location to the LADTAP dose calculation input 
file.  To remove a type population usage location, select (highlight) the location from the 
“Records” (upper) portion of the Population Usage Section and the select the “remove” button to 
delete the location.  Repeat this process for any additional locations for the types (sport or 
commercial) of fishing or invertebrate harvesting. 

 Biota Locations Section 

This section is where any biota exposure locations are identified and defined for use in LADTAP 
dose calculations.  To define a biota exposure location, select the “Add” button to activate the 
biota exposure location at the bottom of the Biota Locations Section.  For each biota exposure 
location, enter the name of the location, the dilution factor (unitless) and the transit time (hrs).  
The values from the “NUREG/CR-4013 Sample Problem 1” are “Fish at outfall,” “1” hr and “1” 
hr, respectively.  If necessary, select the “Calc” button to open Dilution Factor Calculation 
Screen as shown in Figure 3-13 and enter the parameters required for the code to calculate a 
dilution factor as discussed in Section 3.2.2.1.2 above.  Section 3.2.5 of NUREG/CR-4013 
provides additional information and an explanation on the biota dose function in the LADTAP II 
Fortran code. 
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Figure 3-20 Biota Locations Section of the Fish/Population/Biota Tab 

There are three (3) primary aquatic species (fish, invertebrate and algae) and four (4) secondary 
terrestrial species (muskrat, racoon, heron and duck) included in the LADTAP code.  As 
described below, additional species can be added with user defined exposure assumptions.  
NUREG/CR-4013, Section 3.2.5 provides details on the modeling and exposure assumptions 
for the 3 primary and 4 secondary species.  The internal dose component to primary species is 
calculated considering the bioaccumulation factors for each radionuclide concentration, at the 
defined location and dilution, determining an assimilated concentration in the biota mass.  The 
dose is determined by multiplying this biota mass concentration by nuclide-specific effective 
energy deposited in the biota, based on a defined effective radius for the biota.  Tables 3-3 and 
3-4 below summarize the modeling and exposure assumptions. 

The effective radius is used to model the biota as a sphere geometry, such that different dose 
absorption values can be applied for different size/mass biota.  Effective radius is the radius of a 
sphere (considered muscle) that has the same mass as the biota in question, based on an 
assumed uniformly distributed mass.  For an assumed nominal density of 1 gram per cubic 
centimeter (g/cm3) for muscle, the effective radius can be approximated as the cubic root of the 
quantity (mass (in grams) divided by 4.19, where 4.19 = 4/3 * π).  Refer to Appendix D for a 
description of the modeling and calculations for the nuclide-specific deposited energy (dose) 
values based on effective radius. 
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Table 3-3 Default Values for Terrestrial Biota Exposure Parameters 

Terrestrial 
Biota 

Effective Body 
Radius (cm) 

Body Mass 
(g) 

Consumption 
of Food (g/d) Food Organism 

Muskrat 6 1000 100 Aquatic plants 

Racoon 14 1200 200 Invertebrate 

Heron 11 4600 600 Fish 

Duck 5 1000 100 Aquatic plants 

Table 3-4 Biota Exposure Assumptions 

Biota Shoreline (sediment) 
Exposure Time (h/y) 

Swimming Exposure 
Time (h/y) 

Fish 4380 8760 

Invertebrate 8760 8760 

Algae 0 8760 

Muskrat 2922 2922 

Racoon 2191 0 

Heron 2922 2920 

Duck 4383 4383 

If a new biota type will be used, select the “Add Biota” button on the Biota Locations Section as 
shown in Figure 3-20 to open the Additional Biota Types Screen as shown in Figure 3-21. 

Once the Additional Biota Types Screen opens, select the “Add Biota Type” button, as shown in 
Figure 3-21, to activate the input parameter fields for the new biota.  Enter the following input 
parameters for the new biota: 

• Name ─ Enter the name of the biota to be added to the LADTAP dose calculation. 

• Food Type ─ This field is used to enter the classification of food type for the new biota 
and contains a dropdown menu with three food type options.  The food type options are 
“Algae,” “Fish,” and “Invertebrate.” 

• Mass ─ Enter the mass of the biota in units of grams (g) and the allowable range for 
values in this field is greater than 0 g. 
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• Effective Radius ─ This field is used to enter effective radius in units of centimeters (cm) 
and the allowable range for values in this field is greater than 0 cm.   

• Consumption Rate ─ This field is used to enter consumption rate of the biota in units of 
gram per day (g/d) and the allowable range for values in this field is greater than 0 g/d. 

• Shoreline exposure ─ This field is used to enter the shoreline exposure from the biota in 
units of hrs/yr and the allowable range for values in this field is greater than 0 hrs/yr. 

• Swimming exposure ─ This field is used to enter the swimming exposure from the biota 
in units of hrs/yr and the allowable range for values in this field is greater than 0 hrs/yr. 

BNWL-1754 [Ref. 22], Section 6 provides the modeling used in LADTAP for the biota 
calculations; Table 6.1-1 presents the exposure assumptions for the various primary and 
secondary biota. 

 

Figure 3-21 Additional Biota Types Screen 

When the required input parameters for the new biota are entered, select the “Save” button to 
add to the location to the LADTAP dose calculation input file.  To remove a biota type, select 
(highlight) the location from the upper portion of the Additional Biota Types Screen as shown in 
Figure 3-21 and select the “Delete Biota Type” button to delete the biota type.  Select the “close” 
button to return to the Biota Locations Section of the Fish/Population/Biota Tab as shown in 
Figure 3-20. 
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3.2.4 Irrigation Food Data Tab 

The Irrigation Food Data Tab is used to enter the parameters used to calculate the exposure to 
humans from consumption of vegetables, leafy vegetables, milk, and meat that have been 
irrigated with water contaminated with radioactive effluents.  As shown in Figure 3-22, the 
Irrigation Food Data Tab contains two main data input sections: (1) Irrigated Food Pathway 
Section, and (2) Water Usage Locations Section.  Additionally, as shown in Figure 3-22, each of 
these two-main data input section contains a subsection for the additional of input data: (1) 
Irrigated Food data subsection, and (2) Water Usage Data subsection. 

** User Note ** ─ For every irrigated food pathway defined in the Irrigation Food Data Tab, 
there must be at least one water usage location must be defined on this tab as well. 

 

Figure 3-22 Irrigation Food Data Tab 

 Irrigated Food Pathways Section 

This section is where the irrigated food data for the LADTAP dose calculations can be added or 
removed.  To add an irrigated food pathway to the calculation, select the “Add” button which will 
open the information screen with the user note mentioned above as shown in Figure 3-23.  
Select the “OK” button to activate the Irrigated Food Data subsection as shown in Figure 3-24 
and as discussed in Section 3.2.4.1.1 below.  To remove an irrigated food pathway type, select 
(highlight) the pathway type from the “Records” Irrigated Food Pathway Section and select the 
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“remove” button to delete the location.  There is also a display of the number of irrigated food 
pathway records in this section. 

 

Figure 3-23 Irrigation Food Data Note Screen 

3.2.4.1.1 Irrigated Food Data Subsection 

Once the Irrigated Food Data subsection is activated, as shown in Figure 3-24, enter the 
following input parameters for the new irrigated food: 

• Food Type ─ This field is used to enter the classification of irrigation food type and 
contains a dropdown menu with four food type options.  The irrigation food type options 
are “Vegetables,” “Leafy Vegetables,” “Milk,” and “Meat.” 

• Irrigation Rate ─ This field is used to enter the irrigation rate for the food type in units of 
liters per square meters per month (L/m2/mon) and the allowable range for values in this 
field is greater than 0 L/m2/mon. 

• Total Production Rate ─ This field is used to enter the production rate for the irrigated 
food type within a 50-mile radius in units of kg/yr or liters per year (L/yr) and the 
allowable range for values in this field is greater than 0 kg/yr or 0 L/yr. 
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Figure 3-24 Irrigation Food Data Subsection 

• Non-contaminated Irrigation Water ─ These fields are used only when the “Milk” and 
“Meat” irrigation food type options are selected, and they are fraction of the amount of 
non-contaminated irrigation water used for feed livestock feed production.  This field is 
unitless and the allowable range for values in this field is greater than 0.00. 

• Growing Period ─ Enter the length of the irrigated food type growing period in this field in 
units of days and the allowable range for values in this field is greater than 0.00 days. 
Default values from RG 1.109 are 30 days for milk and meat pathway (reflecting pasture 
grass) and 60 days for vegetables and leafy vegetables.   

• Crop Yield ─ Enter the crop yield for the irrigated food type in this field in units of 
kilograms per square meter (kg/m2) and the allowable range for values in this field is 
greater than 0.00 kg/m2.  Default values from RG 1.109 are 0.7 kg/m2 for milk and meat 
pathway (reflecting pasture grass) and 2.0 kg/m2 for vegetables and leafy vegetables. 

If needed to reflect site-specifics, the user can change the individual consumption rates under 
either the Pathway Factors Tab, Section 3.2.6, or by selecting the “Yes” button and the “Edit” 
button on the “Change default usage and consumption data” portion of Figure 3-24.  This will 
open the Usage/Consumption Screen as shown in Figure 3-25.  Similar to Section 3.2.2.1.4, 
enter the required usage/consumption information and select the “Save” button when edits are 
completed, to save the revised usage and consumption data. 
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Figure 3-25 Usage/Consumption Screen 

When the required data for the new irrigated food pathways are entered, select the “Save” 
button to add to the pathway to the LADTAP dose calculation input file.  Selecting the either the 
“Save” or “Cancel” button in the Irrigated Food Data subsection (Figure 3-24) will activate the 
“Usage Locations” button and allow the user to reopen the Water Usage Location Section of the 
Irrigation Food Data Tab described in Section 3.2.4.2. 

 Water Usage Locations Section 

The Water Usage Location Section of the Irrigation Food Data Tab is where the water usage 
location for each irrigated food pathway is defined as shown in Figure 3-26.  To add a location, 
select the “Add” button which will activate the Water Usage Data Subsection as shown in 
Figure 3-26 and as discussed in Section 3.2.4.2.1.  To remove a water usage location, select 
(highlight) the location from the “Records” Water Usage Locations Section and select the 
“remove” button to delete the location.  There is also a display of the number of water usage 
location records in this section. 
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Figure 3-26 Water Usage Data Subsection 

3.2.4.2.1 Water Usage Data Subsection 

Once the Water Usage Data subsection is activated, as shown in Figure 3-26, enter for each 
irrigation food pathway type a location name, a dilution factor, production rate and transit time.  
The dilution factor can be calculated as discussed in Section 3.3.1.2.  It is important to 
remember that for every irrigated food pathway defined there must be at least one water usage 
location and one water usage location may be used for several irrigation food pathways.  Select 
the “Save” to add this location to the LADTAP case. 

** User Note ** ─ If multiple water usage locations are listed for a single irrigated food pathway, 
only the location with the highest dose will be included in the LADTAP FSAR Report. 

3.2.5 Dose Factors Tab 

The Dose Factors Tab is used to view the selected DCF values for the LADTAP dose 
calculation as shown in Figure 3-27.  The factors displayed will be those for the selected ICRP 
dose factor methodology (i.e., ICRP-2 (Default), ICRP-30, or ICRP-72 from the Dose Factors 
dropdown menu.  Select the applicable age group and intake pathway (e.g., adult ingestion or 
inhalation, teen ingestion or inhalation, child ingestion or inhalation and infant ingestion or 
inhalation) to display the DCF values. 
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Figure 3-27 Dose Factors Tab with DCF methodology and age/pathway options 

As mentioned above the three DCF sets that can be selected by the Dose Factors dropdown 
menu are: 

• ICRP-2 (Default) ─ This DCF methodology option contains the default radionuclides and 
DCF values used by NRCDose3, following the precedent set by the NRC release of 
LADTAP II and GASPAR II.  These DCF values are based on the ICRP-2 methodology, 
which is the current basis of the NRC regulations in 10 CFR Part 50, Appendix I, and the 
EPA regulations in 40 CFR Part 190.  ICRP-2 DCF values are included for four age 
groups (Infant, Child, Teen, and Adult) and 7 organs (Bone, Liver, Total Body, Thyroid, 
Kidney, Lung, and GI-LLI).  Appendix A of this manual lists the 203 radionuclides and 
the technical references for the use of the ICRP-2 DCF values. 

• ICRP-30 ─ This DCF methodology utilizes occupational DCF values for ingestion and 
inhalation.  These DCF values are based on the ICRP-30 methodology, which is the 
current basis of the NRC regulations in 10 CFR Part 20.  Since these are occupational 
DCF values, only adult factors are included for 24 organs.  The same 203 radionuclides 
listed in Appendix A and available for the ICRP-2 methodology DCF values are also 
available for the ICRP-30 methodology option.  Section 6.1 provides detail discussions 
on the selection of the radionuclide inhalation class (i.e., D/M/Y). 
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• ICRP-72 ─ This DCF methodology utilizes DCF values in accordance with ICRP Report 
No. (ICRP-60) methodologies.  The DCF values are included for inhalation and ingestion 
pathways, for 6 age groups (Newborn, 1 yr, 5 yr, 10 yr, 15 yr, and Adult) and 27 organs 
(including Remainder and Effective).  The 203 radionuclides, listed in Appendix A, for 
both the ICRP-2 and ICRP-30 methodologies are also the same radionuclides available 
for the ICRP-72 methodology option.  Section 6.1 provides detail discussions on the 
selection of the radionuclide inhalation class (i.e., F/M/S).   

** User Note ** ─ Use of ICRP-72 DCF values by an applicant or licensee for a proposed NRC 
LAR should be discussed with the NRC staff prior to submitting the license request. 

After selecting the appropriate ICRP methodology and Dose Factors from their respective 
dropdown menus all applicable organ DCF values are available for review as shown in 
Figure 3-28.  Select the “Nuclide Data” button to open the Nuclide Data Screen as shown in 
Figure 3-29 and view applicable nuclide data, such as atomic weight, isomeric state, decay 
constant and external dose factors.  Select the “Exit” button to return to the Dose Factors Tab. 

 

Figure 3-28 Dose Factors Tab with ICRP-2 DCF values for review 
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Figure 3-29 Nuclide Data Screen 

3.2.6 Pathway Factors Tab 

The Pathway Factors Tab is used to view and edit, as needed, the remaining parameters used 
for completing the liquid pathway LADTAP dose calculation.  As shown in Figure 3-30, the 
Pathway Factors Tab contains the main Liquid Pathway Parameters Sections and three option 
selection buttons.  The three option selection buttons are: (1) “Bioaccumulation Factors” button, 
(2) Usage/Consumption” button, and (3) “Page Defaults” button. 

** User Note ** ─ The values for the parameters included for the initial install are those 
recommended in RG 1.109, except when using the ICRP-72 DCFs, the values for the 
Usage/Consumption reflect values taken from EPA EFH.  Any changed made to the values in 
this tab will be saved in the program’s main database and will be used for future calculations.  
Therefore, it is recommended that if values are changed to reflect site-specifics, that after the 
case/file is saved, which will also save these changes applicable for the case/file, the defaults 
be reset so as not to inadvertently affect future uses and calculations. 
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Figure 3-30 Pathway Factors Tab 

 Liquid Pathway Parameters 

The following liquid pathway parameters can be reviewed and/or edited on Pathway Factors 
Tab as shown in Figure 3-30.  The liquid pathway parameters that can be reviewed and/or 
edited are: 

• Processing time for aquatic foods is entered in units of hrs with the RG 1.109 default 
value of “24.0” hrs, which has also been used for “NUREG/CR-4013 Sample Problem 1.”  
The allowable range for values in this field is greater than 0.0 hrs. 

• Processing time for water supply systems entered in units of hrs with the RG 1.109 
default value of “12.0” hrs, which is the same as used for “NUREG/CR-4013 Sample 
Problem 1.”  The allowable range for values in this field is greater than 0.0 hrs. 

• Pasture grass consumption rate for milk producing animals is entered in units of 
kilograms per day (kg/d) with the RG 1.109 default value of “50.0” kg/d, which is the 
same as used for “NUREG/CR-4013 Sample Problem 1.”  The allowable range for 
values in this field is greater than 0.0 kg/d. 

• Water consumption rate for milk producing animals is entered in units of liters per day 
(L/d) with the RG 1.109 default value of “60.0” L/d, which is same as used for 
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“NUREG/CR-4013 Sample Problem 1.” The allowable range for values in this field is 
greater than 0.0 L/d. 

• Pasture grass consumption rate for beef producing animals is entered in units of kg/d 
with the RG 1.109 default value of “50.0” kg/d, which is same as used for “NUREG/CR-
4013 Sample Problem 1.”  The allowable range for values in this field is greater than 
0.0 kg/d. 

• Water consumption rate for beef producing animals is entered in units of L/d with the RG 
1.109 default value of “60.0” L/d, which is same as used for NUREG/CR-4013 Sample 
Problem 1.”  The allowable range for values in this field is greater than 0.0 L/d. 

• Fraction of deposition captured by vegetation is unitless with the RG 1.109 default value 
of “0.25,” which is same as used for “NUREG/CR-4013 Sample Problem 1.”  The 
allowable range for values in this field is greater than 0.0 and less than 1.0. 

• Total U.S. population with the RG 1.109 default value of “2.60E+08,” which is same as 
used for “NUREG/CR-4013 Sample Problem 1.”  The allowable range for values in this 
field is greater than 0.0.  (Note: this value is a carryover from previous LADTAP 
population dose calculations; it remains a required code factor though not used for 
current population dose calculations.) 

• Midpoint of plant life is entered in units of years with the default value of 20 years.  RG 
1.109 references a nominal 15-year value; however, this value was changed in the 
LADTAP II and GASPAR II Fortran codes to 20 years, reflecting the nominal 40 year 
expected operating life for a nuclear plant (without license extension).  This is the value 
used for “NUREG/CR-4013 Sample Problem 1.”  The allowable range for values in this 
field is greater than 0.0 yrs. 

• Plant weathering half-life is entered in units of days with the RG 1.109 default value of 
“14” d, which is same as used for “NUREG/CR-4013 Sample Problem 1.”  The allowable 
range for values in this field is greater than 0.0 d. 

• Density thickness of root zone is entered in units of kg/m2 with the RG 1.109 default 
value of “240” kg/m2, which is the same as used for “NUREG/CR-4013 Sample Problem 
1.” The allowable range for values in this field is greater than 0.0 kg/m2. 

• Default age group fractions are entered for the “Adult,” “Teen,” and “Child” (unitless) with 
the RG 1.109 default values of “0.71,” “0.11,” and “0.18,” respectively.  These are the 
same values as used for “NUREG/CR-4013 Sample Problem 1”.  The allowable range 
for values in these fields are greater than 0.0.  If the calculation to be performed is using 
ICRP-30 DCF values, the population fraction should be 1.00 for adults and 0 for teens 
and children as ICRP-30 contains DCF values for only the adult age range. 

• Growing periods are entered for the “Vegetables,” “Leafy Vegetables,” “Milk,” and “Meat” 
in units of d with the RG 1.109 default values of “60,” “60,” “30,” and “30” d, respectively.  
These are the same as used for “NUREG/CR-4013 Sample Problem 1.”  The allowable 
range for values in these fields is greater than 0.0 d. 

• Crop yields are entered for the “Vegetables”, “Leafy Vegetables,” “Milk,” and “Meat” in 
units of kg/m2 with the RG 1.109 default values of “2.0,” “2.0,” “0.7,” and “0.7” kg/m2, 
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respectively.  These are the same values as used for “NUREG/CR-4013 Sample 
Problem 1.”  The allowable range for values in these fields is greater than 0.0 kg/m2. 

Additionally, the sport and commercial aquatic food harvest parameters (U.S. Commercial 
Harvest) listed below are entered on the Pathway Factors Tab as shown in Figure 3-30.  The 
following RG 1.109 default values represent the total U.S. harvest data from the 1970’s.  For 
commercial harvests, the production within 50 miles from the site is considered as part of the 
total U.S. harvest.  Appendix D of RG 1.109 contains equations to compute the average 
concentration in the U.S. commercial harvest (Equation D-2 of RG 1.109) and the annual 
population-integrated dose (Equation D-4 of RG 1.109). 

• Sport harvest processing time is entered in units of hrs with the RG 1.109 default value 
of “168” hrs, which is the same as used for “NUREG/CR-4013 Sample Problem 1.”  The 
allowable range for values in this field is greater than 0.0 hrs. 

• Commercial harvest processing time is entered in units of hrs with the RG 1.109 default 
value of “240” hrs, which is same as used for “NUREG/CR-4013 Sample Problem 1.” 
The allowable range for values in this field is greater than 0.0 hrs. 

• Freshwater fish harvest is entered in units of kg/yr with the RG 1.109 default value of 
“4.40E+07” kg/yr, which is same as used for “NUREG/CR-4013 Sample Problem 1.” The 
allowable range for values in this field is greater than 0.0 kg/yr. 

• Freshwater invertebrates harvest is entered in units of kg/yr with the RG 1.109 default 
value of “2.30E+06” kg/yr, which is same as used for “NUREG/CR-4013 Sample 
Problem 1.”  The allowable range for values in this field is greater than 0.0 kg/yr. 

• Saltwater fish harvest is entered in units of kg/yr with the RG 1.109 default value of 
“6.58E+08” kg/yr, which is same as used for “NUREG/CR-4013 Sample Problem 1.”  
The allowable range for values in this field is greater than 0.0 kg/yr. 

• Saltwater invertebrates harvest is entered in units of kg/yr with the RG 1.109 default 
value of “4.10E+08” kg/yr, which is same as used for “NUREG/CR-4013 Sample 
Problem 1.”  The allowable range for values in this field is greater than 0.0 kg/yr. 
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 Bioaccumulation Factors Button 

To review and edit either the bioaccumulation factors for aquatic biota or transfer factors for 
meat, soil and milk, select the “Bioaccumulation Factors” button as shown in Figure 3-30 to 
open the Bioaccumulation Factors & Transfer Coefficients Screen as shown in Figure 3-31. 

 

Figure 3-31 Bioaccumulation Factors & Transfer Coefficients Screen 

With the Bioaccumulation Factors & Transfer Coefficients Screen open use the scrolling tool to 
review and adjust bioaccumulation factors for saltwater or freshwater plants and fish, and review 
and adjust meat, soil or milk transfer factors.  The RG 1.109 default values should be used 
unless there are site-specific values that have been determined and supported by adequate 
technical bases.  The “Save” button allows the user to save any edits made to either the 
bioaccumulation factors or transfer coefficients and when the database has been updated 
NRCDose3 will inform the user as shown in Figure 3-32.  Additionally, when the review and/or 
adjustments to either the bioaccumulation factors, transfer coefficients, or both are completed, 
select the “Close” button to return to the Pathway Factors Tab.  The NRCDose3 code will again 
prompt the user regarding the status of saving any changes made to either the bioaccumulation 
factors, transfer coefficients, or both as shown in Figure 3-32, select the “Yes” button to close 
the prompt window. 
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Figure 3-32 Bioaccumulation Factors & Transfer Coefficients Prompt Screens 

 Usage/Consumption Button 

To review and edit any of the maximum or average, per age group, usage and consumption 
rates for food, drink and recreation, select the “Usage/Consumption” button as shown on 
Figure 3-30 to open the Usage/Consumption Data Screen as shown in Figure 3-33.  As shown 
in Figure 3-33 there are three different tables of data corresponding to the databases used in 
the LADTAP dose calculations.  The three usage/consumption tables are: 

• Maximum Individual Exposure Consumption Data for selected Dose Factors ─ Data in 
this table includes the four age groups (i.e., “Adults,” “Teens,” “Children,” and “Infants”) 
and eight usage/consumption rates (i.e., “Fish,” “Freshwater Invertebrates,” “Aquatic 
Plants,” “Drinking Water,” “Shoreline Usage,” “Swimming Usage,” “Boating Usage,” and 
“Saltwater Invertebrates”) in units of kg/yr. 

• Irrigated Food Type Consumption Data ─ Data in this table includes the maximum and 
average consumption rates in units of kg/yr for three age groups (i.e., “Adults,” “Teens,” 
and “Children”) and the maximum and average holdup times in units of hrs for four food 
types (i.e., “Vegetables,” “Leafy Vegetables,” “Milk,” and “Meat”).  The “Max Individual 
Holdup Time (hr)” refers to the holdup time used to calculate the maximum dose, which 
is the minimum holdup time. 

• Average Individual Consumption Data ─ Data in this table includes average individual 
consumption in units of kg/yr for three age groups (i.e., “Adults,” “Teens,” and “Children”) 
for three consumption types (i.e., “Fish,” “Invertebrates,” and “Drinking Water”). 

There are different values depending on the ICRP methodology (i.e., ICRP-2 (Default), ICRP-30 
and ICRP-72) selected.  For the ICRP-2 and ICRP-30 methodology selected, the exposure 
assumption values are generally from RG 1.109; and when the ICRP-72 methodology is 
selected the exposure assumption values have been derived from the EPA EFH.  Appendix C of 
this manual provides a detailed description of the default usage and consumption rates under 
the different ICRP methodologies. 
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Figure 3-33 Usage/Consumption Data Screen 

The “Save” button allows the user to save any edits made to any of the usage/consumption data 
and when the database has been updated the NRCDose3 code will inform the user as shown in 
Figure 3-32.  Additionally, when the review and/or adjustments to any of the usage/consumption 
data are completed, select the “Close” button to return to the Pathway Factors Tab.  The 
NRCDose3 code will again prompt the user regarding the status of saving any changes made to 
any of the usage/consumption data as shown in Figure 3-32, select the “Yes” button to close the 
prompt window. 

** User Note ** ─ It is recommended that if the ICRP methodology has been changed (e.g., 
from ICRP-2 (Default), to either ICRP-30 or ICRP-72), the user review the usage and 
consumption rates to ensure the proper values are used in the LADTAP dose calculation.  Use 
of ICRP-72 DCF values by an applicant or licensee for a proposed NRC LAR should be 
discussed with the NRC staff prior to submitting the license request.  The code will automatically 
set the usage/consumption values to those associated with the DCFs being used (e.g., ICRP-2 
and ICRP-30 DCFs using the RG 1.109 generic factors and ICRP-72 DCFs using the EPA EFH. 

 Page Defaults Button 

Select the “Page Defaults” button on the Pathway Factors Tab as shown in Figure 3-30 to return 
all liquid pathway parameters in the LADTAP dose calculation to their default values at any time. 
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** User Note** ─ Remember that if a change is made to the pathway factors, this change will be 
carried forward for future runs.  Defaults should be reset by using the “Get Default” option.  
Users should remember that saving a case/file will save all configurations and values as 
selected for the case.  Changing back to defaults will not affect any changes made for a 
particular case/file unless this file is again saved after values changed back to defaults. 

3.3 Code Execution and Reports 

3.3.1 Executing LADTAP 

After all data for the LADTAP dose calculation is entered, select the “Save” button, as shown in 
Figure 3-34 to save the data to the dataset being used for creating the input file as well as to a 
file name if one has been created for the case.  As shown in Figure 3-34 the NRCDose3 code 
will save the data to the LADTAP database, which is used for the calculation.  If working with a 
saved file name, the saved file will also be updated (i.e., *.LN3).  Select the “OK” button to save 
the data to the database file, as used for creating the input for the run, and, as applicable, to 
save to the open “*.LN3” file. 

 

Figure 3-34 Saving LADTAP Inputs 

If the data is to be saved to different “*.LN3” database file, then select the “Save to LN3 File…” 
as shown in Figure 3-3.  The File Tool dropdown menu option (Figure 3-3) is used to open a 
Windows Explorer directory as shown in Figure 3-35.  At this point, name the *.LN3” file and 
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directory location as desired.  Future saves will save to this new file name, as well as the 
database used for the code execution. 

 

Figure 3-35 Windows Explorer directory for saving LADTAP inputs to a new file 

 

Figure 3-36 LADTAP Module Main Screen ─ Create Input 
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Select the “Create Input” button to activate the “View Input” and the “Run LADTAP” buttons on 
the LADTAP Module Main Screen shown in Figure 3-36.  Select the “View Input” button to 
display and review text file data input, as shown in Figure 3-37.  The “Save As..” button opens a 
Windows Explorer directory and allows the user to save the input as an input field file (“*.ln3”).  
The “Print” button prints the input text file and the “Close” button closes the Text Viewer Screen 
as shown in Figure 3-37 and returns to the LADTAP Module Main Screen as shown in 
Figure 3-36. 

 

Figure 3-37 View LADTAP Input ─ Text Viewer Screen 

Select the “Run LADTAP” button to execute the code and generate the output report.  Selecting 
the “Run LADTAP” button will also activate the “View Output, the “FSAR Report,” and the 
“Supplemental Report” buttons on the LADTAP Module Main Screen as shown in Figure 3-38.  
After NRCDose3 completes the LADTAP dose calculation the output will automatically appear 
as a text output file, as shown in Figure 3-39.  The “Save As..” button as shown in Figure 3-39 
opens a Windows Explorer directory and allows the user to save the output as a text file (“*.txt”).  
The “Print” button prints the output text file and the “Close” button closes the Text Viewer 
Screen and returns to the LADTAP Module Main Screen as shown in Figure 3-38.  The user can 
also the access the output text file by selecting the “View Output” button. 

** User Note ** ─ Though not required, users should consider saving LADTAP files in a user-
specified directory other than the NRCDose3 directory, which would facilitate future use and 
sharing without having to navigate to the NRCDose3 directory. 
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Figure 3-38 LADTAP Module Main Screen ─ Run LADTAP 

 

Figure 3-39 View LADTAP Output ─ Text Viewer Screen 
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3.3.2 LADTAP Reports 

There are two additional reports that are created – FSAR Report and Supplemental Report.  As 
shown in Figure 3-40, the FSAR Report consolidates the input data and dose calculations into a 
single text report that provides the information that is considered most important for the 
preparation and review of results for licensing documents.  The “Save As..” button as shown in 
Figure 3-40 opens a Windows Explorer directory and allows the user to save the output as a 
text file (“*.txt”).  The “Print” button prints the FSAR Report and the “Close” button closes the 
Text Viewer Screen and returns to the LADTAP Module Main Screen as shown in Figure 3-38. 

 

Figure 3-40 LADTAP FSAR Report Screen 

As shown in Figure 3-41, the Supplemental Report provides additional documentation of the 
modeling assumptions that were used for the calculations, such as bioaccumulation factors, 
transfer factors, and various pathway constants.  The “Save As..” button as shown in 
Figure 3-41 opens a Windows Explorer directory and allows the user to save the output as a 
text file (“*.txt”).  The “Print” button prints the FSAR Report and the “Close” button closes the 
Text Viewer Screen and returns to the LADTAP Module Main Screen as shown in Figure 3-38. 
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Figure 3-41 LADTAP Supplemental Report Screen 

** User Note ** ─ Only one report is viewable at a time and reports may be either printed or 
saved as a text file, which can then be further edited and/or saved in different formats using 
standard text file editor functions. 
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4.0 GASPAR 
The GASPAR Module within the NRCDose3 code executes a modified version of the GASPAR 
II Fortran code.  The basic calculation methods (algorithms) of the GASPAR II Fortran code, as 
described in NUREG/CR-4653, have not been changed with this update to the NRCDose3 
code.  However, significant changes have been made to the data management and operation to 
support expanded capabilities of NRCDose3.  The GASPAR II Fortran code performs the 
environmental dose assessments for releases of gaseous radioactive effluents from NPPs into 
the atmosphere and implements the dose assessment methods described in RG 1.109.  The 
GASPAR II Fortran code calculates the radiation dose to individuals, population groups, and 
biota from inhalation of contaminated air, direct exposure from contaminated ground and 
consumption of contaminated foods.  The calculated doses provide information for NEPA 
evaluations, and for determining compliance with the NRC public dose limits in 10 CFR Part 20, 
the EPA public dose limits in 40 CFR Part 190, and the NRC ALARA design objectives and 
numerical guides in 10 CFR Part 50, Appendix I. 

The following sections will discuss the steps for establishing and performing GASPAR dose 
calculations using NRCDose3.  The user is directed to NUREG/CR-4653, for the GASPAR II 
Fortran code user guide and technical bases, and this manual which provides additional 
detailed discussion on the assumptions, limitations and methods for the GASPAR dose 
calculations.  On the NRCDose3 Main Selection Screen as shown in Figure 4-1, select the 
“GASPAR – Gaseous Pathway Dose Assessment” button to open the GASPAR Module Main 
Screen as shown in Figure 4-2. 

 

Figure 4-1 NRCDose3 Main Selection Screen (GASPAR Module) 
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Figure 4-2 GASPAR Module Main Screen 

The GASPAR Module Main Screen as shown in Figure 4-2 opens with case data saved in the 
database and contains three main functional areas for inputting data and conducting GASPAR 
dose calculations using NRCDose3.  These functional areas are: (1) the toolbar and initial setup 
area, (2) data input tabs area and (3) code execution and reports area.  Each of these functional 
areas of the GASPAR Module Main Screen is discussed in the following sections with a 
description of the options and capabilities contained therein. 

4.1 Toolbar and Initial Setup Functional Area 

This portion of the GASPAR Module Main Screen contains three tools and two initial setup input 
fields as shown in Figure 4-2.  The three tools are the File Menu Tool, Quit Tool and About Tool.  
The initial setup fields include the Case Title and Dose Factors dropdown menu. 

4.1.1 File Menu Tool 

The File Menu Tool provides the functionality to manage the GASPAR files as shown in 
Figure 4-3.  The File Tool dropdown menu options are: 

• New ─ Select this option to begin a new GASPAR case.  This will clear the database 
that is used for creating the input for a run, i.e., clearing the existing input information. 
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• Open GN3 File ─ Select this option to access and open a “*.GN3” file that was 
previously created with NRCDose3. 

• Save to Database ─ Choose this option to save the current case to the input database.  
When GASPAR is opened, the information in the database is that as last saved before 
exiting and is used to populate all GASPAR screens and windows. 

• Save to GN3 File ─ Choose this option to save the completed case to a “*.GN3” file.  
This allows the file to be saved for later use, or for sharing with others. 

• Delete ─ Choose this option to open an explorer window that will allow the user to delete 
any previously saved “*.GN3” files. 

** User Note ** ─ The “*.GN3” file type and format is used for NRCDose3 GASPAR files.  
Files of other formats for example “*.GNP” files generated under the NRCDose (version 
2.3.20 and earlier) of GASPAR (i.e., NRCDose 2.3.20 GASPAR II files) are not compatible 
with NRCDose3. 

 

Figure 4-3 GASPAR Toolbar with File Tool dropdown menu 
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4.1.2 Quit Tool 

Selecting the Quit Tool from the toolbar as shown in Figure 4-3 will terminate the GASPAR 
Module operation.  There is a Question prompt screen as shown in Figure 4-4 to ensure that the 
user wants to quit and exit the module.  If the “Yes” button is selected the GASPAR Module will 
terminate and any unsaved changed/edited data will not be saved.  Select the “No” button and 
then the appropriate entry from the File Tool dropdown menu to ensure that any information has 
been saved (to the database and/or a *.GN3 file) prior to quitting. 

 

Figure 4-4 GASPAR Module Quitting Tool Screen 

4.1.3 About Tool 

Select the About Tool from the toolbar the About GASPAR screen as shown in Figure 4-5.  This 
displays information about the GASPAR II code.  Select the “OK” button as shown in Figure 4-5 
to return to the GASPAR Module Main Screen as shown in Figure 4-2. 

 

Figure 4-5 About GASPAR Screen 

4.1.4 Case Title Field 

Enter a title in the Case Title Field for the GASPAR case.  This is a descriptive text field only 
and the data in this field are not used for any GASPAR dose calculations.  Appropriate text 
should be selected to assist user in identifying the facility/site and release point information 
(e.g., Facility XYZ and Miscellaneous Waste Discharge).  As shown in Figure 4-2, the scenario 
title, “GASPAR Test Case 1 – ICRP 2,” is used for the initial installation of the NRCDose3 code. 
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This file is included in the install directory (i.e., default directory C:/NRCDose3) and serves as a 
test case and verification for install. 

4.1.5 Dose Factors Dropdown Menu 

As shown in Figure 4-6, the Dose Factors dropdown menu allows the user to select the DCF 
values to be used for the GASPAR dose calculations.  The options available are “ICRP-2 
(Default),” “ICRP-30,” or “ICRP-72” DCF values.  The user should note that if the DCF values 
are changed, the assumed source term (if any has been entered) will be cleared.  In addition, 
the assumed usage and consumption factors will update to the DCF values associated with the 
selected ICRP methodology. 

** User Note ** ─ For purposes of demonstrating compliance with 10 CFR Part 50, Appendix I, 
and 40 CFR Part 190, the ICRP-2 DCF values should be selected.  Likewise, for demonstrating 
compliance with 10 CFR Part 20, the ICRP-30 DCF values should be selected.  Use of ICRP-72 
DCF values by an applicant or licensee for a proposed NRC LAR request should be discussed 
with the NRC staff prior to submitting the license request. 

 

Figure 4-6 GASPAR Dose Factors dropdown menu 
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4.2 Data Input Tabs 

The seven GASPAR Data Input Tabs as shown in Figure 4-2 are: 

1. Options 

2. Source Term 

3. Pop/Prod Data 

4. Special Locations 

5. Dose Factors 

6. Pathway Factors 

7. Consumption Values 

Though not required when generating the input for GASPAR, it is recommended that the user 
enter the necessary parameters and data to the case in order of the Data Input Tabs as they are 
listed in the GASPAR Module Main Screen as shown in Figure 4-2. 

4.2.1 Options Tab 

The Options Tab is used to enter various parameters for the GASPAR dose calculations.  The 
Options Tab includes a combination of check boxes (left-hand side of tab) and input fields (right-
hand side of tab) as shown in Figure 4-7.  Refer to NUREG/CR-4653 for additional information 
on the input values in this tab. 
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Figure 4-7 Options Tab 

 Option Tab ─ Left-Hand Side Options 

As shown in Figure 4-7, the following check boxes appear on the left-side of the Options Tab: 

• Calculate Individual doses only ─ This option (box) is checked by the user when only the 
individual dose calculations from gaseous effluents will be performed by GASPAR.  If 
this option (box) is unchecked, population dose calculations from gaseous effluents will 
be performed in addition to the individual dose calculations.  The value from the 
“GASPAR Test Case 1 – ICRP-2” for this option is “checked.”  To perform population 
doses, additional data is required for population, meteorological, milk, meat and 
vegetable production, which should be entered in the Pop/Prod Data Tab.  Selecting this 
option will open the population data warning screens as shown in Figure 4-8.  Selecting 
the “OK” button on both warning screens will return the user to the Options Tab. 

** User Note ** ─ If the user does not enter data for population, milk, meat, or vegetable, 
a value of “1.0” is automatically entered; a value is required for the program to perform 
the required calculations.  The term "meteorological" as used in the guidance pertaining 
to GASPAR refers to the relative concentration (X/Q) and relative deposition (D/Q) 
values produced by the XOQDOQ module of NRCDose3, but not to the actual 
meteorological data input to that code. 
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Figure 4-8 Population data warning screens 

• Print cumulative dose reports only ─ This option (box) is checked by the user to print 
only the cumulative dose reports without the reporting of dose contribution by 
radionuclide in the standard GASPAR output. The value from the “GASPAR Test Case 1 
– ICRP-2” for this option is “checked.” 

• Print dose-factor library data ─ This option (box) is checked by the user to print all 
applicable DCF values in the GASPAR dose calculation output file.  The value from the 
“GASPAR Test Case 1 – ICRP-2” for this option is “unchecked.” 

• Perform PARTS calculation ─ This option (box) is checked by the user when the code 
performs calculations with the PARTS subroutine.  These calculations represent site-
specific dose factors normalized to unit release in microcuries per second (μCi/s), 
atmospheric dispersion in units of second per cubic meters (s/m3) and deposition in units 
of (m-2).  The value from the “GASPAR Test Case 1 – ICRP-2” for this option is 
“unchecked.”  Selecting this option will open the PARTS calculation information screens 
as shown in Figure 4-9.  Selecting the “OK” button on both warning screens will return 
the user to the Options Tab.  Additionally, selecting the “Info.” button next to this option 
will open the PARTS information screen as shown in Figure 4-10.  Selecting the “OK” 
button on both warning screens will return the user to the Options Tab.  This option is 
only functional with the ICRP-2 DCFs. 

 

Figure 4-9 PARTS calculation information screens 
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Figure 4-10 PARTS information screen 

• Read X/Q and D/Q data from XOQDOQ-generated file ─ This option (box) is checked by 
the user to use meteorological dispersion parameters that were generated by the 
XOQDOQ code.  This option will result in the dispersion parameters for population dose 
calculations and the Special Locations to be read from a file that is created by 
XOQDOQ.  Section 5.3 provides additional information and an explanation of this 
function in the XOQDOQ code.  The value from the “GASPAR Test Case 1 – ICRP-2” for 
this option is “unchecked.” 

4.2.2 Biota Dose Modeling 

Biota dose modeling is an addition to GASPAR that did not exist in the GASPAR II Fortran 
code. The same modeling methodology, as used in LADTAP II, has been employed.  Additional 
modeling details are included in Section 6.0. In GASPAR, there are six (6) assumed terrestrial 
species -- those assumed in LADTAP (muskrat, racoon, heron and duck) plus cow (herbivore) 
and fox (carnivore).  As described below, additional species can be added with user defined 
exposure assumptions. 

The internal dose component to terrestrial biota is based on the same methodology as LADTAP 
II, using the models in BNWL-1754.  Similar to LADTAP where environmental transfer factors 
(bioaccumulation factors) are used for fish, invertebrates and algae, in GASPAR there are 
transfer factors for vegetation and meat.  The GASPAR modeling is based on defining a species 
as herbivore or carnivore – eating plants or meat, respectively, with calculated radionuclide 
concentrations using the RG 1.109 modeling. 

The internal dose component for all herbivores (cow, muskrat, racoon, duck and heron) is 
calculated considering the radionuclide concentration in the meat, as modeled by RG 1.109, 
equation C-12 for cows, and applying the nuclide-specific absorbed dose coefficients for the 
appropriate effective radius.  See User Note below on effective radius.  For other herbivores, the 
internal dose is calculated based on a ratio of the assumed ingestion rate to the biota mass and 
applying the adult human ingestion DCF, with an adjustment for the difference in absorbed 
energy between an adult (30 cm effective radius) and the biota effective radius. 

The internal dose to a carnivore is calculated similarly but correlated to the calculated meat 
(cow) concentration and adjusting for differences in mass, consumption rate, and effective 
radius.  For both herbivores and carnivores, the adult inhalation dose is added as an 
approximation of the inhalation exposure component to provide the total internal dose. 

The external dose component is the same as the adult ground plane dose multiplied by a factor 
of 2 to account for proximity to ground and divided by 0.7 to remove the shield factor assumed 
for human exposure.  The effect of this is that the external component of the biota dose is 2.86 
times that calculated for adults.  Table 4-1 lists the parameters used to calculate the biota dose 
in GASPAR in NRCDose3. 
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Table 4-1 Biota dose parameters for the GASPAR code in NRCDose3 

Species Mass (g) 
Effective 
Radius* 

(cm) 

Primary 
Food 
Eaten 

Consumption Rate 
(g/d) 

Muskrat 
(from LADTAP II) 1,000 5 Terrestrial 

plants 100 

Raccoon 
(from LADTAP II) 12,000 15 Terrestrial 

plants 200 

Duck 
(from LADTAP II) 1,000 5 Terrestrial 

plants 100 

Heron 
(from LADTAP II) 4,600 10 Terrestrial 

plants 600 

Cow 
(herbivore) N/A 30 Terrestrial 

plants N/A 

Fox 
(carnivore)a 5,700 10 Meat (cow) 520 

User Defined As defined As defined As defined As defined 
* For GASPAR, the selection of effective radius must correspond to one of the eight radii values that have been 
tabulated.  The values as assigned are considered most representative for the species, considering the available 
values. 

• New Biota Button ─ Select the New Biota button to open the Additional Biota Types 
Screen as shown in Figure 4-11 and enter the required parameters for any new biota 
exposure.  To define a new biota type, select the “Add Biota Type” button to activate the 
biota information section at the bottom as shown in Figure 4-11.  For each new biota 
type, enter the name, the primary food type from dropdown menu options (carnivore or 
herbivore), the mass in units of g, the effective radius for the biota in units of cm and the 
consumption rate in units of kg/yr.  Select the “Save” button to save the new biota type 
and return to the Options Tab as shown in Figure 4-7.  To remove a biota type, select 
(highlight) the biota type from the upper portion as shown in Figure 4-11 and select the 
“Delete Biota Type” button to delete the biota type.  Selecting the “Clear” button will 
remove all biota types from the file and selecting the “Close” button will close the 
Additional Biota Types Screen and return the user to the Options Tab. 

** User Note ** ─ The code can only address a single food type, either plant or meat.  
While it is recognized that a racoon is an omnivore, the default modeling assumes a 
plant-based diet for the racoon, which is consistent with that assumed in LADTAP and 
consistent with BNWL-1754 modeling.  Modeling as a carnivore may be performed by 
using the “Add Biota Type” function with appropriate inputs on consumption. 
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** User Note ** ─ A user could perform species-specific modeling by modifying the 
exposure and uptake assumptions and transfer factors that are unique for the species 
(e.g., transfer factors for chickens). 

** User Note ** ─ The effective radius is used to model the biota as a sphere geometry, 
such that different dose absorption values can be applied for different size/mass biota.  
Effective radius is the radius of a sphere (considered muscle) that has the same mass 
as the biota in question, based on an assumed uniformly distributed mass.  For an 
assumed nominal density of 1 gram per cubic centimeter (g/cm3) for muscle, the 
effective radius can be approximated as the cubic root of the quantity (mass (in grams) 
divided by 4.19, where 4.19 = 4/3 * π).  Refer to Appendix D for a description of the 
modeling and calculations for the nuclide-specific deposited energy (dose) values based 
on effective radius. 

 

Figure 4-11 Additional Biota Types Screen 

 Option Tab ─ Right-Hand Side Options 

As shown in Figure 4-7, the following input parameters appear on the right-side of the Options 
Tab.  These parameters are considered site-specific and are used to reflect the particular 
characteristics of the environment where the facility is currently or is to be located. 

• Fraction of the year that leafy vegetables are grown is unitless with the value from the 
“GASPAR Test Case 1 – ICRP-2” set to “0.75” and the allowable range for values in this 
field is greater than 0.0. 

• Fraction of the year that milk cows are on pasture is unitless with the value from the 
“GASPAR Test Case 1 – ICRP-2” set to “0.80” and the allowable range for values in this 
field is greater than 0.0. 
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• Fraction of max. individual’s vegetable intake from own garden is unitless with the value 
from the “GASPAR Test Case 1 – ICRP-2” set to “0.50” and the allowable range for 
values in this field is greater than 0.0. 

• Fraction of milk cows feed intake from pasture while on pasture is unitless with the value 
from the “GASPAR Test Case 1 – ICRP-2” set to “1.00” and the allowable range for 
values in this field is greater than 0.0. 

** User Note ** ─ The milk transfer factors in GASPAR, taken from RG 1.109, Table E-
1, are specific to dairy cows.  Application to other, similar milk animals may be 
appropriate but should consider the particular animal characteristics. 

• Average absolute humidity is entered in units of percent with the value from the 
“GASPAR Test Case 1 – ICRP-2” set to “8.00.”  The allowable range for values in this 
field is greater than 0.0. 

• Average temperature over growing season is in units of degrees Fahrenheit (°F) with the 
value from the “GASPAR Test Case 1 – ICRP-2” set to “70.00” °F.  The allowable range 
for values in this field is greater than 0.0 °F. 

• Fraction of the year that goats are on pasture is unitless with the value from the 
“GASPAR Test Case 1 – ICRP-2” set to “1.00” and the allowable range for values in this 
field is greater than 0.0. 

** User Note ** ─ There are a limited number of milk transfer factors, taken from RG 
1.109, Table E-1, specifically for goats.  Application to other, similar milk animals may be 
appropriate but should consider the particular animal characteristics. 

• Fraction of goat feed intake from pasture while on pasture is unitless with the value from 
the “GASPAR Test Case 1 – ICRP-2” set to “1.00” and the allowable range for values in 
this field is greater than 0.0. 

• Fraction of the year that beef cattle are on pasture is unitless with the value from the 
“GASPAR Test Case 1 – ICRP-2” set to “0.80” and the allowable range for values in this 
field is greater than 0.0. 

** User Note ** ─ The meat transfer factors in GASPAR, taken from RG 1.109, Table E-
1, are specific to beef cattle.  Application to other, similar milk animals may be 
appropriate but should consider the particular animal characteristics. 

• Fraction of beef-cattle feed intake from pasture while on pasture is unitless with the 
value from the “GASPAR Test Case 1 – ICRP-2” set to “1.00” and the allowable range 
for values in this field is greater than 0.0. 

4.2.3 Source Term Tab 

The Source Term Tab is used to enter the different source terms for the GASPAR dose 
calculations as shown in Figure 4-12.  Typically, there is a unique source term for each release 
type.  For this version of GASPAR, as incorporated into NRCDose3, only a single source term 
may be used for each case/run.  If a facility has different source terms for multiple release 
points, additional cases (*.GN3 files) will be needed.  For each source term enter a title (e.g., 
Reactor Vent, Aux. Bldg. Vent), the source term multiplication factor (unitless with default value 
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of “1.00”) that will be applied to the input release activity for each radionuclide, and annual 
release time for purges in units of hr (default value of “0.0” hr). 

 

Figure 4-12 Source Term Tab 

The radionuclides in the source term along with their quantity in Ci are displayed on the right-
hand portion of the Source Term Tab as shown in Figure 4-12.  To add an additional 
radionuclide to the source term, select the “Add Nuclide” button as shown in Figure 4-12. 

** User Note ** ─ The user must ensure that the desired ICRP methodology has been selected 
before entering any additional radionuclide data.  Selecting the “Add Nuclide” button on the 
Source Term Tab will flash open a warning message reminding the users about DCF values as 
shown in Figure 4-13 and then open the Select Nuclide Screen as shown in Figure 4-12.  
Changing the ICRP methodology will cause the source term to be cleared. 

Select the radionuclide (highlighting the radionuclide) to be added to the source term and then 
click the “Add” button as shown in Figure 4-12 to add the radionuclide to the source term on the 
Source Term Tab.  Holding the “control” key during radionuclide selection will allow for the 
selection of multiple radionuclides.  The individual radionuclides, activity release and total 
quantity in units of Ci will be continuously updated.  When the source term data has been 
entered, it is recommended to save the input to the “*.GN3” file by selecting the “Save” button. 
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Figure 4-13 Source Term Warning Message 

Likewise, the user can remove radionuclides from the source term by selecting the radionuclide 
to be removed (highlighting the radionuclide) and then clicking the “Delete Nuclide” button as 
shown in Figure 4-12.  Selecting the “Clear” button clears out all source term data (Nuclide, 
Class, f1 value and Quantity) for all radionuclides in the Source Term Tab. 

4.2.4 Pop/Prod Data Tab 

The Pop/Prod Data Tab is where extensive information about demographics, food production 
and meteorology (if necessary) around the site is entered as shown in Figure 4-14.  The Data 
Types contain five options for entering demographic data, which are: (1) Population, (2) Milk 
Production, (3) Meat Production, (4) Vegetable Production, and (5) Meteorological (note: sector 
dispersion and deposition values will need to be manually inputted unless an XOQDOQ 
generated input file is created).  The demographic and production data can be entered either as 
a total within a 50-mile radius, or on a per sector basis at varying distances from 1 to 50 miles.  
The entry format/table for the sector and distance data only appears if the “Input by distance 
and direction” box is checked. 

Selecting the “Input by distance and direction” check box activates the radial distance (1, 2, 3, 4, 
5, 10, 20, 30, 40, and 50 miles) and each of the 16 meteorological sectors input table as shown 
in Figure 4-14. 
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** User Note ** ─ Data is required for each Data Type dropdown menu option; if the user does 
not enter a value, a value of “1.0” is automatically added to support the calculations required by 
the code. 

 Population 

Select the Population option from the Data Type dropdown menu to enter the total population 
within 50 miles of the site.  The allowable range for values in this field is greater than 0.0.  To 
enter the population data on a per sector basis, select the check box to open the population 
data sectors input table as shown in Figure 4-14.  Enter the population data for each radial 
distance (1, 2, 3, 4, 5, 10, 20, 30, 40, and 50 miles) and each of the 16 downwind direction 
sectors.  Note: the demographic data represents the value in the sector bounded by the 
distances.  For example, 1 mile represents the population in the 0 to 1-mile distance; 10 miles 
represents the population in the 5 to 10-mile distance.  Select the “Update” button to save the 
population data sector data.  Use the “Clear” button to delete the population data from the 
sector table and open the Clear Data Warning Screen as shown in Figure 4-15. 

 

Figure 4-14 Pop/Prod Data Tab 
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Figure 4-15 Clear Data Warning Screen 

 Milk Production 

Select the Milk Production option from the Data Type dropdown menu to enter the total milk 
production in units of L/yr within 50 miles of the site.  The allowable range for values in this field 
is greater than 0.0.  To enter the total milk production data on a per sector basis, select the 
check box to open the milk production data sectors input table as shown in Figure 4-14.  Enter 
the total milk production data for each radial distance (1, 2, 3, 4, 5, 10, 20, 30, 40, and 50 miles, 
representing the distance ranges as discussed above) for each of the 16 downwind direction 
sectors.  Select the “Update” button to save the total milk production sector data.  Use the 
“Clear” button to delete the population data from the sector table and open the Clear Data 
Warning Screen as shown in Figure 4-15. 

 Meat Production 

Select the Meat Production option from the Data Type dropdown menu to enter the total meat 
production in units of kg/yr within 50 miles of the site.  The allowable range for values in this 
field is greater than 0.0.  To enter the total meat production data on a per sector basis, select 
the check box to open the meat production data sectors input table as shown in Figure 4-14.  
Enter the total meat production data for each radial distance (1, 2, 3, 4, 5, 10, 20, 30, 40, and 50 
miles) and each of the 16 downwind distance sectors.  Select the “Update” button to save the 
total meat production sector data.  Use the “Clear” button to delete the total meat production 
data from the sector table and open the Clear Data Warning Screen as shown in Figure 4-15. 

 Vegetable Production 

Select the Vegetable Production option from the Data Type dropdown menu to enter the total 
vegetable production in units of kg/yr within 50 miles of the site.  The default value from the 
“GASPAR Test Case 1 – ICRP-2” of “1.00+03” kg/yr and the allowable range for values in this 
field is greater than 0.0.  To enter the total vegetable production data on a per sector basis, 
select the check box to open the vegetable production data sectors input table as shown in 
Figure 4-14.  Enter the total vegetable production data for each radial distance (1, 2, 3, 4, 5, 10, 
20, 30, 40, and 50 miles, representing the distance ranges as discussed above) for each of the 
16 downwind distance sectors.  Select the “Update” button to save the total vegetable 
production sector data.  Use the “Clear” button to delete the total vegetable production data 
from the sector table and open the Clear Data Warning Screen as shown in Figure 4-15. 

 Meteorological 

Select the Meteorological option from the Data Type menu if the meteorological data (dispersion 
and deposition values) need to be manually entered within GASPAR, and not imported from a 
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completed XOQDOQ run (see Section 5.3).  As discussed in Section 4.2.1.1, this menu option 
is only required if the “Read Met data from XOQDOQ-generated file” is NOT selected 
(unchecked box) on the Options Tab.  Calculated dispersion and deposition values are 
dependent of the release point characteristics as specified in the XOQDOQ code inputs.  Care 
should be exercised in verifying that the dispersion and deposition data, as entered or imported 
here, is representative of the source term for the modeled release point. 

Select the dispersion and deposition data to be entered from either dispersion (i.e., “Undecayed, 
Undepleted;” “Decayed, Undepleted;” and “Decayed, Depleted”) or Ground Deposition as 
discussed in Section 2.2.6 of NUREG/CR-4653.  Enter the applicable dispersion in units of s/m3 
or deposition in units of m-2 for each radial distance (1, 2, 3, 4, 5, 10, 20, 30, 40, and 50 miles 
representing the distance ranges as discussed above) for each of the 16 downwind 
meteorological sectors, as shown on Figure 4-16.  Corresponding values from the XOQDOQ 
output are those represented in the tables titled, “SEGMENT BOUNDARIES IN MILES FROM 
SITE.”  Select the “Update” button to save the data.  Use the “Clear” button to delete the total 
data set from the sector table, which will open a Clear Data Warning Screen as shown in 
Figure 4-15.  Repeat this above described process for the other dispersion or deposition 
parameters. 

 

Figure 4-16 Pop/Prod Data Tab ─ Meteorological Data Type 

As an alternative to manually entering the dispersion and deposition data, select the “Import X/Q 
and D/Q Data” button, as shown on Figure 4-16 to import these data from an appropriate MS 
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Excel (“*.xlsx”) file.  Selecting the “Import X/Q and D/Q Data” button will open a Windows 
Explorer directory allowing the user to navigate to the appropriate file to be imported as shown 
in Figure 4-17.  Selecting the MS Excel file to be imported and the NRCDose 3 code will 
automatically import the data and populate the sector table as shown in Figure 4-16.  After the 
data has been imported, select the “Update” button as shown in Figure 4-16 to save the data. 

 

Figure 4-17 Windows Explorer directory for meteorological data import to GASPAR 

A separate MS Excel (“*.xlsx”) file is required for EACH of the 3 dispersion parameters and the 
single deposition parameter, so this process must be repeated four times for each of the four 
meteorological data sets (Undecayed/Undepleted, Decayed/Undepleted, Decayed/Depleted and 
Ground Deposition).  A template MS Excel example file, as shown in Figure 4-18, is included in 
the NRCDose3 code installation.  Only the values in the shaded yellow cells are imported into 
GASPAR. 

 

Figure 4-18 Meteorological Data Example MS Excel File 
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** User Note ** ─ Ensure that the dispersion or deposition data sets are input into the template 
and dialog box for the correct downwind direction, starting with Sector N and ending with Sector 
NNW. 

4.2.5 Special Location Data Tab 

The Special Location Data Tab is where the parameters used to define the atmospheric 
dispersion and deposition values at any special receptor locations are entered as shown in 
Figure 4-19.  As discussed in Section 4.2.1.1, this tab is only available if the “Read X/Q and D/Q 
data from XOQDOQ-generated file” is NOT selected (unchecked box) on the Options Tab.  This 
tab is not available if the “Read X/Q and D/Q data from XOQDOQ-generated file” is selected on 
the “Options” screen, as the special locations are already defined in that file.  The Special 
Location Data Tab includes the Special Location Records Section (left-hand side of tab) and the 
Location for Individual Doses Section (right-hand side of tab) as shown in Figure 4-19. 

 

Figure 4-19 Special Location Tab 

The Special Locations Records Section (left-hand side of tab) lists the name and number of 
records of each special location.  The user can review and edit special locations by selecting 
(highlighting) the special location and reviewing the entries in the Location for Individual Doses 
Section (right-hand side of tab).  The user can delete a special location record by selecting the 
special location record to be removed (highlight) and then clicking the “Remove” button as 
shown in Figure 4-19.  Likewise, a special location record can be added by selecting the “Add” 
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button and entering the parameters listed in the Location for Individual Doses Section (right-
hand side of tab). 

In the Location for Individual Doses Section (right-hand side of tab) of the tab each special 
location is defined by the following parameters: 

• Name of Location ─ This field contains the name of the special location to be used in the 
GASPAR dose calculation. 

• Direction from site ─ This field contains a dropdown menu with options to select from the 
16 downwing direction sectors. 

• Distance from site (meters) ─ This field contains the distance of the special location from 
the site, as modeled in XOQDOQ, in units of meters and the allowable range for values 
in this field is greater than 0.0. 

• Atmospheric Dispersion Factors ─ This field contains the atmospheric dispersion factors 
in units of s/m3 for the three atmospheric dispersion types (i.e. “Undecayed, 
Undepleted;” “Decayed, Undepleted;” and “Decayed, Depleted”) and the allowable range 
for values in this field is greater than 0.0. 

• Ground Deposition Factor ─ This field contains the ground deposition factor in units of 
m-2 and the allowable range for values in this field is greater than 0.0. 

Select the “Don’t print any detailed reports” option (check box) if none of the detailed reports are 
required to be printed.  If a report of the pathway dose contribution by radionuclide is desired 
then uncheck this selection.  Detailed reports will be included for all unchecked pathway boxes.   
Select the “Save” button when edits to the special location have been completed.  This “Save” 
will save the data for the specific location only, not for the total input file. 

4.2.6 Dose Factors Tab 

The Dose Factors Tab is where DCF values for the GASPAR dose calculation can be selected, 
reviewed and modified as necessary as shown in Figure 4-20, and is identical to the Dose 
Factors Tab in the LADTAP Module.  See Section 3.2.5 for the discussion on the details of the 
Dose Factors Tab, and Section 6.1 for a discussion on how the DCF values were determined.  
After selecting the appropriate ICRP methodology (i.e., ICRP-2 (Default), ICRP-30, and ICRP-
72), from the Dose Factors dropdown menu, select the Factors dropdown menu arrow to open 
and select the applicable age group and pathway (e.g., Adult Ingestion, Adult Inhalation, Teen 
Ingestion, Teen Inhalation, Child Ingestion, Child Inhalation, infant Ingestion, Infant Inhalation) 
DCF values. 

After selecting the appropriate ICRP methodology and Factors from their respective dropdown 
menus all applicable organ DCF values are available for review as shown in Figure 4-20.  Select 
the “Nuclide Data” button to open the Nuclide Data Screen which contains two tables of data as 
shown in Figure 4-21.  The top table contains applicable Nuclide data, such as Atomic Weight, 
Isomeric State, and Decay Constant.  Additionally, using the scrolling tool on the top table 
allows the user to view the DCF values which are summarized in Table 4-2.  The bottom table 
describes the effective energy (MeV/nt) deposited for a given effective radius.  See Appendix D 
of this manual for a detailed description of the bottom table of Figure 4-21.  Select the “Exit” 
button to return to the Dose Factors Tab. 
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Figure 4-20 Dose Factors Tab 

Table 4-2 Description of GASPAR DCF Values 

DCF Description Units 

EXG TB Factor Total Body (or effective) DCF from ground plane 
exposure 

mrem hr⁄
ρCi m2⁄  

EXS TB Factor Total Body (or effective) DCF from submersion in 
contaminated water 

mrem hr⁄
ρCi L⁄

 

EXG Skin Factor Skin DCF from ground plane exposure 
mrem hr⁄
ρCi m2⁄  

EXS Skin Factor Skin DCF from submersion in contaminated water 
mrem hr⁄
ρCi L⁄
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Figure 4-21 Nuclide Data Screen 

If ICRP-2 DCF values are selected, the ICRP total body DCF values from ICRP-2 are used, 
which is no change from the original releases of LADTAP II, GASPAR II and NRCDose version 
2.3.20.  If ICRP-30 DCF values are selected, ICRP Report No. 26 (ICRP-26) [Ref. 23] based 
effective and skin DCF values are used, as found in Federal Guidance Report No. 12 (FGR 12) 
[Ref. 24].  If ICRP-72 DCF values are selected, ICRP-60 based effective DCF values (also from 
FGR 12) and ICRP-26 based skin DCF values are used. 

** User Note ** ─ Use of ICRP-72 DCF values by an applicant or licensee for a proposed NRC 
LAR should be discussed with the NRC staff prior to submitting the license request. 

These external DCF values have been modified, if ICRP-30 or ICRP-72 DCF values are 
selected, to account for short lived progeny radionuclides.  See Sections 6.1 and 6.2 for more 
details and Tables 6-1 and 6-2 for the adjusted radionuclides. 

Select the “Submersion” button to open the Noble Gas Submersion DFs - Default Screen as 
shown in Figure 4-22 and review the DCF values used for air submersion calculations.  The 
Gamma Air and Beta Air DCF values from RG 1.109 have not been changed from the original 
release of GASPAR II.  The Gamma T-Body and Beta Skin DCF values have been updated to 
ICRP-26 methodology DCF values when either ICRP-30 or ICRP-72 methodologies are 
selected.  See Section 6.1 for a discussion on the source of these DCF values.  Select the 
“Close” button to return to the Dose Factors Tab. 
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Figure 4-22 Noble Gas Submersion DFs - Default Screen 

4.2.7 Pathway Factors Tab 

The Pathway Factors Tab is used to modify the default RG 1.109 environmental transport and 
exposure assumptions as used for the GASPAR dose calculation.  In general, the values for the 
parameters included on this tab should only be changed if there is suitable data supporting a 
site-specific change.  As shown in Figure 4-23, the Pathway Factors Tab contains four main 
parameter input sections: (1) general input parameters (upper left-hand portion), (2) Holdup and 
Transport Times Section, (3) Goat Feed to Milk Transfer Factors Section, and (4) Physical 
Parameter Section.  Additionally, this tab contains two selection buttons: (1) the “Transfer 
Factors” button, and (2) the “Page Defaults” button. 

** User Note** ─ Remember that if a change is made to the pathway factors, this change will be 
carried forward for future runs.  Defaults should be reset by using the “Get Default” option.  
Users should remember that saving a case/file will save all configurations and values as 
selected for the case.  Changing back to defaults will not affect any changes made for a 
particular case/file unless this file is again saved after values changed back to defaults.  
Therefore, if any question about saved values, it is good to reset to defaults prior to initiating 
new cases. 
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Figure 4-23 Pathway Factors Tab 

 General Pathway Parameters Section 

The following pathway input parameters are entered in the upper left-hand side of the Pathway 
Factors Tab as shown in Figure 4-23.  These pathway parameters include: 

• Growing period for vegetables consumed by a human is entered in units of d with the 
default value from RG 1.109 of “60” d, which is the value used in the “GASPAR Test 
Case 1 – ICRP-2.”  The allowable range for values in this field is greater than 0.0 d. 

• Cow feed ingestion rate entered in units of kg/d with the default value from RG 1.109 of 
“50.0” kg/d, which is the value used in “GASPAR Test Case 1 – ICRP-2.”  The allowable 
range for values in this field is greater than 0.0 kg/d. 

• Goat feed ingestion rate is entered in units of kg/d with the default value from RG 1.109 
of “6.0” kg/d, which is the value used in “GASPAR Test Case 1 – ICRP-2.” The allowable 
range for values in this field is greater than 0.0 kg/d. 

• Vegetables retention for particulates other than iodine is unitless with the default value 
from RG 1.109 of “0.2,” which is the value used in “GASPAR Test Case 1 – ICRP-2.” 
The allowable range for values in this field is greater than 0.0 and should not exceed 1.0. 
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• Weather removal constant is the vegetation weathering removal for a radionuclide in 
units of inverse seconds (1/sec) with the default value from RG 1.109 of “5.73E-07” 
1/sec (corresponding to a 14 day half-life), which is the value used in “GASPAR Test 
Case 1 – ICRP-2.”  The allowable range for values in this field is greater than 0.0 1/sec. 

• Soil surface density is entered in units of kg/m2 with the default value from RG 1.109 of 
“240.0” kg/m2, which is the value used in “GASPAR Test Case 1 – ICRP-2.”  The 
allowable range for values in this field is greater than 0.0 kg/m2. 

• Iodine retention is unitless with the default value from RG 1.109 of “0.5,” which is the 
value used in “GASPAR Test Case 1 – ICRP 2.”  The allowable range for values in this 
field is greater than 0.0 and should not exceed 1.0. 

• Pasture grass yield is entered in units of kg/m2 with the default value from RG 1.109 of 
“0.5” kg/m2, which is the value used in “GASPAR Test Case 1 – ICRP-2.”  The allowable 
range for values in this field is greater than 0.0 kg/m2. 

• Feed crop yield is entered in units of kg/m2 with the default value from RG 1.109 of “2.0” 
kg/m2, which is the value used in “GASPAR Test Case 1 – ICRP-2.”  The allowable 
range for values in this field is greater than 0.0 kg/m2. 

• Garden vegetable crop yield is entered in units of kg/m2 with the default value from RG 
1.109 of “2.0” kg/m2, which is the value used in “GASPAR Test Case 1 – ICRP-2.”  The 
allowable range for values in this field is greater than 0.0 kg/m2. 

 Holdup and Transport Times Section 

The following input parameters are entered in the Holdup and Transport Times Section of the 
Pathway Factors Tab as shown in Figure 4-23.  All default values come from RG 1.109, which 
have also been used in “GASPAR Test Case 1 – ICRP-2.”  These holdup and transport time 
parameters include: 

• Meat to consumption is entered in units of seconds (sec) with the default value of 
“1.73E+06” sec and the allowable range for values in this field is greater than 0.0 sec. 

• Milk to the population is entered in units of sec with the default value of “3.46E+05” sec 
and the allowable range for values in this field is greater than 0.0 sec. 

• Vegetables to the population is entered in units of sec with the default value of 
“1.21E+06” sec and the allowable range for values in this field is greater than 0.0 sec. 

• Vegetables to the individual is entered in units of sec with the default value of 
“5.18E+06” sec and the allowable range for values in this field is greater than 0.0 sec. 

• Milk to the individual is entered in units of sec with the default value of “1.73E+05” sec 
and the allowable range for values in this field is greater than 0.0 sec. 

• Leafy vegetables to the individual are entered in units of sec with the default value from 
the “GASPAR Test Case 1 – ICRP-2” of “8.64E+04” sec and the allowable range for 
values in this field is greater than 0.0 sec. 
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• Pasture grazing period is entered in units of sec with the default value of “2.59E+06” sec 
and the allowable range for values in this field is greater than 0.0 sec. 

• Feed storage time is entered in units of sec with the default value of “7.78E+06” sec and 
the allowable range for values in this field is greater than 0.0 sec. 

 Goat Feed to Milk Transfer Factors Section 

The Goat Feed to Milk Transfer Factors Section displays the transfer factors for the elements 
listed in Table 4-3 in units of days per liter (d/L).  Table 4-3 displays the default values for the 
elements from RG 1.109 and as used in “GASPAR Test Case 1 – ICRP-2.” and the allowable 
range for values in each field is greater than 0.0 d/L. 

Table 4-3 Goat Feed to Milk Transfer Factors 

Element 
Transfer 
Factor 
(d/L) 

Element 
Transfer 
Factor 
(d/L) 

Element 
Transfer 
Factor 
(d/L) 

Hydrogen 0.17 Chlorine 0.50 Strontium 0.14 

Boron 0.012 Potassium 0.057 Iodine 0.06 

Carbon 0.10 Calcium 0.47 Cesium 0.30 

Magnesium 0.042 Iron 0.0013 Polonium 0.0018 

Phosphorus 0.25 Copper 0.013  

 Physical Parameter Section 

The following input parameters are entered in the Physical Parameters Section of the Pathway 
Factors Tab as shown in Figure 4-23.  All default values come from RG 1.109, which have also 
been used in “GASPAR Test Case 1 – ICRP-2,” except for midpoint of plant life, as discussed 
below.  These parameters include: 

• Midpoint of plant life is entered in units of sec with the default value of “6.31E+08” sec 
and the allowable range for values in this field is greater than 0.0 sec.  This value 
corresponds to 20 years, which differs from RG 1.109 default value of 15 years and 
reflects the current 40-year operating license for NPPs. 

• Shielding factor for individuals is unitless with the default value of “0.7” and the allowable 
range for values in this field is less than or equal to 1.0 and greater than 0.0. As used for 
the calculation, this factor is in the numerator, so its value should not exceed 1.0, where 
1.0 would indicate no reduction for shielding. 

• Shielding factor for populations is unitless with the default value of “0.5” and the 
allowable range for values in this field is less than or equal to 1.0 and greater than 0.0. 
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• Hydrosphere water volume is entered in units of L with the default value in GASPAR 
(see NUREG/CR-4653) of “2.7E+19” L and the allowable range for values in this field is 
greater than 0.0 L. 

• Volume of the atmosphere is entered in units of cubic meters (m3) with the default value 
in GASPAR (see NUREG/CR-4653) of “3.8E+18” m3 and the allowable range for values 
in this field is greater than 0.0 m3. 

• Iodine deposition fraction is unitless with the default value of “0.5” and the allowable 
range for values in this field is greater than 0.0. 

 Transfer Factors Button 

To review and edit the transfer factors for meat, soil and milk, select the “Transfer Factors” 
button shown on Figure 4-23 to open the Transfer Factors Screen as shown in Figure 4-24.  To 
edit the transfer factor for an element, select the cell to be changed and type in the edited value.  
If any of the transfer factors are updated, select the “Save” button to save edits to the transfer 
factors.  Additionally, select the “Get Defaults” button to revert all transfer factors back to their 
default values.  Finally, select the “Close” button when edits are complete which will open the 
question screen as shown in Figure 4-24.  Select the “Yes” button to return to the Pathway 
Factors Tab as shown in Figure 4-23. 

** User Note** ─ Remember that if a change is made to the transfer factors, this change will be 
carried forward for future runs.  Defaults should be reset by using the “Get Default” option.  
Users should remember that saving a case/file will save all configurations and values as 
selected for the case.  Changing back to defaults will not affect any changes made for a 
particular case/file unless this file is again saved after values changed back to defaults.  
Therefore, if any question about saved values, it is good to reset to defaults prior to initiating 
new cases. 

 Page Defaults Button 

Select the “Page Defaults” button on the Pathway Factors Tab as shown in Figure 4-23 to return 
all pathway parameters in the GASPAR database to their RG 1.109 default values. 
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Figure 4-24 Transfer Factors Screen 

4.2.8 Consumption Values Tab 

The Consumption Values Tab presents the demographic and usage parameters for individuals 
and the average population as shown in Figure 4-25.  This tab contains the Usage Parameters 
Section (upper portion of tab) and the Intake Consumption Data Section.  Two different intake 
and consumption assumptions are used in the code depending upon the ICRP methodology 
(i.e., ICRP-2 (Default), ICRP-30, and ICRP-72) as selected from the Dose Factors dropdown 
menu.  One set of intake and consumption assumptions for ICRP-2 (Default) and ICRP-30 are 
taken from RG 1.109 and the second set of intake and consumption assumptions for ICRP-72 
have been derived from EPA EFH. 

** User Note ** ─ For population doses, the average consumption rates are used for distributing 
the production between the different age groups for application of the appropriate age group 
DCF values.  No population doses are calculated for leafy vegetables, total vegetables only. 

The Usage Parameters Section contains the 2000 U.S. population and the fractions of 
population for adults, teenagers and children.  The default value for the 2000 U.S. population is 
“2.8E+08” and the fractions of population are defaulted depending upon the ICRP methodology 
(i.e., ICRP-2 (Default), ICRP-30, and ICRP-72) as selected from the Dose Factors dropdown 
menu.  If the calculation to be performed is using ICRP-2 (Default) and ICRP-72 DCF values, 
the population fractions will “0.71,” “0.18,” and “0.11” for adults, teenagers and children, 
respectively.  If the calculation to be performed is using ICRP-30 DCF values, the population 
fraction will be “1.00” for adults and “0.0” for teenagers and children.  ICRP-30 contains DCF 
values only for an adult age range. 
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Figure 4-25 Consumption Values Tab 

• The Intake Consumption Data Section includes the following parameters.  Values are 
dependent on the ICRP methodology selected, where the ICRP-2 (Default) and ICRP-30 
values are from RG 1.109 and the ICRP-72 values have been derived from the EPA 
EFH. 

• The intake type displays either the maximum or average age-group consumption type 
depending upon the ICRP methodology. 

• The maximum and average inhalation rate is displayed in units of cubic meters per year 
(m3/yr).  The default values vary depending upon the ICRP methodology. 

• The maximum and average vegetable intake is displayed in units of kg/yr with the default 
values varying depending upon the ICRP methodology. 

• The maximum and average leafy vegetable intake is displayed in units of kg/yr with the 
default values varying depending upon the ICRP methodology. 

• The maximum and average milk intake is displayed in units of kg/yr with the default 
values varying depending upon the ICRP methodology. 

• The maximum and average meat intake is displayed in units of kg/yr with the default 
values varying depending upon the ICRP methodology. 
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Select the “Save” button to save any changes and select the “Usage Defaults” button to restore 
the maximum individual defaults.  See Appendix C of this manual for further discussion of the 
default intake and consumption assumptions depending on the ICRP methodology. 

** User Note** ─ Remember that if a change is made to the consumption values, this change 
will be carried forward for future runs.  Defaults should be reset by using the “Get Default” 
option.  Users should remember that saving a case/file will save all configurations and values as 
selected for the case.  Changing back to defaults will not affect any changes made for a 
particular case/file unless this file is again saved after values changed back to defaults.  
Therefore, if any question about saved values, it is good to reset to defaults prior to initiating 
new cases. 

4.3 Code Execution and Reports 

4.3.1 Executing GASPAR 

After all data for the GASPAR dose calculation is entered, select the “Save” button as shown in 
Figure 4-26 to save the data to the dataset being used for creating the input file as well as to a 
file name if one has been created for the case.  As shown in Figure 4-26 the NRCDose3 code 
will save the data to the GASPAR database, which is used for the calculation.  If working with a 
saved file name, the saved file will also be updated (i.e., *.GN3).  Select the “OK” button to save 
the data to the database file, as used for creating the input for the run, and, as applicable, to the 
open “*.GN3” file. 

If the data is to be saved to a different “*.GN3” database file, then select the “Save to GN3 
File…” as shown in Figure 4-3.  The File Tool dropdown menu option (Figure 4-3) is used to 
open a Windows Explorer directory as shown in Figure 4-27.  At this point, name the *.GN3” file 
and directory location as desired.  Future saves will save to this new file name, as well as the 
database used for the code execution. 
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Figure 4-26 Saving GASPAR Inputs 

 

Figure 4-27 Windows Explorer directory for saving GASPAR inputs to a new file 

Select the “Create Input” button to activate the “View Input” and “Run GASPAR” buttons on the 
GASPAR Module Main Screen as shown in Figure 4-28.  Select the “View Input” button to 
display and review text file data input as shown in Figure 4-29.  The “Save As..” button opens a 
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Windows Explorer directory and allows the user to save the input as an input field file (“*.gn3”).  
The “Print” button prints the input text file and the “Close” button closes the Text Viewer Screen 
as shown in Figure 4-29 and returns to the GASPAR Module Main Screen as shown in 
Figure 4-26. 

 

Figure 4-28 GASPAR Module Main Screen ─ Create Input 
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Figure 4-29 View GASPAR Input ─ Text Viewer Screen 

Select the “Run GASPAR” button to execute the code and generate the output report.  Selecting 
the “Run GASPAR” button will also activate the “View Output,” “FSAR Report,” and the 
“Supplemental Report” buttons on the GASPAR Module Main Screen as shown in Figure 4-30.  
After NRCDose3 completes the GASPAR dose calculation the output will appear as a text 
output file as shown in Figure 4-31.  The “Save As..” button as shown in Figure 4-31 opens a 
Windows Explorer directory and allows the user to save the output as a text file (“*.txt”).  The 
“Print” button prints the output text file and the “Close” button closes the Text Viewer Screen as 
shown in Figure 4-31 and returns to the GASPAR Module Main Screen as shown in 
Figure 4-30.  The user can also the access the output text file by selecting the “View Output” 
button. 
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Figure 4-30 GASPAR Module Main Screen ─ Run GASPAR 

 

Figure 4-31 View GASPAR Output ─ Text Viewer Screen 
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** User Note ** ─ Though not required, users should consider saving GASPAR files in a user-
specified directory other than the NRCDose3 directory, which would facilitate future use and 
sharing without having to navigate to that directory. 

4.3.2 GASPAR Reports 

There are two additional reports that are created – FSAR Report and Supplemental Report.  As 
shown in Figure 4-32, the FSAR Report consolidates the input data and dose calculations into a 
single text report that provides the information that is considered most important for the 
preparation and review of results for licensing documents.  The “Save As..” button as shown in 
Figure 4-32 opens a Windows Explorer directory and allows the user to save the output as a 
text file (“*.txt”).  The “Print” button prints the FSAR Report and the “Close” button closes the 
Text Viewer Screen and returns to the GASPAR Module Main Screen as shown in Figure 4-30. 

 

Figure 4-32 GASPAR FSAR Report Screen 

As shown in Figure 4-33, the Supplemental Report provides additional documentation of the 
modeling assumptions that were used for the calculations, such as exposure and modeling 
assumptions, transfer factors, and various pathway constants.  The “Save As..” button as shown 
in Figure 4-33 opens a Windows Explorer directory and allows the user to save the output as a 
text file (“*.txt”).  The “Print” button prints the FSAR Report and the “Close” button closes the 
Text Viewer Screen and returns to the GASPAR Module Main Screen as shown in Figure 4-30. 
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Figure 4-33 GASPAR Supplemental Report Screen 

** User Note ** ─ Only one report is viewable at a time and reports may be either printed or 
saved as a text file, which can then be further edited and/or saved in different formats using 
standard text file editor functions. 
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5.0 XOQDOQ 
The XOQDOQ Module within NRCDose3 executes a modified version of the XOQDOQ Fortran 
code.  The basic calculation methods (algorithms) of the XOQDOQ Fortran code, as described 
in NUREG/CR-2919, have not been changed with this update to the NRCDose code.  However, 
significant changes have been made to the data management and operation to support 
expanded capabilities of NRCDose3.  XOQDOQ calculates the relative atmospheric dispersion 
(X/Q) and relative atmospheric deposition (D/Q) values at locations specified by the user, and at 
various standard radial distances and distance segments for downwind distance sectors.  The 
model is based on a straight-line Gaussian model and the code can account for variation in the 
location of release points, additional plume dispersion due to building wakes, plume depletion 
via dry deposition and radioactive decay, and adjustments to consider non-straight trajectories. 

The following sections will discuss the steps for using XOQDOQ in NRCDose3.  The user is 
directed to NUREG/CR-2919 for the XOQDOQ Fortran code user guide and technical bases 
which provide additional detailed discussion on the assumptions, limitations and methods 
implemented by the XOQDOQ code. 

After opening the NRCDose3 code, select the “XOQDOQ – Annual Average Meteorological 
Dispersion and Deposition” button as shown in Figure 5-1 to open the XOQDOQ Module Main 
Screen as shown in Figure 5-2. 

 

Figure 5-1 NRCDose3 Main Selection Screen (XOQDOQ Module) 
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Figure 5-2 XOQDOQ Module Main Screen 

The XOQDOQ Module Main Screen as shown in Figure 5-2 opens with case data that is saved 
in the database and it contains three main functional areas for inputting data and performing 
XOQDOQ dispersion and deposition calculations.  These functional areas are: (1) the toolbar 
and initial setup area, (2) data input tabs area and (3) code execution and reports area.  Each of 
these functional areas of the XOQDOQ Module Main Screen is discussed in the following 
sections with a description of the options and capabilities contained therein. 

5.1 Toolbar and Initial Setup Functional Area 

This portion of the XOQDOQ Module Main Screen contains three tools and one initial setup 
input fields as shown in Figure 5-2.  The three tools are the File Menu Tool, Quit Tool and About 
Tool.  The only initial setup field is the Case Title.. 

5.1.1 File Menu Tool 

The File Menu Tool provides the functionality to manage the XOQDOQ files as shown in 
Figure 5-3.  The File Tool dropdown menu options are: 

• New ─ Select this option to begin a brand new XOQDOQ case.  This will clear the 
database from any previously input information. 
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• Open XN3 File ─ Select this option to access and open a “*.XN3” file that was previously 
created with NRCDose3. 

• Open Legacy Input File ─ Select this option to open a Windows Explorer directory and 
navigate to an XOQDOQ legacy “*.dat” file.  This file option allows a user to load input 
files that may have been created in text file format for use with the original Fortran 
XOQDOQ code.  If the user opens a legacy file, the file structure is already in the format 
needed for running the code.  There is no need to create input; simply select run 
XOQDOQ.  The input screens and options cannot be used for editing and updating a 
legacy file.  Any editing will need to be done using a text editor, following the format and 
file structure as described in NUREG/CR-2919, and saved as a “*.dat” file for future use. 

• Save to Database ─ Choose this option to save the current case to the database.  When 
XOQDOQ is opened with “Current Project” selected, the information in the database, as 
last saved before exiting, initially populates all XOQDOQ screens and windows. 

• Save to XN3 File ─ Choose this option to save the completed case to a “*.XN3” file.  
This allows the file to be saved for later use, or for sharing with others. 

• Delete ─ Choose this option to open an Explorer window that will allow the user to delete 
any previously saved “*.XN3” files. 

 

Figure 5-3 XOQDOQ Toolbar with File Tool dropdown menu 
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5.1.2 Quit Tool 

Selecting the Quit Tool from the toolbar as shown in Figure 5-3 will terminate the XOQDOQ 
module operation.  There is a Question prompt screen as shown in Figure 5-4 to ensure that the 
user wants to quit and exit the module.  If the “Yes” button is selected the XOQDOQ Module will 
terminate and any changed/edited data will not be saved.  Select the “No” button and then the 
appropriate entry from the File Tool dropdown menu to ensure that any information has been 
saved (to the database and/or a “*.XN3” file) prior to quitting. 

 

Figure 5-4 XOQDOQ Module Quitting Tool Screen 

5.1.3 About Tool 

Selecting the About Tool from the Toolbar as shown in Figure 5-5 displays information about the 
XOQDOQ Fortran code.  Select the “OK” button as shown in Figure 5-5 to return to the 
XOQDOQ Module Main Screen as shown in Figure 5-2. 

 

Figure 5-5 About XOQDOQ Screen 

5.1.4 Main Title Field 

Enter a title in the Main Title Field for the XOQDOQ calculation.  This is a descriptive text field 
that will only save up to 80 characters.  The appropriate text should be selected to assist user in 
identifying, for example, the facility/site, period of record of meterological input data, and release 
point information.  As displayed in Figure 5-2, the example scenario Main Title is “NRC NUREG-
CR-2919 Test Case 1,” which is installed along with the NRCDose3 code in the installation 
directory (i.e., C:/NRCDose3). 
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5.2 Data Input Tabs 

The two XOQDOQ Data Input Tabs as shown in Figure 5-2 are: 

1. Options/Parameters 

2. Met Data 

Though not required when generating the input for XOQDOQ, it is recommended that the user 
enter the necessary parameters and data to the case in order of the Data Input Tabs as they are 
listed in the XOQDOQ Module Main Screen as shown in Figure 5-2. 

5.2.1 Options/Parameters Tab 

The Options/Parameters Tab is used to enter various parameters for the XOQDOQ calculations.  
The tab includes the Options Section, left-hand side of the tab, and the Parameters Section, 
right-hand side of tab as shown in Figure 5-6.  Refer to NUREG/CR-2919 and Table B-3 of 
Appendix B to this user guide for additional information on the inputs in this tab. 

 

Figure 5-6 Options/Parameters Tab 
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 Options Section 

As shown in Figure 5-6, the following option check boxes appear in the Options Section of this 
tab: 

• Compute Sector Spread to Compare to Centerline Values in Purge Calcs – Select this 
option to distribute the associated X/Q values across the entire width of the downwind 
sector.  The default value should be “checked” as used for the example case, “NRC 
NUREG-CR-2919 Test Case 1” and is normally “checked” in program execution (see 
KOPT (3)).  

• Plot short-term X/Q values – Select this option to plot short-term X/Q values versus 
probability of occurrence.  The value from the example case, “NRC NUREG-CR-2919 
Test Case 1,” for this option is “unchecked” and is normally “unchecked” in program 
execution (see KOPT (4)). 

• Use Cubic Spline in Lieu of Least Square Function for Intermittent Release Distribution – 
Select this option to use cubic spline in lieu of a least square function for fitting an 
intermittent release distribution.  The value from the example case, “NRC NUREG-CR-
2919 Test Case 1,” for this option is “unchecked” and is normally “checked” in program 
execution (see KOPT (5)). 

• Correct Χ/Q and D/Q values for open terrain recirculation – Select this option to utilize 
the default correction for open terrain recirculation, based on Figure 3.2 of NUREG/CR-
2919.  If this option is not checked, and the “Use site specific terrain recirculation data” 
(next option) is “unchecked,” then no recirculation is included in the calculations.   . The 
default value from the “NRC NUREG-CR-2919 Test Case 1” is for this option to be 
“checked” but its use should be based on site-specific conditions (see KOPT (8)). 

• Use site specific terrain recirculation data – When using site-specific recirculation 
factors, check this option AND “uncheck” the option for “Correct X/Q D/Q values for 
open terrain recirculation factors.”  Recirculation correction factors will be based on 
information entered in the Parameters section under “Number of distances of site-
specific correction factors for recirculation.”  Otherwise both the site-specific and the 
default recirculation values will be applied.  Additionally, when inputting the site-specific 
terrain recirculation factors, it is necessary to input values for all 16 downwind distance 
sectors.  If a zero (0) is left as a value for the recirculation factor in a sector at a specific 
distance, it will result in the calculation of zero (0) dispersion and deposition values for 
that sector and distance.  The value from the example case, “NRC NUREG-CR-2919 
Test Case 1,” for this option is “unchecked” but its use should be based on site-specific 
conditions and whether site-specific recirculation factors are available (see KOPT (9)). 

• Use desert sigma curves – Select this option to use desert sigma curves for continuous 
ground level releases in a desert environment.  Desert sigma curves include the effect of 
plume meander.  The value from the example case, “NRC NUREG-CR-2919 Test Case 
1,” is “unchecked” and is normally "unchecked" in program execution (see KOPT (10)). 

Some options are hard coded into XOQDOQ and are not adjustable by the user.  One such 
option is the output of X/Q and D/Q values for radial segments, discussed and identified as 
KOPT(6) in NUREG/CR-2919.  In NRCDose3, the X/Q and D/Q values for the radial segments 
are always provided in the output.  Similarly, if special receptor locations have been identified, 
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the X/Q and D/Q values for those locations will always be provided in the output (KOPT(7)) in 
NUREG/CR-2919).  The option for uneven sector sizes (KOPT(11)) as described in 
NUREG/CR-2919) is also not adjustable and not used in the Fortran code calculations.  Refer to 
Appendix B for additional information. 

 Parameters Section 

The Parameters Section is where the factors that influence how the release will be 
characterized are entered.  The “Increment for which plotted results are printed out defaults to 
15 percent and is used in computing the X/Q values for a purge release.  As shown in 
Figure 5-6, the following inputs appear in the Parameters Section of this tab: 

• Number of Distances with Terrain Data for Each Sector: ─ For this parameter, enter the 
number of distances from the plant that have terrain data to be entered.  The value from 
the example case, “NRC NUREG-CR-2919 Test Case 1,” is “3”. If this option is selected, 
a numerical value must be entered in this field. 

** User Note ** ─ Do not enter a value greater than 10 for the number of distances with 
terrain data. 

Next, select the “Heights” button to open the Terrain Height Values Screen, as shown in 
Figure 5-7, and enter the terrain height and distance in units of meters for each 
downwind direction sector.  Select the “Save” button when the terrain heights and 
distances for the 16 sectors are entered.  If the plant grade elevation is set at a value of 
zero on the Met Data Tab (see Section 5.2.2), then terrain height and distance values 
are in units of meters.  If the plant elevation is set to a value greater than zero, the 
distances are in units of miles from the plant release point; and the terrain height is in 
units of feet above sea level (Figure 5-7). 

** User Note ** ─ If the user changes plant grade elevation, such as to cause the units 
for terrain data to change, any prior entered terrain values will not change to reflect the 
change in units. 
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Figure 5-7 Terrain Height Values Screen 

• Increment for which plotted results are printed out: ─ This parameter specifies what level 
short-term X/Q percentile values is to be used.  The value from the example case, “NRC 
NUREG-CR-2919 Test Case 1,” is “5” percent and the allowable range for values in this 
field is greater than 0.0 percent.  This feature applies to purge releases.  See Section 4.4 
of NUREG/CR-2919 for a more detailed explanation of this parameter. 

• Number of titles of receptor types: ─ Enter the number of the different receptor types that 
will be used in the XOQDOQ analysis.  Typically, there are three receptor points: 
“Residence,” “Garden,” and “Site Boundary.”  However, the user can define fewer 
receptor points or add additional receptor points as needed.  The value from the 
example case, “NRC NUREG-CR-2919 Test Case 1,” is “3” and the allowable range for 
values in this field is between 1 and a maximum of 30 receptor points.  After entering the 
number, select the “Define” button to open the Receptor Types Screen, as shown 
Figure 5-8.  Enter the Title and Location for each receptor type and select the “Define” 
button for each receptor type to open the Receptor Locations Screen as shown in 
Figure 5-8.  On the Receptor Locations Screen, select the Distance from the 16 
directional sector options in the dropdown menu and the Distance in units of meters for 
each receptor location.  When completed, select the “Save” button as needed to return 
to the “Options/Parameters” Tab. 
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Figure 5-8 Receptor Types and Receptor Locations Screens 

• Number of Release Exit Points: ─ Enter the number of the different release exit points 
on the Options/Parameters Tab that will be modeled using XOQDOQ.  The value from 
the example case, “NRC NUREG-CR-2919 Test Case 1,” for this option is “2” and the 
allowable range for values in this field is between 1 to a maximum of 5 release points.  
Select the “Details” button to open the Location Selection Screen, as shown in 
Figure 5-8, and enter a descriptive title for each release point. 

 

Figure 5-9 Location Selection and Release Point Data Screens 

Select the release point (highlight) and the “Edit” button to open the Release Point Data 
Screen as shown in Figure 5-9.   

• Release Exit Point Title ─ Enter a descriptive title for the release point in this text field. 
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• Vent/Stack Average Velocity ─ Enter the average velocity of the effluent from the plant 
vent or stack in units of meters per second (m/s) with an allowable range for values in 
this field of greater than 0.0 m/s. 

• Vent/Stack Inside Diameter ─ Enter the inside diameter of the plant vent or stack in units 
of meters with an allowable range for values in this field of greater than 0.0 m. 

• Release Exit Point Height ─ Enter the height of the release point from the plant vent or 
stack in units of meters with an allowable range for values in this field of greater than 0.0 
m. 

• Height of Vent’s/Stack’s Bldg ─ Enter the height of the building with the plant vent or 
stack in units of meters above plant grade with an allowable range for values in this field 
of greater than 0.0 m. 

• Minimum Cross-Sectional Area for Vent/Stack Building ─ Enter the minimum cross-
sectional area of the building with the plant vent or stack in units of square meters (m2) 
with an allowable range for values in this field of greater than 0.0 m2. 

• Wind Height Used for the Vent’s/Stack’s Elevated Release ─ Enter the wind height used 
for an elevated plant vent or stack release in units of meters with an allowable range for 
values in this field of greater than 0.0 m. 

• Vent/Stack Heat Emission Rate ─ Enter the heat emission rate of the plant vent or stack 
in units of calories per second (cal/s) with an allowable range for values in this field of 
greater than 0.0 cal/s.  Normally, this value should be 0 for power plants.  Section 4.20 
of NUREG/CR-2919 provides additional information on when this parameter may need 
to be adjusted. 

• Purges ─ This field provides the user with the dropdown menu options to select whether 
there are purges or not.  The dropdown menu options, as shown on Figure 5-9, are “No 
Purge” and the purge options of “Decay 1,” “Decay 2,” and “Decay 3.”  If the “No Purge” 
option is selected, the “Number of intermittent releases” and “Average number of hours 
per intermittent release” options are deactivated.  If the purge options of “Decay 1,” 
“Decay 2,” and “Decay 3” are selected the “Number of intermittent releases” and 
“Average number of hours per intermittent release” field are activated.  Enter the number 
of intermittent releases and the average number of hours per each release.  Each of the 
purge options of “Decay 1,” “Decay 2,” and “Decay 3” are the Card Type 4 (i.e., 
DECAY(1), DECAY(2), and DECAY(3)) options in the XOQDOQ Fortran code and each 
represents how decay is handled.  Typically, for purge option “Decay 1” (DECAY(1)), no 
decay is considered, which is the standard application.  For purge option “Decay 2” 
(DECAY(2)), a 2.26-day decay is considered; and for purge option “Decay 3” 
(DECAY(3)), an 8-day decay (with deposition through depletion) is considered.  This 
decay is only for the calculation of the short-term X/Q values and does not affect the 
long-term dispersion calculations as shown in the sector tables or for Special Locations. 

** User Note ** ─ If a release point is deleted on the Location Selection Screen, as 
shown in Figure 5-9, the number of release points identified on the Options/Parameters 
Tab will automatically be updated. 
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• Number of Distances of Site-Specific Correction Factors for Recirculation ─ As noted in 
Section 5.2.1.1, this option becomes activated when the user selects (checks) the “Use 
site specific terrain recirculation data” option in the Options Section of the 
Options/Parameters Tab.  Enter the number of distances of site-specific correction 
factors for recirculation.  The allowable range for the number of site-specific recirculation 
factors is between 1 and a maximum of 10 recirculation factors.  After entering the 
number of site-specific recirculation factors, select the “Corrections…” button to open the 
Distance Corrections Screen, as shown Figure 5-10.  For each of distance site-specific 
correction factors, enter the distance in meters for the 16 directional sectors and the 
correction factors as shown in Figure 5-10.  A value greater than 1.0 is needed for each 
entry; this recirculation value is a direct multiplier in the dispersion and deposition 
calculations; therefore, a value less than 1.0 will cause a proportional reduction and a 
value of zero (0) will result in calculation of zero (0) X/Q and D/Q values.  Select the 
“Save” when done for each distance of site-specific correction factors for recirculation. 

 

Figure 5-10 Distance Corrections Screen 

• Building Wake Constant ─ If desired, the default building wake constant can be 
adjusted.  The value from the example case, “NRC NUREG-CR-2919 Test Case 1,” for 
this parameter is “0.5” and the allowable range for values in this field is greater than 0.0.  
However, the building wake constant should not be changed without supporting 
dispersion and building dimension data.  If a building wake constant other than the 
default value is used a warning window will open as shown in Figure 5-11 stating that 
“For regulatory submittals to the NRC, an applicant is expected to provide technical 
justification for using an alternate value for the building wake constant.”  The user must 
acknowledge this warning by selecting the “OK” button to return to the 
Options/Parameters Tab. 
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Figure 5-11 Building Wake Constant Warning Window 

5.2.2 Met Data Tab 

The Met Data Tab is used to enter the meteorological information and data parameters to 
determine the applicable relative dispersion (X/Q) and relative deposition (D/Q) values in the 
XOQDOQ calculations.  As shown in Figure 5-12, the tab includes an input option section in the 
upper portion of the tab and a joint frequency distribution (JFD) table in the lower portion of the 
tab.  For additional information regarding the inputs on this tab refer to NUREG/CR-2919.  The 
inputs and options on this tab include: 

• Distribute calms as first wind-speed class ─ This option distributes calms as the first 
wind class and activates the “Number of Hours, or Percent of Calm for Each Stability 
Category” input fields.  The value from the example case, “NRC NUREG-CR-2919 Test 
Case 1,” for this option is “checked.” 

• Input joint frequency distribution data as percent frequency ─ This option changes the 
units of the JFD for each stability class from hours to percent.  The value from the 
example case, “NRC NUREG-CR-2919 Test Case 1,” for this option is “unchecked.” 
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Figure 5-12 Met Data Tab 

• Number of velocity categories: ─ Enter the number of velocity categories in this field.  
The value from the example case, “NRC NUREG-CR-2919 Test Case 1,” for this field is 
“5” and the allowable range for values in this field is between 1 and a maximum of 14 
velocity categories.  Consistent with NRC guidance, finer resolution (i.e., more wind 
speed classes) is desirable in summarizing wind speed data for the lower wind speed 
classes.  Select the “Max Wind Speeds” button to open the Maximum Wind Speeds 
Screen as shown in Figure 5-13.  Before selecting the "Max Wind Speeds" button, the 
user should specify on the Met Data Tab the maximum wind speed units of measure as 
either miles per hour (mph) or meters per second (m/sec) to be applied to all velocity 
categories.  The units of measure need to be consistent with the wind speeds units of 
measure in the JFD.  Select the "Save" button on the "Maximum Wind Speeds" screen 
to save any changes to the database. 
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Figure 5-13 Maximum Wind Speeds Screen 

• Number of stability categories: ─ Enter the number of stability categories in this field.  
The value from the example case, “NRC NUREG-CR-2919 Test Case 1,” for this field is 
“7” and the allowable range for values in this field is between 1 and a maximum of 7 
stability categories. 

** User Note ** ─ The NRC in RG 1.111 utilizes 7 stability classes (A through G) based 
on vertical temperature difference in RG 1.23 [Ref. 25] whereas the EPA recognizes just 
6 classes (A through F) an allows for several categorization approaches. 

• Wind speed class units: ─ Select the wind speed class option in units of either mph or 
m/sec.  This will change the units for the entries in the JFD table (lower portion of the 
Met Data tab) and the units for the “Number of Hours, or Percent of Calm for Each 
Stability Category” input fields simultaneously.  The value from the example case, “NRC 
NUREG-CR-2919 Test Case 1,” for this parameter is “m/sec.” 

• Number of hours, or percent of calm for each stability category: ─ Enter either the 
number of hours or percent of calm for each of the stability categories. 

• Height (above ground level) of the measured wind presented in the joint frequency data: 
─ Enter the height (above ground level) of the measured wind speed in units of meters.  
For ground level or elevated/ground-level mixed release, use winds at the 10-meter 
level.  The value from the example case, “NRC NUREG-CR-2919 Test Case 1,” for this 
parameter is “10” m and the allowable range for values in this field is greater than or 
equal to 0.0 m. 

• Plant grade elevation (above sea level): – Enter the plant elevation in meters 
(NUREG/CR-2919 calls for feet).  If the plant elevation is set at a value of zero, as 
discussed Section 5.2.1.2, then terrain height and distance range values are in units of 
meters.  If the plant elevation is set to a value greater than zero, the range distances are 
in units of miles from the plant release point; and the terrain height is in units of feet 
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above sea level.  The value from the example case, “NRC NUREG-CR-2919 Test Case 
1,” for this option is “0.0” m and the allowable range for values in this field is greater than 
or equal to 0.0 m. 

• Half-lives used in Χ/Q calculations (days): – Enter the half-lives used for Χ/Q calculations 
in units of days for the three-different decay and depletion parameters.  Typically, these 
should not be changed from the default values: 

 101 days to be used for undecayed, undepleted Χ/Q calculations 

 2.26 days to be used for decayed, undepleted Χ/Q calculations 

 -8.00 days (to be used for decayed, depleted Χ/Q calculations 

** User Note ** ─ The default values are used in the XOQDOQ Fortran code in a 
manner for controlling certain functions and the decay time.  Any value over 100 for 
“DECAY(1)” is used to designate no decay and no depletion, reflected in the “No Decay 
and Undepletion” X/Q calculations.  The value for DECAY(2), with a default of 2.26 days, 
reflects the value used for decay during transport and used for the “Decayed, 
Undepleted” X/Q calculations.  Finally, the DECAY(3) value of -8.00 days reflects a 
decay of 8 days as well a plume depletion as used for the “Decayed and Depleted” X/Q 
calculations.  Further information on these values can be found in NUREG/CR-2919 and 
for correct use of results in the GASPAR II Fortran code, these values should not be 
changed. 

The lower portion of the Met Data Tab includes the input options for the JFD table as shown in 
Figure 5-12.  Select (highlight) the appropriate Stability (i.e., Class A through Class G) and enter 
either the number of hours or percent the wind blows in each of the 16 downwind sectors of the 
JFD table.  This process should be repeated for each stability class up to Class G. 

Alternatively, JFD data can be imported using one of the two import file formats.  If the user has 
a suitable MS Excel file with JFD information, this file can be imported to XOQDOQ by selecting 
the “Import JFD Data (EXCEL)” button.  This will open the windows as shown in Figure 5-14.  
To use information from a JFD file, select the “Yes” button on the Check Screen to open the Met 
Data Import Screen.  On the Met Data Import Screen double click on the “Input File” field to 
open Windows Explorer and navigate to the directory containing the JFD file to be imported.  
Select the “Open” button to enter the file in the “Input File” field.  Finally, select the “Import” 
button to import the file. 

Similarly, JFD data may be imported using the file format of the output as generated by an 
internal (NRC) application referred to as MetQA (currently at Version 2.0), which represents the 
NRC staff’s implementation of NUREG-0917 (Nuclear Regulatory Commission Staff Computer 
Programs for Use with Meteorological Data), dated July 1982 [Ref. 26].  The MetQA application 
generates various summaries that assist in evaluating the quality and completeness (i.e., data 
recovery) of the meteorological parameters measured by an applicant’s or licensee’s onsite 
meteorological monitoring program.  The MetQA application generates meteorological data 
inputs to atmospheric dispersion models including the XOQDOQ code, suitable for use with 
NRCDose3.  In practice, many applicants and licensees have adapted and expanded the 
primarily quality assurance-related guidance in NUREG-0917, depending on their own internal 
QA practices and procedures and meteorological monitoring program. 
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The JFD portion of the XOQDOQ input file, whether generated by importing a suitable file (MS 
Excel or the NRC staff’s MetQA application) must follow the formatting requirements specified in 
the user’s guidance for the XOQDOQ dispersion model (i.e., NUREG/CR-2919) (see Card Type 
6 of that guidance).  JFD formatting is structured, as follows, into an array by wind direction, 
wind speed range, and by one of seven atmospheric stability classes ranging, in sequence, from 
extremely unstable (Class A) thru extremely stable (Class G). 

Each line of the array has sixteen (16) entries corresponding to the 16 standard wind direction 
sectors (i.e., N, NNE, NE, etc. proceeding clockwise thru the NNW sector).  Each of the 16 
values on this line represents the frequency of occurrence for a designated wind speed range 
and stability class and is entered either as the number of hours or percent frequency of 
occurrence (which is a user selectable option elsewhere in the model input file) relative to the 
total hours in the meteorological data set.  The data set used to generate the JFD can consist of 
one year (or annual cycle) of measurements (i.e., as many as 8,760 hours if no values are 
missing) or be a composite of multiple years (annual cycles) of measurements. 

The next line in the array represents the frequencies of occurrence for the sixteen wind direction 
sectors but this time corresponding to the next wind speed range and for the same stability 
class.  The number of wind speed ranges for each stability class is user specified up to a 
maximum of fourteen (14).  The JFD entries cycle thru the remaining number wind speed 
ranges for the first stability class.  The same sequence is repeated for the next stability class 
until frequency values for all seven stability classes have been accounted. 

In the attached file, the JFD entries begin on the fifth line (the first four lines are generated by 
the MetQA program); frequency values appear on 91 lines.  So, based on the description above, 
the JFD in this case represents 13 wind speed groups for each of the seven stability classes.  
Accounting, then, for all 16 wind direction sectors, 1,456 frequency entries would need to be 
made for a new JFD as part of the input data required for an XOQDOQ run under the 
NRCDose3. 

 

Figure 5-14 Importing JFD Information 

Selecting the “Clear” button on Figure 5-12 opens the Clear Grid JFDs Screen as shown in 
Figure 5-15.  Select the “Yes” button as shown in Figure 5-15 to clear all JFD table information 
from the Met Data Tab. 
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Figure 5-15 Clear Grid JFDs Screen 

5.3 Code Execution and Reporting 

After all data for the XOQDOQ calculation is entered, select the “Save” button as shown in 
Figure 5-16 to save the data to the dataset being used for creating the input file as well as to a 
file name if one has been created for the case.  As shown in Figure 5-16 the NRCDose3 code 
will save the data to the XOQDOQ database, which is used for the calculation.  If working with a 
saved file name, the saved file will also be updated (i.e., *.XN3).  Select the “OK” button to save 
the data to the database file, as used for creating the input for the run, and, as applicable, to 
save to the open “*.XN3” file. 

 

Figure 5-16 Saving XOQDOQ Inputs 
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If the data is to be saved to different “*.XN3” database file, then select the “Save to XN3 File…” 
as shown in Figure 5-3.  The File Tool dropdown menu option (Figure 5-3) is used to open a 
Windows Explorer directory as shown in Figure 5-17.  At this point, name the *.XN3” file and 
directory location as desired.  Future saves will save to this new file name, as well as the 
database used for the code execution. 

 

Figure 5-17 Windows Explorer directory for saving XOQDOQ inputs to a new file 

** User Note ** ─ If running XOQDOQ from an open or saved file, then selecting “Save” will 
save to both the dataset used for creating the input as well as the file name.  Otherwise, “Save” 
will only save to the dataset for the input file, as no file name has been previously identified. 

Selecting the “Create Input” button will open the XOQDOQ Check Screen as shown in 
Figure 5-18, select the “Yes” button to continue.  Additionally, selecting the “Create Input” button 
will also activate the “View Input” and the “Run XOQDOQ” buttons on the XOQDOQ Module 
Main Screen as shown in Figure 5-19.  Select the “View Input” button to display and review text 
file data input as shown in Figure 5-20.  The “Save As..” button as shown in Figure 5-20 opens a 
Windows Explorer directory and allows the user to save the input as an input field file (“*.dt3”).  
The “Print” button prints the input text file and the “Close” button closes the Text Viewer Screen 
as shown Figure 5-20 and returns to the XOQDOQ Module Main Screen as shown in 
Figure 5-19. 

 

Figure 5-18 XOQDOQ Check Screen 
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Figure 5-19 XOQDOQ Module Main Screen ─ Create Input 

 

Figure 5-20 View XOQDOQ Input ─ Text Viewer Screen 
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Figure 5-21 XOQDOQ Module Main Screen ─ Run XOQDOQ 

Select the “Run XOQDOQ” button to execute the code and generate the output report.  
Selecting the “Run XOQDOQ” button will also activate the “View Output” and the “Create 
Alternate X/Q and D/Q Input” buttons on the XOQDOQ Module Main Screen as shown in 
Figure 5-21.  After NRCDose3 completes the XOQDOQ calculation the output will appear as a 
text output file, as shown in Figure 5-22.  The “Save As..” button as shown in Figure 5-22 opens 
a Windows Explorer directory and allows the user to save the output as a text file (“*.txt”).  The 
“Print” button prints the input text file and the “Close” button closes the Text Viewer Screen as 
shown Figure 5-22 and returns to the XOQDOQ Module Main Screen as shown in Figure 5-21.  
Users can also the access the output text file by selecting the “View Output” button. 

** User Note ** ─ Though not required, users should consider saving XOQDOQ files in a user-
specified directory other than the NRCDose3 directory, which would facilitate future use and 
sharing without having to navigate to that directory. 
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Figure 5-22 View XOQDOQ Output ─ Text Viewer Screen 

Select the “Create Alternate X/Q and D/Q Input” button to create a file for use in GASPAR II.  
Additionally, this button can only be used if the “Number of release exit points:” is no more than 
one as shown in Figure 5-23.  If the number of release point exits is no more than one, select 
the “Create Alternate X/Q and D/Q Input” button to generate the alternate meteorological (i.e., 
dispersion and deposition results) input text file to GASPAR.  This will open the “Alt Met Input” 
screen as shown in Figure 5-24 and allow the user to select five or less individual records from 
the specific points of interest by highlighting the records.  Select the “OK” button to open the 
alternate meteorological dispersion and deposition (GASPAR) input text file viewer as shown in 
Figure 5-24. 
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Figure 5-23 XOQDOQ Module Main Screen ─ Create Alternate Met Input 

 

Figure 5-24 Alternate Met Input Screen 
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Figure 5-25 View Alternate Meteorological Input ─ Text Viewer Screen 

The “Save As..” button as shown in Figure 5-25 opens a Windows Explorer directory and allows 
the user to save the output in a text file format suitable for use by XOQDOQ as an alt met data 
input file (“*.dt3”).  The “Print” button prints the input text file and the “Close” button closes the 
Text Viewer Screen as shown in Figure 5-25 and returns to the XOQDOQ Module Main Screen 
as shown in Figure 5-21.  Users can also the access the output text file by selecting the “View 
Alternate Input” button. 
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6.0 SIGNIFICANT REVISIONS CONTAINED IN NRCDOSE3 
The previously released NRC versions of the LADTAP II and GASPAR II Fortran codes, along 
with the CNS versions of NRCDose all used the same DCF library.  This DCF library included 
DCF values for 170 radionuclides, 4 age groups, and 7 organs.  These DCF values were all 
based on the ICRP-2 methodology but came from various sources.  Primarily, the DCF values 
were taken from RG 1.109 with many of the radionuclide DCF values using updated values from 
NUREG-0172, “Age-Specific Radiation Dose Commitment Factors for a one-year Chronic Year” 
[Ref. 27].  Some of the DCF values for strontium-90, holmium-166m, lead-210, thorium-229 and 
thorium-232 were updated with the information contained in NUREG-0172 Errata, “Battelle 
Memorandum, Changes and Correction for NUREG-0172” [Ref. 28].  Additionally, other DCF 
values, notably some transuranic organ DCF values (i.e., bone and liver), were taken from 
Report Number EMP-155, “Review and Expansion of USNRC Regulatory Guide 1.109 Models 
for Computing Dose Conversion Factors” [Ref. 29]. 

NRCDose3 retains the DCF libraries used in LADTAP II, GASPAR II, and NRCDose (version 
2.3.20) in their original forms, as previously released.  The NRCDose3 code will also calculates 
external skin exposure from water submersion; whereas the original LADTAP II code’s DCF 
libraries did not contain values for this calculation.  In addition, the NRCDose3 code allows the 
user to select updated DCF values for dose calculations, notably those based on ICRP 30 or 
ICRP 72 methodologies.  A total of 203 radionuclide DCF values are included in NRCDose3, 
which accounts for all radionuclides contained in any of the original LADTAP II and GASPAR II 
DCF library references from RG 1.109, NUREG-0172 (and errata), and EMP-155. 

6.1 ICRP-30 DCF Values 

The software package Radiological Toolbox (RadToolbox) version 3.0 (https://ramp.nrc-
gateway.gov/) was used to obtain the ICRP-30 DCF values.  The ICRP-30 DCF values are used 
for occupational exposures, and are only applicable to adults, so NRCDose3 only calculates 
adult doses if ICRP-30 DCF values are selected. 

For some ingestion radionuclides, and nearly all inhalation radionuclides, multiple sets of DCF 
values are available.  For ingestion, there are different DCF values depending on the assumed 
f1 value.  For inhalation, there are different DCF values corresponding to the Day (D), Month 
(M) and Year (Y) clearance classes in ICRP 30.  NRCDose3 allows the user to select which 
form and corresponding DCF to be used for each radionuclide, or the user can simply use the 
default form.  To determine the default chemical form, the radionuclides are generally assumed 
to be an oxide form.  Contamination in NPP reactor coolant systems, the source for most power 
plant effluent releases, is commonly found in the oxide form.  Nuclear fuel is also in an oxide 
form, and corrosion products that have been activated in the core are incorporated in extra-core 
oxides.  Therefore, all elements were assumed to be oxides.  EPA Federal Guidance Report 
No. 11 (FGR 11) [Ref. 30], Table 3, “Gastrointestinal Absorption Fractions (f1) and Lung 
Clearance Classes for Chemical Compounds,” was consulted to determine the ingestion and 
lung clearance class for the oxide form of each element, as either days (D), weeks (W) or years 
(Y), and that form has been identified as the default class in ICRP 30. 

There were also changes made to the external DCF values used when ICRP-30 is selected in 
NRCDose3.  For air submersion the total body and skin DCF values are taken from FGR 12.  
Krypton-89 and xenon-137 DCF values are not included in FGR 12, so the total body and skin 
factors were obtained from Department of Energy (DOE) Publication DE88-014691 [Ref. 31].  

https://ramp.nrc-gateway.gov/
https://ramp.nrc-gateway.gov/
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The gamma air and beta air DCF values have not been changed from the RG 1.109-based 
values contained in the original release of LADTAP II and GASPAR II. 

FGR 12 was used for the external exposure DCF values from ground contamination or water 
submersion, for both skin dose and effective dose based on the ICRP-26 methodology.  For 
these DCF values, contributions from progeny radionuclides were included as shown in 
Table 6-1. 

Table 6-1 Radionuclides with included progeny for ICRP-26 based external DCF 
values 

Radionuclide 
Progeny 

Contribution 
Included 

Radionuclide 
Progeny 

Contribution 
included 

Radionuclide 
Progeny 

Contribution 
Included 

Br-83 Kr-83m Ru-106 Rh-106 I-131 Xe-131m 

Zr-95 Nb-95m Ag-110m Ag-110 I-133 Xe-133m 

Zr-97 Nb-97m Sb-126m Sb-126 I-135 Xe-135m 

Ru-103 Rh-103m Te-133m Te-133 Cs-137 Ba-137m 

 Ce-144 Pr-144m 

6.2 ICRP-72 DCF Values 

The software package RadToolbox version 3.0 (https://ramp.nrc-gateway.gov/) was used to 
obtain the ICRP-72 DCF values.  The ICRP-72 DCF values include 6 age groups (i.e., Newborn, 
1 yr, 5 yr, 10 yr, 15 yr, and Adult), which are all calculated by the NRCDose3 code when ICRP-
72 DCF values are selected.  

Similar to ICRP-30 DCF values, for some ingestion radionuclides and nearly all inhalation 
radionuclides multiple sets of DCF values are available.  For ingestion, there are different DCF 
values depending on the assumed f1 value.  For inhalation there are DCF values corresponding 
to Fast (F), Medium (M) or Slow (S) inhalation classes, plus a vapor form (V) in some instances.  
The NRCDose3 code allows the user to select which form of each radionuclide to be used, or 
the user can simply use the default form.  The way the default form of each radionuclide was 
determined is described in Section 6.1, but with the D/W/Y lung clearance classes were directly 
correlated to the ICRP-72 F/M/S inhalation classes.  For hydrogen-3 (tritium) and carbon-14, the 
vapor form of HTO and CO2 were selected, respectively. 

There were also changes to the external DCF values used when ICRP 72 is selected in 
NRCDose3.  For air submersion the total body and skin DCF values are taken from FGR 12 for 
the applicable noble gases.  Krypton-89 and xenon-137 DCF values are not included in FGR 12, 
so the skin factors were obtained from DOE Publication DE88-014691.  The gamma total body 
DCF values for krypton-89 and xenon-137 used under ICRP 72 in NRCDose3 were obtained 
from DOE-STD-1196-2011 [Ref. 32].  The gamma air and beta air DCF values have not been 
changed from the RG 1.109-based values contained in the original release of LADTAP II and 
GASPAR II. 

https://ramp.nrc-gateway.gov/
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FGR 12 was used for the external exposure DCF values from ground contamination or water 
submersion, for both skin dose and effective dose based on the ICRP-60 [Ref. 33] methodology.  
For these DCF values, contributions from progeny radionuclides were included as shown in 
Table 6-2. 

Table 6-2 Radionuclides with included progeny for ICRP-60 based external DCF 
values 

Radionuclide 
Progeny 

Contribution 
Included 

Radionuclide 
Progeny 

Contribution 
included 

Radionuclide 
Progeny 

Contribution 
Included 

Br-83 Kr-83m Ru-106 Rh-106 I-131 Xe-131m 

Zr-95 Nb-95m Ag-110m Ag-110 I-133 Xe-133m 

Zr-97 Nb-97m Sb-126m Sb-126 I-135 Xe-135m 

Ru-103 Rh-103m Te-133m Te-133 Cs-137 Ba-137m 

 Ce-144 Pr-144m 

6.3 Biota Dose in GASPAR 

Biota dose calculations have been added to GASPAR in NRCDose3.  Biota dose calculations 
are performed for every defined special location in GASPAR.  The species selected are those 
that were calculated by previous versions of LADTAP II and NRCDose (version 2.3.20), 
excluding algae and adding cow and fox as additional, surrogate land-based herbivore and 
carnivore, respectively. 

Pathways of exposure assumed include plume (submersion noble gases), groundplane, 
inhalation, and ingestion (plants for herbivores and meat assumed equivalent to cow meat 
concentrations for carnivore).  Since the exposures are only for the gaseous effluents, the 
assumptions made for plant and (cow) meat concentrations are based on the RG 1.109 
modeling for accumulation in feed (assumed representative of plant-based foods) as modeled in 
equations (C-5), (C-8) for C-14, and (C-9) for H-3 and equation (C-12) for resulting 
concentration in (cow) meat.  Equations (7-1), (7-2), and (7-3) below present the modeling for 
integration of the plant and meat concentrations into the resulting calculation of the biota dose.  
Table 6-3 lists the parameters used to calculate the biota dose in GASPAR in NRCDose3. 
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Table 6-3 Biota dose parameters for the GASPAR code in NRCDose3 

Species Mass 
(g) 

Effective 
Radius 

(cm) 

Primary 
Food 
Eaten 

Consumption Rate 
(g/d) 

Muskrat 
(from LADTAP II) 1,000 6 Plants 100 

Raccoon 
(from LADTAP II) 12,000 14 Plants 200 

Duck 
(from LADTAP II) 1,000 5 Plants 100 

Cow 
(herbivore) N/A N/A Plants N/A 

Fox 
(carnivore)a 5,700 10 Meat 520 

User Defined N/A N/A N/A N/A 

** User Note ** ─ The code can only address a single food type, either plant or meat.  While it is 
recognized that a racoon is an omnivore, the default modeling assumes a plant-based diet for 
the racoon, which is consistent with that assumed in LADTAP and modeling in BNWL-1754.  
Modeling as a carnivore may be performed by using the “Add Biota Type” function with 
appropriate inputs on consumption. 

The total dose to any biota is the sum of the external and internal dose components.  The 
external dose component is the same as the adult ground plane dose multiplied by a factor 2 to 
account for proximity to ground and divided by 0.7 to remove the shield factor assumed for 
human exposure.  The effect of this is that the external component of the biota dose is 2.86 
times that calculated for adults. 

The internal dose is the adult man inhalation dose added to an ingestion dose component.  This 
food consumption internal dose component is dependent on the food type.  The GASPAR II and 
LADTAP II Fortran codes in NRCDose3 employ the same modeling in BNWL-1754.  Similar to 
LADTAP where environmental transfer factors (bioaccumulation factors) are used for fish, 
invertebrates and algae, in GASPAR there are transfer factors for vegetation and meat.  The 
GASPAR modeling is based on defining a species as herbivore or carnivore.  Due to only 
having meat transfer factors, for any carnivore, it is assumed that the meat concentration (as 
eaten by a carnivore) is the same as what it would be for a cow. 

** User Note ** ─ A user could perform species-specific modeling by modifying the exposure 
and uptake assumptions and transfer factors that are unique for the species (e.g., transfer 
factors for chickens). 

The ingestion dose to the muskrat, raccoon or duck is determined using Equation (7-1): 
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𝑀𝑀𝑟𝑟𝐶𝐶𝐶𝐶𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 
× 70 × 𝐸𝐸𝐸𝐸𝐸𝐸𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆𝑆 

𝐸𝐸𝐸𝐸𝐸𝐸𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴
× 𝐷𝐷𝐶𝐶𝐷𝐷𝐶𝐶   (7-1) 

where: Veg. Conc. = the vegetable (produce) concentration for radionuclide i 
as calculated by GASPAR II for each location (pCi/kg); 

 Consumption RateSpecies = the mass of food consumed by species (kg/yr); 
 MassSpecies = the mass of species (kg): 
 70 = constant for the assumed mass of an adult as used for 

derivation of the ICRP-2 DCFs (kg); 
 EFFSpecies = the energy for the identified effective species radius 

(MeV); 
 EFFAdult = the energy for the effective radius for an adult (MeV); 
 DCFi = the total body ingestion DCF for an adult for 

radionuclide i (mrem/pCi) 

GASPAR calculates radionuclide concentrations in cow meat, so the effective radius dose 
coefficients are used directly to calculate the cow internal dose component via the ingestion 
pathway using Equation (7-2): 

 𝐷𝐷𝐷𝐷𝐷𝐷𝑒𝑒 �𝑟𝑟𝑟𝑟𝑟𝑟
𝑦𝑦𝑟𝑟
� = 0.0187 × 𝑀𝑀𝑒𝑒𝑀𝑀𝑀𝑀 𝐶𝐶𝐷𝐷𝐶𝐶𝐶𝐶.× 𝐸𝐸𝐷𝐷𝐷𝐷𝐶𝐶 (7-2) 

where: 0.0187 = the conversion factor [(dis-kg-mrad) per (pCi-yr-MeV)]; 
 Meat Conc. = the cow meat concentration for radionuclide i as 

calculated by GASPAR II for each location (pCi/kg); 
 MassSpecies = the mass of species (kg): 
 EFFi = the energy per decay for the identified effective species 

radius (MeV/dis); 

The ingestion dose to the fox is determined using Equation (7-3): 

 𝐷𝐷𝐷𝐷𝐷𝐷𝑒𝑒 �𝑟𝑟𝑟𝑟𝑟𝑟
𝑦𝑦𝑟𝑟
� = 𝑀𝑀𝑒𝑒𝑀𝑀𝑀𝑀 𝐶𝐶𝐷𝐷𝐶𝐶𝐶𝐶.× 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 𝑅𝑅𝑟𝑟𝐶𝐶𝑅𝑅𝐹𝐹𝐹𝐹𝐹𝐹 

𝑀𝑀𝑟𝑟𝐶𝐶𝐶𝐶𝐹𝐹𝐹𝐹𝐹𝐹 
× 70 × 𝐸𝐸𝐸𝐸𝐸𝐸𝐹𝐹𝐹𝐹𝐹𝐹 

𝐸𝐸𝐸𝐸𝐸𝐸𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴𝐴
× 𝐷𝐷𝐶𝐶𝐷𝐷𝐶𝐶 (7-3) 

where: Meat Conc. = the meat concentration for radionuclide i as calculated 
by GASPAR for each location (pCi/kg); 

 Consumption RateFox = the mass of food consumed by the fox (kg/yr); 
 MassFox = the mass of the fox (kg): 
 70 = constant for the assumed mass of an adult (kg); 
 EFFFox = the energy for the identified effective fox radius (MeV); 
 EFFAdult = the energy for the effective radius for an adult (MeV); 
 DCFi = the total body ingestion DCF for an adult for 

radionuclide i (mrem/pCi) 

GASPAR performs the calculations for the vegetable and meat concentrations in the PARTS 
subroutine.  The specific modeling of produce and meat concentrations for carbon-14 is 
performed in the CARBON subroutine, and hydrogen-3 (tritium) in the TRITIUM subroutine. 

The inhalation dose to all biota is approximated as equal to the adult inhalation (total body) dose 
at the specific location.  The groundplane dose to biota is approximated as equal to adult 
groundplane dose with a correction for eliminating the assumed 0.7 shielding factor and adding 
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a factor of 2 multiplier to provide conservatism accounting for biota potentially being in closer 
proximity to the ground. 
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APPENDIX A:  RADIONUCLIDES IN REACTOR EFFLUENTS IN 
NRCDOSE3 

The radionuclides that are contained in NRCDose3 have been expanded over those that were 
available in the original versions of LADTAP II, GASPAR II, and XOQDOQ Fortran codes.  The 
radionuclides and DCF values in the original versions of the codes are largely those found in 
RG 1.109, Revision 1 [Ref. 1], but not in all cases.  An evaluation was performed to determine 
the source of the DCF values contained in the original version of the codes, by comparing the 
radionuclides and DCF values in the LADTAP.lib file with those contained in the following ICRP-
2 [Ref. 2] based sources: 

• RG 1.109, Revision 1 
• NUREG-0172 (and Errata) [Ref. 3] 
• NUREG/CR-2384 [Ref. 4] 
• EMP-155 [Ref. 5] 

The following table provides a listing of which radionuclides and DCF values are included in the 
identified source document.  Highlighted entries indicate radionuclides that are not contained in 
the original LADTAP.LIB as used in NRCDose3 (v2.3.20). 

Table A-1 NRCDose3 radionuclides, DCF values, and reference documents 

 LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 

1 H-3 H-3 H-3   H-3 
2 Be-10   Be-10   Be-10 
3 C-14 C-14 C-14   C-14 
4 N-13   N-13     
5 F-18   F-18     
6 Na-22   Na-22     
7 Na-24 Na-24 Na-24     
8 P-32 P-32 P-32     
9       S-35   

10       Cl-36   
11     Ar-39     
12     Ar-41     
13 Ca-41   Ca-41     
14       Ca-45   
15 Sc-46   Sc-46     

Notes: 

a.  NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes.  No ingestion or other organ 
DCF values are included. 
All radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF 
values are selected. 
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Table A-1 NRCDose3 radionuclides, DCF values, and reference documents (cont.) 

 LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 

16 Cr-51 Cr-51 Cr-51   Cr-51 
17 Mn-54 Mn-54 Mn-54   Mn-54 
18 Mn-56 Mn-56 Mn-56     
19 Fe-55 Fe-55 Fe-55     
20 Fe-59 Fe-59 Fe-59   Fe-59 
21 Co-57   Co-57     
22 Co-58 Co-58 Co-58   Co-58 
23 Co-60 Co-60 Co-60   Co-60 
24 Ni-59   Ni-59     
25 Ni-63 Ni-63 Ni-63     
26 Ni-65 Ni-65 Ni-65     
27 Cu-64 Cu-64 Cu-64     
28       Ga-67 Ga-67 
29 Zn-65 Zn-65 Zn-65     
30 Zn-69m   Zn-69m   Zn-69m 
31 Zn-69 Zn-69 Zn-69     
32       Se-75   
33 Se-79   Se-79     
34 Br-82   Br-82     
35 Br-83 Br-83 Br-83     
36 Br-84 Br-84 Br-84     
37 Br-85 Br-85 Br-85     
38     Kr-83ma     
39     Kr-85ma     
40     Kr-85a     
41     Kr-87a     
42     Kr-88a     
43     Kr-89a     
44 Rb-86 Rb-86 Rb-86     
45 Rb-87   Rb-87     

Notes: 

a.  NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes.  No ingestion or other organ 
DCF values are included. 
All radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF 
values are selected. 
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Table A-1 NRCDose3 radionuclides, DCF values, and reference documents (cont.) 

 LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 

46 Rb-88 Rb-88 Rb-88     
47 Rb-89 Rb-89 Rb-89     
48       Sr-85   
49 Sr-89 Sr-89 Sr-89   Sr-89 
50 Sr-90 Sr-90 Sr-90   Sr-90 
51 Sr-91 Sr-91 Sr-91     
52 Sr-92 Sr-92 Sr-92     
53 Y-90 Y-90 Y-90   Y-90 
54 Y-91m Y-91m Y-91m     
55 Y-91 Y-91 Y-91   Y-91 
56 Y-92 Y-92 Y-92     
57 Y-93 Y-93 Y-93     
58 Zr-93   Zr-93   Zr-93 
59 Zr-95 Zr-95 Zr-95   Zr-95 
60 Zr-97 Zr-97 Zr-97     
61 Nb-93m   Nb-93m     
62 Nb-95 Nb-95 Nb-95   Nb-95 
63 Nb-97   Nb-97     
64 Mo-93   Mo-93     
65 Mo-99 Mo-99 Mo-99     
66 Tc-99m Tc-99m Tc-99m     
67 Tc-99   Tc-99   Tc-99 
68 Tc-101 Tc-101 Tc-101     
69 Ru-103 Ru-103 Ru-103   Ru-103 
70 Ru-105 Ru-105 Ru-105     
71 Ru-106 Ru-106 Ru-106   Ru-106 
72 Rh-105   Rh-105     
73 Pd-107   Pd-107     
74 Pd-109   Pd-109     
75       Cd-109   

Notes: 

a.  NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes.  No ingestion or other organ 
DCF values are included. 
All radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF 
values are selected. 
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Table A-1 NRCDose3 radionuclides, DCF values, and reference documents (cont.) 

 LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 

76 Ag-110m Ag-110m Ag-110m   Ag-110m 
77 Ag-111   Ag-111     
78 Cd-113m   Cd-113m     
79 Cd-115m   Cd-115m   Cd-115m 
80       Sn-113   
81 Sn-123   Sn-123   Sn-123 
82 Sn-125   Sn-125     
83 Sn-126   Sn-126     
84 Sb-124   Sb-124   Sb-124 
85 Sb-125   Sb-125   Sb-125 
86 Sb-126   Sb-126     
87 Sb-127   Sb-127     
88 Te-125m Te-125m Te-125m   Te-125m 
89 Te-127m Te-127m Te-127m     
90 Te-127 Te-127 Te-127     
91 Te-129m Te-129m Te-129m     
92 Te-129 Te-129 Te-129     
93 Te-131m Te-131m Te-131m     
94 Te-131 Te-131 Te-131     
95 Te-132 Te-132 Te-132     
96 Te-133m   Te-133m     
97 Te-134   Te-134     
98       I-125   
99 I-129   I-129   I-129 
100 I-130 I-130 I-130     
101 I-131 I-131 I-131   I-131 
102 I-132 I-132 I-132     
103 I-133 I-133 I-133     
104 I-134 I-134 I-134     
105 I-135 I-135 I-135     
Notes: 

a.  NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes.  No ingestion or other organ 
DCF values are included. 
All radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF 
values are selected. 
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Table A-1 NRCDose3 radionuclides, DCF values, and reference documents (cont.) 

 LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 

106     Xe-131ma     
107     Xe-133ma     
108     Xe-133a     
109     Xe-135ma     
110     Xe-135a     
111     Xe-137a     
112     Xe-138a     
113 Cs-134m   Cs-134m     
114 Cs-134 Cs-134 Cs-134   Cs-134 
115 Cs-135   Cs-135     
116 Cs-136 Cs-136 Cs-136     
117 Cs-137 Cs-137 Cs-137   Cs-137 
118 Cs-138 Cs-138 Cs-138     
119 Cs-139   Cs-139     
120       Ba-133   
121 Ba-139 Ba-139 Ba-139     
122 Ba-140 Ba-140 Ba-140   Ba-140 
123 Ba-141 Ba-141 Ba-141     
124 Ba-142 Ba-142 Ba-142     
125 La-140 La-140 La-140   La-140 
126 La-141   La-141     
127 La-142 La-142 La-142     
128 Ce-141 Ce-141 Ce-141   Ce-141 
129 Ce-143 Ce-143 Ce-143     
130 Ce-144 Ce-144 Ce-144   Ce-144 
131 Pr-143 Pr-143 Pr-143     
132 Pr-144 Pr-144 Pr-144     
133 Nd-147 Nd-147 Nd-147     
134 Pm-147   Pm-147   Pm-147 
135 Pm-148m   Pm-148m     
Notes: 

a.  NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes.  No ingestion or other organ 
DCF values are included. 
All radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF 
values are selected. 
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Table A-1 NRCDose3 radionuclides, DCF values, and reference documents (cont.) 

 LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 

136 Pm-148   Pm-148     
137 Pm-149   Pm-149     
138 Pm-151   Pm-151     
139 Sm-151   Sm-151   Sm-151 
140 Sm-153   Sm-153     
141 Eu-152   Eu-152     
142 Eu-154   Eu-154   Eu-154 
143 Eu-155   Eu-155   Eu-155 
144 Eu-156   Eu-156     
145 Tb-160   Tb-160     
146 Ho-166m   Ho-166m   Ho-166m 
147       Tm-170   
148       Yb-169   
149 W-181   W-181     
150 W-185   W-185     
151 W-187 W-187 W-187     
152       Ta-182   
153       Ir-192   
154       Au-198   
155       Tl-201 Tl-201 
156       Tl-204   
157 Pb-210   Pb-210   Pb-210 
158 Bi-210   Bi-210   Bi-210 
159 Po-210   Po-210     
160     Rn-222     
161 Ra-223   Ra-223     
162 Ra-224   Ra-224     
163 Ra-225   Ra-225     
164 Ra-226   Ra-226     
165 Ra-228   Ra-228     
Notes: 

a.  NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes.  No ingestion or other organ 
DCF values are included. 
All radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF 
values are selected. 
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Table A-1 NRCDose3 radionuclides, DCF values, and reference documents (cont.) 

 LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 

166 Ac-225   Ac-225     
167 Ac-227   Ac-227     
168 Th-227   Th-227     
169 Th-228   Th-228     
170 Th-229   Th-229   Th-229 
171 Th-230   Th-230     
172 Th-232   Th-232   Th-232 
173 Th-234   Th-234     
174 Pa-231   Pa-231     
175 Pa-233   Pa-233     
176 U-232   U-232   U-232 
177 U-233   U-233     
178 U-234   U-234   U-234 
179 U-235   U-235   U-235 
180 U-236   U-236   U-236 
181 U-237   U-237     
182 U-238   U-238   U-238 
183 Np-237   Np-237   Np-237 
184 Np-238   Np-238     
185 Np-239 Np-239 Np-239   Np-239 
186       Pu-236 Pu-236 
187 Pu-238   Pu-238   Pu-238 
188 Pu-239   Pu-239   Pu-239 
189 Pu-240   Pu-240   Pu-240 
190 Pu-241   Pu-241   Pu-241 
191 Pu-242   Pu-242   Pu-242 
192 Pu-244   Pu-244   Pu-244 
193 Am-241   Am-241   Am-241 
194 Am-242m   Am-242m   Am-242m 
195 Am-243   Am-243   Am-243 
Notes: 

a. NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes.  No ingestion or other organ 
DCF values are included. 
All radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF 
values are selected. 
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Table A-1 NRCDose3 radionuclides, DCF values, and reference documents (cont.) 

 LADTAP II Library RG 1.109 NUREG-0172 NUREG/CR-2384 EMP-155 

196 Cm-242   Cm-242   Cm-242 
197 Cm-243   Cm-243   Cm-243 
198 Cm-244   Cm-244   Cm-244 
199 Cm-245   Cm-245     
200 Cm-246   Cm-246     
201 Cm-247   Cm-247     
202 Cm-248   Cm-248     
203 Cf-252   Cf-252   Cf-252 
Notes: 

a. NUREG-0172 contains only inhalation lung DCF values for Kr and Xe isotopes.  No ingestion or other organ 
DCF values are included. 
All radionuclides highlighted above are not contained in the original versions of LADTAP II, GASPAR II, and 
NRCDose, but have been added to the database files for NRCDose3 and are available when ICRP-2 DCF 
values are selected. 

Any radionuclide highlighted above is not contained in the original versions of LADTAP II, 
GASPAR II, and NRCDose, but has been added to the database files for NRCDose3 and is 
available when ICRP-2 DCF values are selected. 

This list of 203 radionuclides is the same radionuclides that are available when ICRP-30 or 
ICRP-72 DCF values are selected in NRCDose3. 
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APPENDIX B:  USER-MODIFIABLE PARAMETERS 
LADTAP II, GASPAR II, and XOQDOQ Fortran codes rely on many parameters and 
assumptions as inputs to perform their dose assessments.  One of the design objectives of the 
updated NRCDose3 was to allow users increased flexibility to modify and adjust each of the 
code’s parameters, as needed.  All parameters that are used in XOQDOQ, LADTAP II, and 
GASPAR II Fortran codes have been identified, including all radiological and non-radiological 
parameters that are either user-modifiable or hardwired in the codes.  The LADTAP II, GASPAR 
II, and XOQDOQ Fortran input cards were reviewed for modifiable parameters, and the ability to 
modify input card parameters via the existing NRCDose code (version 2.3.20) was confirmed.  
The LADTAP II, GASPAR II, and XOQDOQ Fortran code modifiable parameters are identified in 
Tables B-1 through B-3.  Additionally, the LADTAP II, GASPAR II, and XOQDOQ Fortran codes 
were reviewed to identify additional variables and parameters that were hardwired into the 
Fortran code.  The LADTAP II, GASPAR II, and XOQDOQ Fortran code hardwired parameters 
are identified in Tables B-4 through B-6. 

Table B-1 LADTAP II Modifiable Parameters 

Name Description LADTAP II 
Notation Where Adjusted in NRCDose3 

Plant Title Text of plant title or run N/A Main Screen.  "Scenario" 

Water Type selection Determines saltwater vs. 
freshwater site LT Selections -> "Site Type" 

Discharge Liquid effluent discharge rate 
to impoundment system 

CFS, 
QSUBP Selections -> "Discharge Flow Rate" 

Source Term 
Multiplier 

 UML Selections -> "Source Term Multiplier" 

 Control printing percent 
contribution by nuclide LCT Selections -> "Dose Contributions" 

Blockdata Changing and printing block 
data parameters IFLAG Not used in NRCDose3 

Population Total Population within 50 
miles POP Selections -> "50-mile Population" 

 Control parameter for reading 
record TR  

Population Fraction Fraction of population adult PERA Selections -> Modify defaults -> Edit 
Population Fraction Fraction of population teen PERT Selections -> Modify defaults -> Edit 
Population Fraction Fraction of population child PERC Selections -> Modify defaults -> Edit 

Release Nuclide Nuclide released IA Selections -> Source Term -> Add 
Nuclide 

Release Nuclide Nuclide released IM Selections -> Source Term -> Add 
Nuclide 

Release Rate Annual Release (Ci/yr) QQ Selections -> Source Term -> Add 
Nuclide 

Reconcentration 
Factor 

Radionuclide reconcentration 
factor R Selections -> Source Term  

Reconcentration 
Model 

 M Selections -> Reconcentration.  Model. 

Discharge rate Effluent Discharge rate QSUBB Selections -> Reconcentration.  
Impoundment 
Volume Total Volume (ft3) VSUBT Selections -> Reconcentration. 

Shore-width Factor  SWF 
ALARA Locations -> ALARA – Max. 
Individual (or Additional Usage 
Locations) -> Shore-width factor 

  



 

B-2 

Table B-1 LADTAP II Modifiable Parameters (cont.) 

Name Description LADTAP II 
Notation Where Adjusted in NRCDose3 

Dilution Factor DF for aquatic food and 
boating 

DILU, 
BDIL 

ALARA Locations -> ALARA – Max. 
Individual -> Dilution Factor.  Aquatic food 
and boating. 

Dilution Factor DF for shoreline and swimming SHD 
ALARA Locations -> ALARA – Max. 
Individual -> Dilution Factor.  Shoreline 
and swimming 

Dilution Factor DF for drinking water DWD 
 ALARA Locations -> ALARA – Max. 
Individual -> Dilution Factor.  Drinking 
water. 

Transit Time 
Time from discharge to 
receiving water body to 
exposure location (hr) 

T 

ALARA Locations -> ALARA – Max. 
Individual (or Additional Usage Locations) 
-> Transit Time.  Other pathways (All 
pathways). 

Transit Time 
Time from discharge to 
receiving water body to 
drinking water (hr) 

TD ALARA Locations -> ALARA – Max. 
Individual -> Transit Time.  Drinking water. 

Fish Consumption 
Annual fish consumption 
(adult, teen, child, infant) 
(kg/yr) 

FIUS, 
TAF, CHF, 

TDF 

ALARA Locations -> ALARA – Max. 
Individual -> Change default usage and 
consumption data.  Edit. 

Invertebrate 
Consumption  

Annual invertebrate 
consumption (adult, teen, 
child, infant) (kg/yr) 

CRUS, 
TAC, 

CHC, TDC 

ALARA Locations -> ALARA – Max. 
Individual -> Change default usage and 
consumption data.  Edit. 

Aquatic Plant 
consumption 

Annual algae consumption 
(adult, teen, child, infant) 
(kg/yr) 

ALUS, 
TAA, CHA, 

TDA 

ALARA Locations -> ALARA – Max. 
Individual -> Change default usage and 
consumption data.  Edit. 

Drinking water 
Annual drinking water 
consumption (adult, teen, 
child, infant) (kg/yr) 

WUSE, 
TAW, 
CHW, 
TDW 

ALARA Locations -> ALARA – Max. 
Individual -> Change default usage and 
consumption data.  Edit. 

Shoreline usage Annual shoreline usage (adult, 
teen, child, infant) (hr/yr) 

SHU, TAS, 
CHS, TDS 

ALARA Locations -> ALARA – Max. 
Individual -> Change default usage and 
consumption data.  Edit. 

Swimming Exposure 
Annual swimming exposure 
time (adult, teen, child, infant) 
(hr/yr) 

SWU, 
TASW, 
CHSW, 
TDSW 

ALARA Locations -> ALARA – Max. 
Individual -> Change default usage and 
consumption data.  Edit. 

Boating Usage 
Annual boating usage time 
(adult, teen, child, infant) 
(hr/yr) 

BUSE, 
TAB, CHB, 

TDB 

ALARA Locations -> ALARA – Max. 
Individual -> Change default usage and 
consumption data.  Edit. 

Flow velocity Average flow velocity (ft/sec) UR 

ALARA Locations -> ALARA – Max. 
Individual (or Additional Usage Locations) 
-> Dilution Factor -> Calc -> Surface 
Water Velocity 

Average Depth Depth of water body (ft) HR 

ALARA Locations -> ALARA – Max. 
Individual (or Additional Usage Locations) 
-> Dilution Factor -> Calc -> Surface 
Water Depth 

Distance 
Downshore distance from 
discharge point to usage 
location (ft) 

XR 

ALARA Locations -> ALARA – Max. 
Individual (or Additional Usage Locations) 
-> Dilution Factor -> Calc -> Downstream 
Distance 
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Table B-1 LADTAP II Modifiable Parameters (cont.) 

Name Description LADTAP II 
Notation Where Adjusted in NRCDose3 

Distance Offshore distance to water 
usage location (ft) YR 

ALARA Locations -> ALARA – Max. 
Individual (or Additional Usage Locations) 
-> Dilution Factor -> Calc -> Offshore 
Distance 

River width Width of river or depth of 
discharge point in the lake (ft) BW 

ALARA Locations -> ALARA – Max. 
Individual (or Additional Usage Locations) 
-> Dilution Factor -> Calc -> River Width 

Sport Fishing Usage Annual sport fish harvest 
(kg/yr) CATH Fish/Population/Biota -> Fish Usage 

Location -> Sport Fishing…Add 

Sport Fishing Usage Dilution factor DILU Fish/Population/Biota -> Fish Usage 
Location -> Sport Fishing…Add 

Sport Fishing Usage Transit Time T Fish/Population/Biota -> Fish Usage 
Location -> Sport Fishing…Add 

Commercial Fishing 
Usage Location (see Sport fishing above) CATH, 

DILU, T 
Fish/Population/Biota -> Fish Usage 
Location-Commercial Fishing…Add 

Sport Invertebrate 
Harvest Location (see Sport fishing above) CATH, 

DILU, T 

Fish/Population/Biota -> Fish Usage 
Location -> Sport Invertebrate 
Harvest…Add 

Commercial 
Invertebrate Harvest 
Location Data 

(see Sport fishing above) CATH, 
DILU, T 

Fish/Population/Biota -> Fish Usage 
Location -> Commercial Invertebrate 
Harvest…Add 

Population Population served by drinking 
water location P Fish/Population/Biota -> Population Usage 

-> Drinking Water…Add 

Dilution Factor DF at the intake location DILU Fish/Population/Biota -> Population Usage 
-> Drinking Water…Add 

Transit Time Time from discharge point to 
water supply intake (hr) T Fish/Population/Biota -> Population Usage 

-> Drinking Water…Add 

Volume Supply rate of drinking water 
(gal/d) GAL Fish/Population/Biota -> Population Usage 

-> Drinking Water…Add 

Drinking water usage Average rate of drinking water 
usage by individuals (gal/d) GUS Fish/Population/Biota -> Population Usage 

-> Drinking Water…Add 

Population Shoreline Population shoreline usage 
(person-hr/yr) 

SHU, 
DILU, T, 

SWF 

Fish/Population/Biota -> Population 
Usage-Shoreline …Add 

Population Swimming Population Swimming Usage 
(person-hr/yr) 

SWU, 
DILU, T 

Fish/Population/Biota -> Population 
Usage-Swimming …Add 

Population Boating Population Boating Usage 
(person-hr/yr) 

BTUSE, 
DILU, T 

Fish/Population/Biota -> Population Usage 
-> Boating …Add 

Irrigated Foods Irrigation rate (L/m2/month) IRRIG Irrigated Food Data -> Irrigation Food Data 
-> Add 

Irrigated Foods 
Fraction of animal feed NOT 
produced with contaminated 
water 

FFED Irrigated Food Data -> Irrigation Food Data 
-> Add 

Irrigated Foods Fraction of animal drinking 
water NOT contaminated FDH20 Irrigated Food Data -> Irrigation Food Data 

-> Add 

Irrigated Foods Total production rate of food 
product (kg/yr) TFMG Irrigated Food Data -> Irrigation Food Data 

-> Add 

Irrigated Foods Growing period for food 
product (d) TGRW Irrigated Food Data -> Irrigation Food Data 

-> Add 

Irrigated Foods Crop yield for food product 
(kg/m2) YLD Irrigated Food Data -> Irrigation Food Data 

-> Add 

Food Consumption 
Maximum Current food 
consumption rate (adult, teen, 
child) (kg/yr) 

ACON, 
TCON, 
CCON 

Irrigated Food Data -> Irrigation Food Data 
-> Add.  Modify Food Consumption Default 
data.  Edit. 
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Table B-1 LADTAP II Modifiable Parameters (cont.) 

Name Description LADTAP II 
Notation Where Adjusted in NRCDose3 

Food Consumption 
Average Current food 
consumption rate (adult, teen, 
child) (kg/yr) 

AC, TC, 
CC 

Irrigated Food Data -> Irrigation Food Data 
-> Add.  Modify Food Consumption Default 
data.  Edit. 

holdup time Holdup time to average person 
(h) HOLD 

Irrigated Food Data -> Irrigation Food Data 
-> Add.  Modify Food Consumption Default 
data.  Edit. 

holdup time Holdup time to maximum 
person (h) HOLD1 

Irrigated Food Data -> Irrigation Food Data 
-> Add.  Modify Food Consumption Default 
data.  Edit. 

Production Rate Production rate for current 
food product (kg/yr or L/yr) PROD Irrigated Food Data -> Irrigation Food Data 

-> Add -> Usage Locations 
Food Product Water 
Usage Location Data DF, transit time DILU, T Irrigated Food Data -> Irrigation Food Data 

-> Add -> Usage Locations 
Biota Exposure 
Location Data DF, transit time DILU, T Fish/Population/Biota -> Biota Exposures -

> Add 
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Table B-2 GASPAR II Modifiable Parameters 

Name Description GASPAR II 
Notation Where Adjusted in NRCDose3 

Plant Title Text of plant title or run N/A Main Screen.  "Case Title" 

Input deck type Determines population dose, 
individual dose, or both JC(1) Options -> "Calculate Individual 

doses only" 
Number of Source 
Terms 

Number of release points (with 
associated source terms) JC(2) NOTE: NRCDose3 limited to a single 

source term. 

Cumulative Doses 
Prints cumulative doses from each 
source term, or only total dose 
from all source terms 

JC(3) Options -> "Print cumulative dose 
reports only" 

Block Data 
Records Block data changes JC(4) Not used in NRCDose3 

Dose Factor 
Library Dose Factor Report selection JC(5) Options -> Print dose-factor library 

data 

Vegetable Growth Fraction of year leafy vegetables 
are grown FV Options -> "Fraction of the year leafy 

vegetables are grown" 

Cow Pasture Fraction of year cows are on 
pasture FP Options -> "Fraction of the year milk 

cows are on pasture" 

Crop from Garden Fraction of crop from garden FG 
Options -> "Fraction of max 
individual's vegetable intake from own 
garden" 

Cow Intake Fraction of cow intake from 
pasture, while on pasture FPF Options -> "Fraction of milk-cow feed 

intake from pasture while on pasture" 

Humidity Absolute humidity over growing 
season (g/m3) H Options -> "Average absolute 

humidity" 

Temperature Average temperature over growing 
season (degrees Fahrenheit) T Options -> "Average temperature 

over growing season" 

Goat Pasture Fraction of year goats on pasture FGT Options -> "Fraction of the year goats 
are on pasture" 

Goat Intake Fraction of goat intake from 
pasture, while on pasture FPG Options -> "Fraction of goat feed 

intake from pasture while on pasture" 

Beef Cow Pasture Fraction of year beef cows are on 
pasture FB Options -> "Fraction of the year beef 

cows are on pasture" 

Beef Cow Intake Fraction of beef cow intake from 
pasture, while on pasture FBF Options -> "Fraction of beef-cow feed 

intake from pasture while on pasture" 

Population Total Population within 50 miles LS, 
PERSON 

Pop/Prod Data tab -> Population 
Data.  Population Control.  Uncheck 
"Input by distance and direction" -> 
Data Entry 
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Table B 2 GASPAR II Modifiable Parameters (cont.) 

Name Description GASPAR II 
Notation Where Adjusted in NRCDose3 

Population 
Population in given downwind 
direction sector and annular 
distance 

POP(160) 

Pop/Prod Data tab -> Population 
Data.  Population Control.  Check 
"Input by distance and direction" -> 
Data Entry 

Milk Production 
Milk production in given downwind 
direction sector and annular 
distance 

ZMILK(160) 
Pop/Prod Data tab -> Milk Production 
Data.  Milk Production Control.  
Check "Input by distance and 
direction" -> Data Entry 

Milk Production Total Milk production within 50 
miles ZMLKT 

Pop/Prod Data tab -> Milk Production 
Data.  Milk Production Control.  
Uncheck "Input by distance and 
direction" -> Data Entry 

Meat Production 
Meat production in given 
downwind direction sector and 
annular distance 

ZMEAT(160) 

Pop/Prod Data tab -> Meat 
Production Data.  Meat Production 
Control.  Check "Input by distance 
and direction" -> Data Entry 

Meat Production Total Meat production within 50 
miles ZMETT 

Pop/Prod Data tab -> Meat 
Production Data.  Meat Production 
Control.  Uncheck "Input by distance 
and direction" -> Data Entry 

Vegetable 
Production 

Vegetable production in given 
downwind direction sector and 
annular distance 

ZVEGT(160) 

Pop/Prod Data tab -> Vegetable 
Production Data.  Vegetable 
Production Control.  Check "Input by 
distance and direction" -> Data Entry 

Vegetable 
Production 

Total Vegetable production within 
50 miles ZVEGTT 

Pop/Prod Data tab -> Vegetable 
Production Data.  Vegetable 
Production Control.  Uncheck "Input 
by distance and direction" -> Data 
Entry 

Source Term 
Multiplier 

Multiplier to account for multi-unit 
sites with same release UML 

Variables -> Source Term.  Source 
Data.  "Source Multiplication Factor" 
Note: NRCDose3 limited to a single 
source term. 

New MET data Determines if last MET data can 
be reused. JC(1) 

Note: Not used in NRCDose3. 
NRCDose3 limited to a single source 
term. 

New release data Determines if last release data can 
be reused. JC(2) 

Note: Not used in NRCDose3. 
NRCDose3 limited to a single source 
term. 

Purge duration Total annual purge release time PURGE Source Term -> Source Data 
"Release time for purges" 

Release Nuclide Nuclide released IA Source Term -> Add Nuclide 
Release Nuclide Nuclide released IM Source Term -> Add Nuclide 
Annual Release Annual Release (Ci) QQ, Q(33) Source Term -> Add Nuclide 
Release Point - 
Undecayed, 
undepleted X/Q 

Title for data source, date, height, 
release point, etc. 

 Pop/Prod Data -> Meteorological -> 
Title 

Annual Average 
X/Q 

X/Q at each downwind sector and 
annular distance XQ(160) 

Pop/Prod Data -> Meteorological -> 
Undecayed, Undepleted -> Data 
Entry 
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Table B 2 GASPAR II Modifiable Parameters (cont.) 

Name Description GASPAR II 
Notation Where Adjusted in NRCDose3 

Release Point - 
Decayed, 
undepleted X/Q 

Title for data source, date, height, 
release point, etc.  Pop/Prod Data -> Meteorological -> 

Decayed, Undepleted ->Title 

Decayed, 
Depleted X/Q 

Decayed, depleted X/Q at each 
downwind sector and annular 
distance 

XQDD(160) Pop/Prod Data -> Meteorological -> 
Decayed, Depleted -> Data Entry 

Release Point - 
Deposition D/Q 

Title for data source, date, height, 
release point, etc. 

 Pop/Prod Data -> Meteorological -> 
Decayed, Depleted ->Title 

Deposition D/Q 
Deposition factor (D/Q) at each 
downwind sector and annular 
distance 

DEP Pop/Prod Data -> Meteorological -> 
Decayed, Depleted -> Data Entry 

Special Location 
Data 

Determines if detailed pathway 
reports are printed JS(n) Special Location Data -> Add.  "Don't 

print any detailed reports" 
Special Location 
Name 

 Name Special Location Data -> Add.  "Name 
of Location" 

Special Location 
Downwind 
Direction Sector 

 (DIR) Special Location Data -> Add. 
"Downwind direction from site" 

Special Location 
Distance 

 DIST Special Location Data -> Add. 
"Distance from Site (m)" 

Special Location 
X/Q 

 X/Q, XQ1 
Special Location Data -> Add -> 
Atmospheric Dispersion Factors -> 
Undecayed, Undepleted 

Special Location 
XQD 

Special location decayed, 
undepleted X/Q XQD, XQD1 

Special Location Data -> Add -> 
Atmospheric Dispersion Factors -> 
Decayed, Undepleted 

Special Location 
XQDD 

Special Location Decayed, 
depleted X/Q 

XQDD, 
XQDD1 

Special Location Data -> Add -> 
Atmospheric Dispersion Factors -> 
Decayed, Depleted 

Special Location 
DEP Special Location D/Q DEP1 

Special Location Data -> Add -> 
Atmospheric Deposition Factors -> 
Ground Deposition Factor 
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Table B-3 XOQDOQ Modifiable Parameters 

Name Description XOQDOQ 
 Notation Where Adjusted in NRCDose 

Options Distribute calms as first wind 
speed class KOPT(1) Met Data tab 

Options Input joint frequency as 
percent frequency KOPT(2) 

Met Data tab -> Input joint 
frequency distribution data as 
percent frequency 

Options Compute sector spread KOPT(3) Options/Parameters tab, Options 
Options Plot short term X/Q values KOPT(4) Options/Parameters tab, Options 
Options Use cubic spline KOPT(5) Options/Parameters tab, Options 

Options Punch radial segment X/Q KOPT(6) Not included on screen.  Not 
adjustable in NRCDose3. 

Options Punch output X/Q at point of 
interest KOPT(7) Not included on screen. Not 

adjustable in NRCDose3. 
Options Correct value for open terrain KOPT(8) Options/Parameters tab, Options 

Options Site specific terrain 
recirculation data KOPT(9) Options/Parameters tab, Options 

Options Desert sigma curves KOPT(10) Options/Parameters tab, Options 

Options 
Uneven Sector Sizes - 30 
degrees in N, E, S, W and 20 
degrees elsewhere 

KOPT(11) 
Not included on screen.  Not 
adjustable in NRCDose3.  Not 
used in Fortran code. 

Parameters Number of velocity 
categories NVEL Met Data tab 

Parameters Number of stability 
categories NSTA Met Data tab 

Parameters Wind speed class units (mph 
or m/s) - Met Data tab 

Parameters 
Number of distances with 
terrain data for each 
downwind sector 

NDIS Options/Parameters tab, 
Parameters 

Parameters 
Increment for which plotted 
results are printed out (in 
percent) 

INC Options/Parameters tab, 
Parameters 

Parameters Number of titles of receptor 
types NPTYPE Options/Parameters tab, 

Parameters 

Parameters Number of release exit points NEXIT Options/Parameters tab, 
Parameters 

Parameters 
Number of distances of site-
specific correction factors for 
recirculation 

NCOR Options/Parameters tab, 
Parameters 

Wind Measurement 
Height 

Height above ground level 
(m) of measured wind speed 
presented in the JFD 

PLEV Met Data tab, Misc. 

X/Q Half-lives 

Half-lives used in 
undecayed, decayed, and 
decayed/depleted X/Q 
calculations 

DECAYS 

Met Data tab. Half-lives used in 
X/Q calculations (days) (with 
explanations of departures from 
typical values) 

Plant Grade Elevation Plant grade elevation above 
sea level PLGRAD Met Data tab, Misc. 

Calms Data 
Time (hours) or percent 
frequency of calms for each 
stability class 

CALM Met Data tab 

Joint Frequency Data 

Time (hours) or percent 
frequency for each of the 16 
standard wind direction 
sectors, for each stability 

FREQ 

Met Data tab, select stability 
class, enter the frequencies of 
occurrence for each wind 
direction sector (i.e., direction 
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Name Description XOQDOQ 
 Notation Where Adjusted in NRCDose 

class and wind speed 
category 

from relative to True North) and 
wind speed category 
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Table B-3 XOQDOQ Modifiable Parameters (cont.) 

Name Description XOQDOQ 
 Notation Where Adjusted in NRCDose 

Maximum Wind 
Speeds 

Maximum speed in each 
wind speed class (mph or 
m/s) 

UMAX Met Data tab -> Max Wind 
Speeds 

Correction factor 
distance 

Distance to site-specific 
correction factor in each of 
the 16 downwind direction 
sectors (m) 

VRDIST 

Options/Parameters tab, 
Parameters -> Corrections, 
select distance number, enter 
site-specific distance for each 
correction factor for each 
downwind sector 

Correction factor 

Site-specific correction factor 
in each downwind direction 
sector for the specified 
distance 

VRCR 

Options/Parameters tab, 
Parameters -> Corrections, 
select distance number, enter 
site-specific correction factor for 
each downwind sector 

Terrain factor 

Distance range for which 
terrain heights are given in 
each of the 16 downwind 
direction sectors 

DIST 

Options/Parameters tab, 
Parameters -> Heights, select 
distance range, enter distance 
range with terrain data for each 
downwind sector   

Terrain factor 
Terrain height per distance 
range in each of the 16 
downwind direction sectors 

HT 

Options/Parameters tab, 
Parameters -> Heights, select 
distance range, enter terrain 
height for each downwind sector 

Receptors Number of receptor locations 
for a particular receptor type NPOINT 

Options/Parameters tab, 
Parameters -> Number of titles of 
receptor types -> Define, enter 
number of receptor locations 
(points) per receptor type 

Receptors Titles of receptor types TITLPT 

Options/Parameters tab, 
Parameters -> Number of titles of 
receptor types -> Define, enter 
titles of receptor types 

Receptors Receptor downwind direction 
and distance (m) KDIR, PTDIST 

Options/Parameters tab, 
Parameters -> Number of titles of 
receptor types -> Define -> 
Define, enter downwind direction 
and distance per receptor 
location (point) 

Release Points Vent/stack average velocity 
(m/s) EXIT 

Options/Parameters tab, 
Parameters -> Number of release 
exit points -> Details, select 
Release Point -> Edit 

Release Points Vent/stack inside diameter 
(m) DIAMTR 

Options/Parameters tab, 
Parameters -> Number of release 
exit points -> Details, select 
Release Point -> Edit 

Release Points Release point height (m) HSTACK 

Options/Parameters tab, 
Parameters -> Number of release 
exit points -> Details, select 
Release Point -> Edit 

Release Points Height of vent/stack building 
(m) HBLDG 

Options/Parameters tab, 
Parameters -> Number of release 
exit points -> Details, select 
Release Point -> Edit 
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Table B-3 XOQDOQ Modifiable Parameters (cont.) 

Name Description XOQDOQ 
Notation Where Adjusted in NRCDose 

Release Points 
Minimum cross section 
area for vent/stack 
building (m2) 

CRSEC 

Options/Parameters tab, 
Parameters -> Number of 
release exit points -> Details, 
select Release Point -> Edit 

Release Points Wind height used for 
vent/stack release (m) SLEV 

Options/Parameters tab, 
Parameters -> Number of 
release exit points -> Details, 
select Release Point -> Edit 

Release Points Vent/stack heat emission 
rate (Cal/sec) HEATR 

Options/Parameters tab, 
Parameters -> Number of 
release exit points -> Details, 
select Release Point -> Edit 

Release Points Intermittent release X/Q to 
use IPURGE 

Options/Parameters tab, 
Parameters -> Number of 
release exit points -> Details -> 
Edit, select No Purge or Decay 
type 

Release Points Number of intermittent 
releases per year NPURGE 

Options/Parameters tab, 
Parameters -> Number of 
release exit points -> Details, 
select Release Point -> Edit 

Release Points Average number of hours 
per intermittent release NPRGHR 

Options/Parameters tab, 
Parameters -> Number of 
release exit points -> Details, 
select Release Point -> Edit 
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Table B-4 LADTAP II Hardwired Parameters 

Name Description 
Location in 

Fortran 
Code 

Value Units 

FACCA Bioaccumulation Factors 
for freshwater plants BLOC 132 values provided on a chemical 

element basis L/kg 

FACCF Bioaccumulation factors for 
freshwater fish BLOC 100 values provided on a chemical 

element basis L/kg 

FACCI Bioaccumulation factors for 
freshwater invertebrates BLOC 116 values provided on a chemical 

element basis L/kg 

SACCA Bioaccumulation Factors 
for Saltwater plants BLOC 180 values provided on a chemical 

element basis L/kg 

SACCF Bioaccumulation factors for 
Saltwater fish BLOC 148 values provided on a chemical 

element basis L/kg 

SACCI Bioaccumulation factors for 
saltwater invertebrates BLOC 164 values provided on a chemical 

element basis L/kg 

PLNTLF, PL Midpoint of plant life (yr) BLOC 195 20.0 years 
POP Total population in 50 miles BLOC 40 260000000.0 people 

TPROCF Processing time for aquatic 
foods (hr) BLOC 215 24.0 hours 

TPROCW Processing time for water 
supply systems BLOC 215 12.0 hours 

DFL Ingestion dose factors  LADTAP.LIB 
file 

Values provided in separate file for 
each radionuclide, age range and 

organ 
 

EXS 

External Dose conversion 
factors for water immersion 
for each radionuclide/age 
group and organ (mrem/hr 
per pCi/L) 

LADTAP.LIB 
file 

Values provided in separate file for 
each radionuclide, age range and 

organ 
 

EXG 

External Dose conversion 
factors for ground exposure 
for each radionuclide/age 
group and organ (mrem/hr 
per pCi/m2) 

LADTAP.LIB 
file 

Values provided in separate file for 
each radionuclide, age range and 

organ 
 

Q1 Milk animals pasture grass 
consumption rate (kg/d) BLOC 44 50.0  

Q2 Milk Animals water 
consumption rate BLOC 44 60.0  

Q3 Beef animals pasture grass 
consumption rate (kg/d) BLOC 44 50.0  

Q4 Beef animals water 
consumption rate (L/d) BLOC 44 50.0  

FRAC Fraction of deposition 
captured by vegetation BLOC 48 0.25  

ZMET Meat transfer coefficient  BLOC 50 Values provided in code for each 
chemical element 

 

SOIL Soil to plant transfer factors BLOC 68 Values provided in code for each 
chemical element 

 

ZMLK Milk transfer coefficient BLOC 84 Values provided in code for each 
chemical element 
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Table B-5 GASPAR II Hardwired Parameters 

Name Description 
Location in 

Fortran 
Code 

Value Units RG 1.109 
Notation 

AREA Total area within 50 mile 
(m2) BLKDATA17 2.00E+10 m2  

AVMET Average Meat intake: child, 
teen, adult BLKDATA16 37, 59, 95 kg/yr Ua 

AVMLK Average Milk intake: child, 
teen, adult BLKDATA15 170, 200, 110 L/yr Ua 

AVVEG Average vegetable intake: 
child, teen, adult BLKDATA15 200, 240, 190 kg/yr Ua 

POPF Population fractions: child, 
teen, adult BLKDATA15 0.18, 0.11, 0.71  fa 

USPOP US Population BLKDATA15 2.80E+08 people  

AVINH Average inhalation rate: 
child, teen, adult BLKDATA15 3700, 8000, 8000 L/yr Ua 

AVLVEG Average leafy vegetable 
intake: child, teen, adult BLKDATA15 10, 20, 30 kg/yr Ua 

SPINH Max Inhalation rate: infant, 
child, teen, adult BLKDATA16 1400, 3700, 8000, 8000 L/yr Ua 

SPVEG Max vegetable intake: 
infant, child, teen, adult BLKDATA16 0, 520, 630, 520 kg/yr Ua 

SLVEG Max leafy vegetable intake: 
infant, child, teen, adult BLKDATA16 0, 26, 42, 64 kg/yr Ua 

SPMLK Max milk intake: infant, 
child, teen adult BLKDATA16 330, 330, 400, 310 L/y Ua 

SPMET Max meat intake: infant, 
child, teen, adult BLKDATA16 0, 41, 65, 110 kg/yr Ua 

BLDAY Growing period for veg. 
consumed by an individual BLKDATA10 60 day te 

COWIN Cow feed ingestion rate BLKDATA10 50 kg/d QF 

DFA Inhalation dose factors  BLKDATA19 
Values provided in separate file 

for each radionuclide, age range 
and organ 

  

FID Fraction of Iodine that 
deposits BLKDATA17 0.5   

GOATIN Goat feed ingestion rate BLKDATA10 6 kg/d QF 

PARTUP 
Retention factor of 
vegetables for particulates 
other than iodine 

BLKDATA10 0.2  r 

PLIFE Midpoint of plant life BLKDATA17 6.31E+08 s tb 
REMVEG Weather removal constant BLKDATA10 5.73E-07 sec-1 λw 

SD Soil surface density BLKDATA10 240 kg/m2 P 

SOIL Soil to plant transfer factors BLKDATA14 Values provided in code for each 
chemical element 

 Biv 

SF Shielding factor for 
individuals BLKDATA17 0.7  SF 
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Table B-5 GASPAR II Hardwired Parameters (cont.) 

  

Name Description 
Location in 

Fortran 
Code 

Value Units RG 1.109 
Notation 

SSF Shielding factor for 
populations BLKDATA17 0.5  SF 

TAU Rad. Decay constant BLKDATA21 Values provided in code for each 
radionuclide sec-1 λi 

TIM(1) Holdup and transport time: 
Meat to consumption BLKDATA10 1.73E+06 sec ts and tp 

TIM(2) Holdup and transport time: 
milk to population BLKDATA10 3.46E+05 sec th and tp 

TIM(3) Holdup and transport time: 
vegetable to pop. BLKDATA10 1.21E+06 sec th and tp 

TIM(4) Holdup and transport time: 
veg. to individual BLKDATA10 5.18E+06 sec th and tp 

TIM(5) Holdup and transport time: 
milk to individual BLKDATA10 1.73E+05 sec tf and tp 

TIM(6) Holdup and transport time: 
leafy veg. to individual BLKDATA10 8.64E+04 sec th and tp 

TIM(7) Holdup and transport time: 
pasture grazing period BLKDATA10 2.59E+06 sec te 

TIM(8) Holdup and transport time: 
feed storage time BLKDATA10 7.78E+06 sec th 

VHS Hydrosphere water volume  2.70E+19 L  
VIORET Iodine retention  BLKDATA10 1  r 

VNA Volume of the atmosphere BLKDATA17 3.80E+18 m3  
YA1 Pasture grass yield BLKDATA10 0.7 kg/m2 Yv 
YA2 Feed crop yield BLKDATA10 2 kg/m2 Yv 

YV Garden vegetable crop 
yield BLKDATA10 2 kg/m2 Yv 

ZGMLK Goat feed-to-milk transfer 
factor for each element BLKDATA10 Values provided for each 

chemical element d/L Fm 

ZMET Feed-to-meat transfer 
factor for each element BLKDATA12 Values provided for each 

chemical element D/Kg Ff 

ZMLK Feed to cow transfer factor 
for each element BLKDATA11 Values provided for each 

chemical element d/L Fm 

BOTB Bone correction factor CARBON19 5 for bone, 1 for all others.  
Applies to carbon doses only. 

  

DFL Ingestion dose factors  DFLIB 
Values provided in separate file 

for each radionuclide, age range 
and organ 

mrem/µCi  

EXG 
External Ground Dose 
Factors (mrem/hr per 
pCi/m2) 

PART 6 Values provided in separate file 
for each radionuclide 

(mrem/hr 
per 

pCi/m2) 
DFG 
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Table B-6 XOQDOQ Hardwired Parameters 

Name Description 
Location in 

Fortran 
Code 

Value Units NOTE 

NDIR Number of wind 
direction sectors Line 124 16   

C Building Wake 
Constant Line 124 0.5  

Default value may be changed 
on Options/Parameters tab, 
Parameters, but requires 
justification 

KOPT(6) Punch radial 
segment X/Q    Not included on screen.  Not 

adjustable in NRCDose3. 

KOPT(7) Punch output X/Q 
at point of interest    Not included on screen. Not 

adjustable in NRCDose3. 

KOPT(11) 

Uneven Sector 
Sizes - 30 
degrees in N, E, 
S, W and 20 
degrees 
elsewhere 

Line 501 0  Not adjustable in NRCDose3.  
Not used in FORTRAN code. 

UCOR 
Correction for 
wind speed from 
mph to m/s 

 0.44704 m/s per mph  
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APPENDIX C:  USAGE PARAMETERS 
C.1 ICRP-30 Usage and Consumption Factors 

In NRCDose3 the assumed usage and consumption values differ depending on the DCF values 
used to perform the dose calculations, regardless if the dose calculation is for a maximum or 
average individual, or it is for a population or individual dose calculation.  The default usage and 
consumption values assumed when ICRP-2 [Ref. 1] or ICRP-30 [Ref. 2] DCF values are used 
are those from RG 1.109, Revision 1 [Ref. 3].  Tables C-1 and C-2 display the usage and 
consumption parameter values for ICRP-2 and ICRP-30 DCF values from Tables E-4 and E-5 of 
RG 1.109. 

Table C-1 ICRP-2 and ICRP-30 DCF Average Individual Exposure Assumptions 

Pathway Units Infant Child Teen Adult Source 
Drinking Water L/yr N/A 260 260 370 RG 1.109, Table E-4 

Inhalation m3/yr N/A 3700 8000 8000 RG 1.109, Table E-4 

Fruit/Vegetables/Grain kg/yr N/A 200 240 190 RG 1.109, Table E-4 

Leafy Vegetables kg/yr N/A 10 20 30 Original LADTAP II code 

Milk L/yr N/A 170 200 110 RG 1.109, Table E-4 

Meat kg/yr N/A 37 59 95 RG 1.109, Table E-4 

Fish kg/yr N/A 2.2 5.2 6.9 RG 1.109, Table E-4 

Other Seafood kg/yr N/A 0.33 0.75 1.0 RG 1.109, Table E-4 

Shoreline hr/yr N/A N/A N/A N/A N/A 

Swimming hr/yr N/A N/A N/A N/A N/A 

Table C-2 ICRP-2 and ICRP-30 DCF Maximum Individual Exposure Assumptions 

Pathway Units Infant Child Teen Adult Source 
Drinking Water L/yr 330 510 510 730 RG 1.109, Table E-5 

Inhalation m3/yr 1400 3700 8000 8000 RG 1.109, Table E-5 

Fruit/Vegetables/Grain kg/yr 0 520 630 520 RG 1.109, Table E-5 

Leafy Vegetables Kg/yr 0 26 42 64 RG 1.109, Table E-5 

Milk L/yr 330 330 400 310 RG 1.109, Table E-5 

Meat kg/yr 0 41 65 110 RG 1.109, Table E-5 

Fish kg/yr 0 6.9 16 21 RG 1.109, Table E-5 

Other Seafood kg/yr 0 1.7 3.8 5 RG 1.109, Table E-5 

Shoreline hr/yr 0 14 67 12 RG 1.109, Table E-5 

Swimming hr/yr N/A N/A N/A N/A N/A 
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C.2 ICRP-72 Usage and Consumption Factors 

Those assumed usage and consumption values for the ICRP-60/72 [Refs. 4 and 5] DCF values 
were derived from EPA EFH [Ref. 6] (https://www.epa.gov/expobox/about-exposure-factors-
handbook).  Regardless of the calculation being performed, the usage and consumption 
parameter values may be adjusted to account for any site-specific behaviors.  Tables C-3 and 
C-4 display the usage and consumption parameter values for ICRP-60/72 DCF values. 

** User Note ** ─ Use of ICRP-72 usage and consumption values by an applicant or licensee 
for a proposed NRC LAR should be discussed with the NRC staff prior to submitting the license 
request. 

Table C-3 ICRP-72 DCF Average Individual Exposure Assumptions 

Pathway Units Infant 
1-year 
(Child) 

5-year 
(Child) 

10-year 
(Child) 

15-year 
(Teen) Adult 

Drinking Water L/yr 203 130 139 187 187 448 

Inhalation m3/yr 1971 3249 3760 4380 5548 5950 

Fruit/Vegetables/Grain kg/yr 71 107 111 123 120 175 

Milk L/yr 26 197 141 125 83 70 

Meat kg/yr 6 18 22 29 35 47 

Fish kg/yr 3 6 7 9 11 18 

Other Seafood kg/yr 1 2 2 2 3 4 

Shoreline hr/yr 10 20 25 26 23 23 

Swimming hr/yr 19 23 27 30 28 29 

Table C-4 ICRP-72 DCF Maximum Individual Exposure Assumptions 

Pathway Units Infant 
1-year 
(Child) 

5-year 
(Child) 

10-year 
(Child) 

15-year 
(Teen) Adult 

Drinking Water L/yr 385 320 350 480 480 1080 

Inhalation m3/yr 3358 5001 5037 6059 7994 8979 

Fruit/Vegetables/Grain kg/yr 182 249 269 323 296 429 

Milk L/yr 150 477 347 369 340 301 

Meat kg/yr 27 51 58 74 97 120 

Fish kg/yr 8 24 20 25 30 58 

Other Seafood kg/yr 2 6 5 6 7 15 

Shoreline hr/yr 17 48 48 48 48 48 

Swimming hr/yr 19 36 36 36 36 36 
  

https://www.epa.gov/expobox/about-exposure-factors-handbook
https://www.epa.gov/expobox/about-exposure-factors-handbook
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APPENDIX D:  EFFECTIVE RADIUS 
D.1 Absorbed Energy in Spheres of Various Sizes 

The energy absorbed within unit density spheres (considered muscle) due to nuclear 
transformation (decay) of an incorporated radionuclide are used in computing the dose to 
aquatic and terrestrial biota within the LADTAP II and GASPAR II Fortran codes in NRCDose3.  
Presently these software packages address a limited number of radionuclides with the absorbed 
energy based on information of the energies and intensities of the emitted radiations and the 
absorbed fraction of the photon emissions derived using dated analytical methods.  In this work, 
we update the numerical data by using the nuclear decay data of ICRP Report No. 107 (ICRP-
107) [Ref. 1] and photon absorbed fraction data of Reference 2 to tabulate the absorbed energy 
within eight-unit density spheres ranging in radius from 1.0 to 30 cm for 203 radionuclides of 
interest. 

The absorbed energy 𝐸𝐸𝑟𝑟𝑎𝑎𝐶𝐶is computed using Equation (D-1): 

 𝐸𝐸𝑟𝑟𝑎𝑎𝐶𝐶 = ∑  ∑ 𝑌𝑌𝑟𝑟,𝐶𝐶  𝐸𝐸𝑟𝑟,𝐶𝐶  𝐴𝐴𝐷𝐷𝑟𝑟,𝐶𝐶
𝑁𝑁𝑟𝑟
𝐶𝐶𝑟𝑟  (D-1) 

where: ∑𝑟𝑟  = the outer summation addresses the various radiation types r; 
 ∑𝑁𝑁𝑟𝑟𝐶𝐶 = the inner summation extends over Nr radiations of type r emitted in the decay 

of the radionuclide; 
 Yr,i = the yield per decay in Becquerel seconds (Bq s); 
 Er,i = the energy per decay in Mega-electron volts (MeV); and 
 AFr,i = the absorbed fraction in the sphere (unit less). 

The AFr,i for all radiations other than photons and photons of energy less than 10 kilo-electron 
volts (keV) is assumed to be 1.  For photons of energy greater than 10 keV, the absorbed 
fraction is based on Reference 2.  For photons of energy greater than 10 kev, the absorbed 
fractions are based on Stable and Konijnenber (Ref. 2). For spheres of 15 and 30 cm radius 
Monte Carlo calculations were undertaken using MCNP (Ref. 3). The unit of the resultant 
quantity is MeV/Bq s.  No relative biological effectiveness factors have been employed in the 
computations.  The diameter, in centimeters (cm), and the mass, in kilograms (kg), of the eight 
spheres is given in Table D-1 and the resultant absorbed energies for the 203 radionuclides are 
contained in Table D-2. 
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Table D-1 Diameter and mass of the unit density spheres 

Radius 
(cm) 

Mass 
(kg) 

1.0 0.0042 

1.5 0.014 

2.5 0.065 

3.5 0.18 

5.0 0.52 

10 4.2 

15 14 

30 113 

Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius 

Nuclide 
Radius 
(cm) 

1 1.5 2.5 3.5 5 10 15 30 
H-3 5.68E-03 5.68E-03 5.68E-03 5.68E-03 5.68E-03 5.68E-03 5.68E-03 5.68E-03 
Be-10 2.52E-01 2.52E-01 2.52E-01 2.52E-01 2.52E-01 2.52E-01 2.52E-01 2.52E-01 
C-14 4.95E-02 4.95E-02 4.95E-02 4.95E-02 4.95E-02 4.95E-02 4.95E-02 4.95E-02 
N-13 5.14E-01 5.27E-01 5.51E-01 5.76E-01 6.14E-01 7.30E-01 8.01E-01 1.01E+00 
F-18 2.64E-01 2.77E-01 3.00E-01 3.24E-01 3.61E-01 4.73E-01 5.42E-01 7.42E-01 
Na-22 2.39E-01 2.64E-01 3.12E-01 3.60E-01 4.34E-01 6.63E-01 8.15E-01 1.24E+00 
Na-24 6.06E-01 6.43E-01 7.16E-01 7.90E-01 9.03E-01 1.25E+00 1.52E+00 2.22E+00 
P-32 6.95E-01 6.95E-01 6.95E-01 6.95E-01 6.95E-01 6.95E-01 6.95E-01 6.95E-01 
S-35 4.87E-02 4.87E-02 4.87E-02 4.87E-02 4.87E-02 4.87E-02 4.87E-02 4.87E-02 
Cl-36 2.73E-01 2.73E-01 2.73E-01 2.73E-01 2.73E-01 2.73E-01 2.73E-01 2.73E-01 
Ar-39 2.19E-01 2.19E-01 2.19E-01 2.19E-01 2.19E-01 2.19E-01 2.19E-01 2.19E-01 
Ar-41 4.87E-01 5.01E-01 5.27E-01 5.54E-01 5.93E-01 7.18E-01 8.07E-01 1.05E+00 
Ca-41 3.23E-03 3.23E-03 3.23E-03 3.23E-03 3.23E-03 3.23E-03 3.23E-03 3.23E-03 
Ca-45 7.72E-02 7.72E-02 7.72E-02 7.72E-02 7.72E-02 7.72E-02 7.72E-02 7.72E-02 
Sc-46 1.53E-01 1.76E-01 2.19E-01 2.63E-01 3.29E-01 5.33E-01 6.75E-01 1.07E+00 
Cr-51 5.70E-03 6.09E-03 6.85E-03 7.62E-03 8.85E-03 1.27E-02 1.48E-02 2.14E-02 
Mn-54 2.35E-02 3.37E-02 5.22E-02 7.11E-02 9.98E-02 1.87E-01 2.47E-01 4.14E-01 
Mn-56 8.60E-01 8.78E-01 9.13E-01 9.47E-01 1.00E+00 1.16E+00 1.28E+00 1.60E+00 
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Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius (cont.) 

Nuclide 
Radius 
(cm) 

1 1.5 2.5 3.5 5 10 15 30 
Fe-55 5.83E-03 5.83E-03 5.83E-03 5.83E-03 5.83E-03 5.83E-03 5.83E-03 5.83E-03 
Fe-59 1.41E-01 1.54E-01 1.79E-01 2.03E-01 2.41E-01 3.58E-01 4.41E-01 6.71E-01 
Co-57 2.55E-02 2.69E-02 2.98E-02 3.29E-02 3.79E-02 5.41E-02 6.09E-02 9.02E-02 
Co-58 5.69E-02 6.89E-02 9.07E-02 1.13E-01 1.47E-01 2.51E-01 3.20E-01 5.16E-01 
Co-60 1.44E-01 1.70E-01 2.22E-01 2.74E-01 3.52E-01 5.96E-01 7.70E-01 1.25E+00 
Ni-59 6.89E-03 6.89E-03 6.89E-03 6.89E-03 6.89E-03 6.89E-03 6.89E-03 6.90E-03 
Ni-63 1.74E-02 1.74E-02 1.74E-02 1.74E-02 1.74E-02 1.74E-02 1.74E-02 1.74E-02 
Ni-65 6.38E-01 6.44E-01 6.55E-01 6.66E-01 6.84E-01 7.38E-01 7.76E-01 8.82E-01 
Cu-64 1.30E-01 1.32E-01 1.37E-01 1.41E-01 1.48E-01 1.69E-01 1.82E-01 2.19E-01 
Ga-67 4.47E-02 4.64E-02 5.00E-02 5.39E-02 6.02E-02 8.02E-02 8.96E-02 1.24E-01 
Zn-65 2.14E-02 2.79E-02 4.02E-02 5.25E-02 7.13E-02 1.29E-01 1.70E-01 2.83E-01 
Zn-69m 3.25E-02 3.77E-02 4.76E-02 5.77E-02 7.36E-02 1.22E-01 1.51E-01 2.34E-01 
Zn-69 3.22E-01 3.22E-01 3.22E-01 3.22E-01 3.22E-01 3.22E-01 3.22E-01 3.22E-01 
Se-75 2.78E-02 3.26E-02 4.18E-02 5.13E-02 6.67E-02 1.15E-01 1.38E-01 2.24E-01 
Se-79 5.29E-02 5.29E-02 5.29E-02 5.29E-02 5.29E-02 5.29E-02 5.29E-02 5.29E-02 
Br-82 2.01E-01 2.32E-01 2.90E-01 3.49E-01 4.39E-01 7.15E-01 9.00E-01 1.42E+00 
Br-83 3.26E-01 3.26E-01 3.26E-01 3.26E-01 3.27E-01 3.27E-01 3.28E-01 3.29E-01 
Br-84 1.26E+00 1.28E+00 1.31E+00 1.34E+00 1.40E+00 1.55E+00 1.67E+00 1.97E+00 
Br-85 1.04E+00 1.04E+00 1.04E+00 1.04E+00 1.05E+00 1.05E+00 1.06E+00 1.07E+00 
Kr-83m 4.09E-02 4.10E-02 4.12E-02 4.13E-02 4.14E-02 4.15E-02 4.15E-02 4.15E-02 
Kr-85m 2.59E-01 2.61E-01 2.64E-01 2.68E-01 2.75E-01 2.94E-01 3.04E-01 3.40E-01 
Kr-85 2.51E-01 2.51E-01 2.51E-01 2.51E-01 2.51E-01 2.51E-01 2.51E-01 2.52E-01 
Kr-87 1.34E+00 1.35E+00 1.36E+00 1.38E+00 1.40E+00 1.48E+00 1.53E+00 1.67E+00 
Kr-88 3.98E-01 4.16E-01 4.52E-01 4.88E-01 5.44E-01 7.16E-01 8.47E-01 1.19E+00 
Kr-89 1.40E+00 1.42E+00 1.46E+00 1.50E+00 1.56E+00 1.73E+00 1.86E+00 2.21E+00 
Rb-86 6.70E-01 6.71E-01 6.73E-01 6.75E-01 6.78E-01 6.87E-01 6.94E-01 7.12E-01 
Rb-87 1.15E-01 1.15E-01 1.15E-01 1.15E-01 1.15E-01 1.15E-01 1.15E-01 1.15E-01 
Rb-88 2.08E+00 2.09E+00 2.10E+00 2.11E+00 2.13E+00 2.19E+00 2.23E+00 2.35E+00 
Sr-85 2.52E-02 3.20E-02 4.44E-02 5.66E-02 7.55E-02 1.32E-01 1.66E-01 2.66E-01 
Rb-89 9.91E-01 1.01E+00 1.06E+00 1.10E+00 1.17E+00 1.38E+00 1.54E+00 1.95E+00 
Sr-89 5.85E-01 5.85E-01 5.85E-01 5.85E-01 5.85E-01 5.85E-01 5.85E-01 5.85E-01 
Sr-90 1.96E-01 1.96E-01 1.96E-01 1.96E-01 1.96E-01 1.96E-01 1.96E-01 1.96E-01 
Sr-91 6.70E-01 6.78E-01 6.94E-01 7.09E-01 7.33E-01 8.07E-01 8.56E-01 9.97E-01 
Sr-92 2.27E-01 2.40E-01 2.68E-01 2.95E-01 3.36E-01 4.65E-01 5.57E-01 8.09E-01 
Y-89m 2.67E-02 3.76E-02 5.73E-02 7.73E-02 1.08E-01 2.01E-01 2.65E-01 4.45E-01 
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Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius (cont.) 

Nuclide 
Radius 
(cm) 

1 1.5 2.5 3.5 5 10 15 30 
Y-90 9.33E-01 9.33E-01 9.33E-01 9.33E-01 9.33E-01 9.33E-01 9.33E-01 9.33E-01 
Y-91m 4.02E-02 4.69E-02 5.93E-02 7.19E-02 9.15E-02 1.51E-01 1.88E-01 2.95E-01 
Y-91 6.03E-01 6.03E-01 6.03E-01 6.03E-01 6.04E-01 6.04E-01 6.04E-01 6.05E-01 
Y-92 1.45E+00 1.46E+00 1.46E+00 1.47E+00 1.48E+00 1.50E+00 1.52E+00 1.57E+00 
Y-93 1.17E+00 1.17E+00 1.18E+00 1.18E+00 1.18E+00 1.19E+00 1.20E+00 1.22E+00 
Zr-93 1.94E-02 1.94E-02 1.94E-02 1.94E-02 1.94E-02 1.94E-02 1.94E-02 1.94E-02 
Zr-95 1.35E-01 1.44E-01 1.60E-01 1.77E-01 2.03E-01 2.81E-01 3.33E-01 4.81E-01 
Zr-97 7.40E-01 7.51E-01 7.71E-01 7.91E-01 8.21E-01 9.15E-01 9.77E-01 1.15E+00 
Nb-93m 3.04E-02 3.06E-02 3.08E-02 3.10E-02 3.11E-02 3.13E-02 3.13E-02 3.14E-02 
Nb-95 6.13E-02 7.08E-02 8.79E-02 1.05E-01 1.32E-01 2.14E-01 2.68E-01 4.22E-01 
Nb-95m 1.84E-01 1.86E-01 1.88E-01 1.90E-01 1.93E-01 2.02E-01 2.06E-01 2.20E-01 
Nb-97 4.83E-01 4.92E-01 5.07E-01 5.22E-01 5.46E-01 6.19E-01 6.65E-01 8.00E-01 
Nb-97m 4.83E-01 4.92E-01 5.07E-01 5.22E-01 5.46E-01 6.19E-01 6.65E-01 8.00E-01 
Mo-93 1.01E-02 1.12E-02 1.27E-02 1.36E-02 1.44E-02 1.53E-02 1.56E-02 1.59E-02 
Mo-99 3.96E-01 3.98E-01 4.02E-01 4.05E-01 4.11E-01 4.27E-01 4.37E-01 4.68E-01 
Tc-99m 1.94E-02 2.08E-02 2.39E-02 2.71E-02 3.23E-02 4.87E-02 5.60E-02 8.65E-02 
Tc-99 1.01E-01 1.01E-01 1.01E-01 1.01E-01 1.01E-01 1.01E-01 1.01E-01 1.01E-01 
Tc-101 4.80E-01 4.84E-01 4.92E-01 5.01E-01 5.14E-01 5.54E-01 5.76E-01 6.47E-01 
Ru-103 7.76E-02 8.38E-02 9.55E-02 1.07E-01 1.26E-01 1.83E-01 2.17E-01 3.17E-01 
Ru-105 4.58E-01 4.67E-01 4.85E-01 5.02E-01 5.30E-01 6.12E-01 6.64E-01 8.16E-01 
Ru-106 1.00E-02 1.00E-02 1.00E-02 1.00E-02 1.00E-02 1.00E-02 1.00E-02 1.00E-02 
Rh-103m 3.83E-02 3.85E-02 3.87E-02 3.88E-02 3.90E-02 3.92E-02 3.93E-02 3.93E-02 
Rh-105 1.55E-01 1.56E-01 1.58E-01 1.60E-01 1.63E-01 1.72E-01 1.77E-01 1.93E-01 
Rh-105m 1.55E-01 1.56E-01 1.58E-01 1.60E-01 1.63E-01 1.72E-01 1.77E-01 1.93E-01 
Pd-107 9.58E-03 9.58E-03 9.58E-03 9.58E-03 9.58E-03 9.58E-03 9.58E-03 9.58E-03 
Pd-109 4.40E-01 4.41E-01 4.42E-01 4.43E-01 4.44E-01 4.46E-01 4.46E-01 4.48E-01 
Cd-109 8.85E-02 9.07E-02 9.41E-02 9.64E-02 9.89E-02 1.03E-01 1.04E-01 1.07E-01 
Ag-110 1.18E+00 1.18E+00 1.18E+00 1.18E+00 1.18E+00 1.19E+00 1.19E+00 1.20E+00 
Ag-110m 1.33E-01 1.66E-01 2.26E-01 2.87E-01 3.80E-01 6.66E-01 8.60E-01 1.41E+00 
Ag-111 3.55E-01 3.55E-01 3.55E-01 3.56E-01 3.57E-01 3.60E-01 3.62E-01 3.68E-01 
Cd-113m 1.85E-01 1.85E-01 1.85E-01 1.85E-01 1.85E-01 1.85E-01 1.85E-01 1.85E-01 
Cd-115m 6.05E-01 6.06E-01 6.06E-01 6.07E-01 6.08E-01 6.11E-01 6.14E-01 6.20E-01 
Sn-113 1.00E-02 1.16E-02 1.41E-02 1.59E-02 1.81E-02 2.19E-02 2.33E-02 2.61E-02 
Sn-123 5.23E-01 5.23E-01 5.23E-01 5.23E-01 5.23E-01 5.24E-01 5.25E-01 5.26E-01 
Sn-125 8.10E-01 8.14E-01 8.21E-01 8.28E-01 8.39E-01 8.72E-01 8.96E-01 9.61E-01 
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Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius (cont.) 

Nuclide 
Radius 
(cm) 

1 1.5 2.5 3.5 5 10 15 30 
Sn-126 1.41E-01 1.42E-01 1.45E-01 1.47E-01 1.50E-01 1.59E-01 1.63E-01 1.75E-01 
Sb-124 4.18E-01 4.38E-01 4.77E-01 5.15E-01 5.75E-01 7.58E-01 8.86E-01 1.24E+00 
Sb-125 1.13E-01 1.19E-01 1.31E-01 1.42E-01 1.59E-01 2.11E-01 2.41E-01 3.29E-01 
Sb-126 4.16E-01 4.50E-01 5.13E-01 5.77E-01 6.76E-01 9.77E-01 1.17E+00 1.73E+00 
Sb-126m 6.67E-01 6.86E-01 7.22E-01 7.58E-01 8.15E-01 9.86E-01 1.09E+00 1.41E+00 
Sb-127 3.32E-01 3.40E-01 3.56E-01 3.73E-01 3.98E-01 4.75E-01 5.23E-01 6.64E-01 
Te-125m 1.14E-01 1.16E-01 1.20E-01 1.23E-01 1.27E-01 1.34E-01 1.37E-01 1.41E-01 
Te-127m 8.42E-02 8.48E-02 8.60E-02 8.69E-02 8.81E-02 9.03E-02 9.11E-02 9.24E-02 
Te-127 2.25E-01 2.25E-01 2.25E-01 2.25E-01 2.25E-01 2.26E-01 2.26E-01 2.27E-01 
Te-129m 2.73E-01 2.74E-01 2.75E-01 2.77E-01 2.78E-01 2.83E-01 2.86E-01 2.93E-01 
Te-129 5.46E-01 5.47E-01 5.49E-01 5.51E-01 5.53E-01 5.61E-01 5.65E-01 5.77E-01 
Te-131m 2.18E-01 2.35E-01 2.68E-01 3.00E-01 3.51E-01 5.03E-01 6.05E-01 8.94E-01 
Te-131 7.22E-01 7.27E-01 7.36E-01 7.46E-01 7.62E-01 8.10E-01 8.38E-01 9.26E-01 
Te-132 1.19E-01 1.22E-01 1.29E-01 1.36E-01 1.48E-01 1.79E-01 1.94E-01 2.45E-01 
Te-133 7.13E-01 7.26E-01 7.52E-01 7.78E-01 8.18E-01 9.41E-01 1.02E+00 1.26E+00 
Te-133m 4.26E-01 4.48E-01 4.89E-01 5.30E-01 5.93E-01 7.85E-01 9.14E-01 1.28E+00 
Te-134 2.47E-01 2.58E-01 2.79E-01 3.00E-01 3.33E-01 4.33E-01 4.92E-01 6.72E-01 
I-125 2.55E-02 2.80E-02 3.26E-02 3.63E-02 4.10E-02 4.96E-02 5.23E-02 5.76E-02 
I-129 6.80E-02 6.92E-02 7.15E-02 7.35E-02 7.62E-02 8.16E-02 8.33E-02 8.69E-02 
I-130 3.26E-01 3.53E-01 4.01E-01 4.51E-01 5.28E-01 7.62E-01 9.11E-01 1.34E+00 
I-131 2.01E-01 2.06E-01 2.15E-01 2.24E-01 2.39E-01 2.84E-01 3.10E-01 3.88E-01 
I-132 5.41E-01 5.69E-01 6.19E-01 6.70E-01 7.48E-01 9.87E-01 1.15E+00 1.60E+00 
I-133 4.28E-01 4.35E-01 4.50E-01 4.64E-01 4.86E-01 5.54E-01 5.97E-01 7.20E-01 
I-134 6.31E-01 6.62E-01 7.18E-01 7.75E-01 8.63E-01 1.13E+00 1.31E+00 1.83E+00 
I-134m 1.01E-01 1.05E-01 1.14E-01 1.22E-01 1.35E-01 1.72E-01 1.91E-01 2.51E-01 
I-135 3.75E-01 3.92E-01 4.24E-01 4.57E-01 5.06E-01 6.59E-01 7.68E-01 1.07E+00 
Xe-131m 1.49E-01 1.50E-01 1.52E-01 1.54E-01 1.56E-01 1.60E-01 1.61E-01 1.64E-01 
Xe-133m 1.95E-01 1.96E-01 1.99E-01 2.01E-01 2.03E-01 2.10E-01 2.13E-01 2.20E-01 
Xe-133 1.40E-01 1.42E-01 1.44E-01 1.46E-01 1.49E-01 1.58E-01 1.61E-01 1.70E-01 
Xe-135m 1.11E-01 1.16E-01 1.27E-01 1.37E-01 1.53E-01 2.02E-01 2.32E-01 3.17E-01 
Xe-135 3.27E-01 3.30E-01 3.35E-01 3.42E-01 3.51E-01 3.82E-01 3.98E-01 4.52E-01 
Xe-137 1.70E+00 1.70E+00 1.71E+00 1.71E+00 1.72E+00 1.74E+00 1.75E+00 1.79E+00 
Xe-138 6.79E-01 6.90E-01 7.13E-01 7.35E-01 7.69E-01 8.76E-01 9.52E-01 1.16E+00 
Cs-134m 1.15E-01 1.15E-01 1.17E-01 1.18E-01 1.20E-01 1.24E-01 1.26E-01 1.31E-01 
Cs-134 1.98E-01 2.17E-01 2.53E-01 2.88E-01 3.44E-01 5.11E-01 6.21E-01 9.35E-01 
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Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius (cont.) 

Nuclide 
Radius 
(cm) 

1 1.5 2.5 3.5 5 10 15 30 
Cs-135 8.94E-02 8.94E-02 8.94E-02 8.94E-02 8.94E-02 8.94E-02 8.94E-02 8.94E-02 
Cs-136 1.90E-01 2.15E-01 2.62E-01 3.09E-01 3.81E-01 6.04E-01 7.53E-01 1.18E+00 
Cs-137 1.88E-01 1.88E-01 1.88E-01 1.88E-01 1.88E-01 1.88E-01 1.88E-01 1.88E-01 
Cs-138 1.29E+00 1.31E+00 1.36E+00 1.41E+00 1.48E+00 1.70E+00 1.86E+00 2.30E+00 
Cs-139 1.66E+00 1.67E+00 1.67E+00 1.68E+00 1.69E+00 1.72E+00 1.74E+00 1.79E+00 
Ba-133 6.85E-02 7.48E-02 8.70E-02 9.91E-02 1.18E-01 1.71E-01 1.97E-01 2.79E-01 
Ba-137m 7.89E-02 8.65E-02 1.00E-01 1.14E-01 1.36E-01 2.01E-01 2.43E-01 3.64E-01 
Ba-139 9.02E-01 9.03E-01 9.04E-01 9.05E-01 9.07E-01 9.13E-01 9.16E-01 9.26E-01 
Ba-140 3.26E-01 3.28E-01 3.33E-01 3.38E-01 3.45E-01 3.66E-01 3.79E-01 4.16E-01 
Ba-141 9.82E-01 9.92E-01 1.01E+00 1.03E+00 1.07E+00 1.17E+00 1.23E+00 1.42E+00 
Ba-142 4.36E-01 4.49E-01 4.72E-01 4.95E-01 5.31E-01 6.42E-01 7.14E-01 9.23E-01 
La-140 5.76E-01 6.00E-01 6.47E-01 6.94E-01 7.67E-01 9.90E-01 1.15E+00 1.58E+00 
La-141 9.88E-01 9.88E-01 9.89E-01 9.89E-01 9.90E-01 9.93E-01 9.95E-01 1.00E+00 
La-142 9.04E-01 9.26E-01 9.70E-01 1.01E+00 1.08E+00 1.29E+00 1.45E+00 1.87E+00 
Ce-141 1.73E-01 1.74E-01 1.76E-01 1.78E-01 1.82E-01 1.92E-01 1.97E-01 2.15E-01 
Ce-143 4.44E-01 4.48E-01 4.56E-01 4.64E-01 4.76E-01 5.11E-01 5.30E-01 5.87E-01 
Ce-144 9.23E-02 9.25E-02 9.31E-02 9.38E-02 9.48E-02 9.76E-02 9.88E-02 1.03E-01 
Pr-143 3.15E-01 3.15E-01 3.15E-01 3.15E-01 3.15E-01 3.15E-01 3.15E-01 3.15E-01 
Pr-144 1.21E+00 1.21E+00 1.21E+00 1.21E+00 1.21E+00 1.21E+00 1.22E+00 1.22E+00 
Pr-144m 4.89E-02 4.93E-02 5.01E-02 5.09E-02 5.20E-02 5.47E-02 5.57E-02 5.78E-02 
Nd-147 2.74E-01 2.76E-01 2.80E-01 2.84E-01 2.91E-01 3.10E-01 3.20E-01 3.48E-01 
Pm-147 6.19E-02 6.19E-02 6.19E-02 6.19E-02 6.19E-02 6.19E-02 6.19E-02 6.19E-02 
Pm-148m 2.15E-01 2.39E-01 2.85E-01 3.31E-01 4.03E-01 6.23E-01 7.62E-01 1.16E+00 
Pm-148 7.40E-01 7.46E-01 7.58E-01 7.70E-01 7.89E-01 8.46E-01 8.86E-01 9.97E-01 
Pm-149 3.65E-01 3.65E-01 3.66E-01 3.66E-01 3.67E-01 3.68E-01 3.69E-01 3.71E-01 
Pm-151 3.13E-01 3.17E-01 3.25E-01 3.33E-01 3.47E-01 3.87E-01 4.09E-01 4.77E-01 
Sm-151 2.00E-02 2.00E-02 2.00E-02 2.00E-02 2.00E-02 2.00E-02 2.00E-02 2.00E-02 
Sm-153 2.73E-01 2.74E-01 2.76E-01 2.78E-01 2.82E-01 2.93E-01 2.98E-01 3.11E-01 
Eu-152 1.54E-01 1.68E-01 1.94E-01 2.21E-01 2.61E-01 3.86E-01 4.68E-01 6.99E-01 
Eu-154 2.99E-01 3.13E-01 3.40E-01 3.68E-01 4.10E-01 5.39E-01 6.27E-01 8.74E-01 
Eu-155 6.67E-02 6.75E-02 6.92E-02 7.10E-02 7.41E-02 8.38E-02 8.78E-02 1.02E-01 
Eu-156 4.80E-01 4.93E-01 5.18E-01 5.43E-01 5.81E-01 7.00E-01 7.85E-01 1.02E+00 
Tb-160 2.83E-01 2.96E-01 3.21E-01 3.46E-01 3.84E-01 5.02E-01 5.81E-01 8.05E-01 
Ho-166m 1.87E-01 2.07E-01 2.44E-01 2.82E-01 3.41E-01 5.21E-01 6.35E-01 9.68E-01 
Tm-170 3.28E-01 3.28E-01 3.29E-01 3.29E-01 3.29E-01 3.29E-01 3.30E-01 3.31E-01 
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Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius (cont.) 

Nuclide 
Radius 
(cm) 

1 1.5 2.5 3.5 5 10 15 30 
Yb-169 1.60E-01 1.64E-01 1.72E-01 1.81E-01 1.97E-01 2.45E-01 2.75E-01 3.46E-01 
W-181 1.61E-02 1.66E-02 1.77E-02 1.89E-02 2.10E-02 2.76E-02 3.19E-02 4.00E-02 
W-185 1.27E-01 1.27E-01 1.27E-01 1.27E-01 1.27E-01 1.27E-01 1.27E-01 1.27E-01 
W-187 3.10E-01 3.16E-01 3.26E-01 3.37E-01 3.54E-01 4.05E-01 4.37E-01 5.28E-01 
Ta-182 2.38E-01 2.52E-01 2.80E-01 3.08E-01 3.50E-01 4.84E-01 5.74E-01 8.28E-01 
Ir-192 2.37E-01 2.47E-01 2.66E-01 2.86E-01 3.18E-01 4.14E-01 4.69E-01 6.38E-01 
Au-198 3.37E-01 3.42E-01 3.52E-01 3.62E-01 3.77E-01 4.24E-01 4.52E-01 5.33E-01 
Tl-201 5.10E-02 5.23E-02 5.47E-02 5.73E-02 6.17E-02 7.55E-02 8.17E-02 1.03E-01 
Tl-204 2.37E-01 2.37E-01 2.37E-01 2.37E-01 2.37E-01 2.38E-01 2.38E-01 2.38E-01 
Pb-210 4.29E-02 4.32E-02 4.35E-02 4.37E-02 4.39E-02 4.44E-02 4.47E-02 4.51E-02 
Bi-210 3.89E-01 3.89E-01 3.89E-01 3.89E-01 3.89E-01 3.89E-01 3.89E-01 3.89E-01 
Po-210 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 
Rn-222 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 
Ra-223 5.85E+00 5.86E+00 5.86E+00 5.86E+00 5.87E+00 5.89E+00 5.90E+00 5.93E+00 
Ra-225 1.07E-01 1.08E-01 1.09E-01 1.09E-01 1.11E-01 1.13E-01 1.15E-01 1.17E-01 
Ra-224 5.78E+00 5.78E+00 5.78E+00 5.78E+00 5.78E+00 5.78E+00 5.78E+00 5.78E+00 
Ra-226 4.86E+00 4.86E+00 4.86E+00 4.86E+00 4.87E+00 4.87E+00 4.87E+00 4.87E+00 
Ra-228 1.50E-02 1.52E-02 1.55E-02 1.57E-02 1.59E-02 1.61E-02 1.61E-02 1.62E-02 
Ac-225 5.92E+00 5.92E+00 5.92E+00 5.92E+00 5.92E+00 5.92E+00 5.92E+00 5.93E+00 
Ac-227 8.50E-02 8.50E-02 8.51E-02 8.52E-02 8.52E-02 8.52E-02 8.53E-02 8.53E-02 
Th-227 6.07E+00 6.07E+00 6.08E+00 6.08E+00 6.09E+00 6.10E+00 6.11E+00 6.14E+00 
Th-228 5.52E+00 5.52E+00 5.52E+00 5.52E+00 5.52E+00 5.52E+00 5.52E+00 5.52E+00 
Th-229 5.09E+00 5.09E+00 5.10E+00 5.10E+00 5.10E+00 5.12E+00 5.12E+00 5.14E+00 
Th-230 4.77E+00 4.77E+00 4.77E+00 4.77E+00 4.77E+00 4.77E+00 4.77E+00 4.77E+00 
Th-232 4.08E+00 4.08E+00 4.08E+00 4.08E+00 4.08E+00 4.08E+00 4.08E+00 4.08E+00 
Th-234 6.35E-02 6.37E-02 6.41E-02 6.45E-02 6.50E-02 6.65E-02 6.71E-02 6.92E-02 
Pa-231 5.12E+00 5.12E+00 5.12E+00 5.12E+00 5.13E+00 5.13E+00 5.13E+00 5.14E+00 
Pa-233 2.25E-01 2.29E-01 2.35E-01 2.41E-01 2.50E-01 2.77E-01 2.91E-01 3.37E-01 
U-232 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 5.41E+00 
U-233 4.91E+00 4.91E+00 4.91E+00 4.91E+00 4.91E+00 4.91E+00 4.91E+00 4.91E+00 
U-234 4.86E+00 4.86E+00 4.86E+00 4.86E+00 4.86E+00 4.86E+00 4.86E+00 4.86E+00 
U-235 4.53E+00 4.53E+00 4.54E+00 4.54E+00 4.55E+00 4.57E+00 4.58E+00 4.62E+00 
U-236 4.57E+00 4.57E+00 4.57E+00 4.57E+00 4.57E+00 4.57E+00 4.57E+00 4.57E+00 
U-237 2.09E-01 2.11E-01 2.16E-01 2.20E-01 2.27E-01 2.46E-01 2.55E-01 2.86E-01 
U-238 4.27E+00 4.27E+00 4.27E+00 4.27E+00 4.27E+00 4.27E+00 4.27E+00 4.27E+00 
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Table D-2 Effective Energy Deposited (MeV/nt) in Tissue of Given Radius (cont.) 

Nuclide 
Radius 
(cm) 

1 1.5 2.5 3.5 5 10 15 30 
Np-237 4.92E+00 4.93E+00 4.93E+00 4.93E+00 4.93E+00 4.94E+00 4.94E+00 4.94E+00 
Np-238 2.67E-01 2.74E-01 2.88E-01 3.01E-01 3.20E-01 3.80E-01 4.21E-01 5.37E-01 
Np-239 2.72E-01 2.75E-01 2.80E-01 2.85E-01 2.93E-01 3.17E-01 3.28E-01 3.68E-01 
Pu-236 5.87E+00 5.87E+00 5.87E+00 5.87E+00 5.87E+00 5.87E+00 5.87E+00 5.87E+00 
Pu-238 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 5.59E+00 
Pu-239 5.24E+00 5.24E+00 5.24E+00 5.24E+00 5.24E+00 5.24E+00 5.24E+00 5.24E+00 
Pu-240 5.25E+00 5.26E+00 5.26E+00 5.26E+00 5.26E+00 5.26E+00 5.26E+00 5.26E+00 
Pu-241 5.36E-03 5.36E-03 5.36E-03 5.36E-03 5.36E-03 5.36E-03 5.36E-03 5.36E-03 
Pu-242 4.98E+00 4.98E+00 4.98E+00 4.99E+00 4.99E+00 4.99E+00 4.99E+00 4.99E+00 
Pu-244 4.89E+00 4.89E+00 4.89E+00 4.89E+00 4.89E+00 4.89E+00 4.89E+00 4.90E+00 
Am-241 5.61E+00 5.61E+00 5.62E+00 5.62E+00 5.62E+00 5.62E+00 5.63E+00 5.63E+00 
Am-242m 7.03E-02 7.08E-02 7.14E-02 7.18E-02 7.22E-02 7.27E-02 7.29E-02 7.31E-02 
Am-243 5.38E+00 5.39E+00 5.39E+00 5.39E+00 5.39E+00 5.40E+00 5.41E+00 5.42E+00 
Cm-242 6.21E+00 6.21E+00 6.22E+00 6.22E+00 6.22E+00 6.22E+00 6.22E+00 6.22E+00 
Cm-243 6.04E+00 6.04E+00 6.04E+00 6.05E+00 6.05E+00 6.07E+00 6.08E+00 6.10E+00 
Cm-244 5.90E+00 5.90E+00 5.90E+00 5.90E+00 5.90E+00 5.90E+00 5.90E+00 5.90E+00 
Cm-245 5.54E+00 5.54E+00 5.54E+00 5.55E+00 5.55E+00 5.57E+00 5.57E+00 5.59E+00 
Cm-246 5.52E+00 5.52E+00 5.52E+00 5.52E+00 5.53E+00 5.53E+00 5.53E+00 5.53E+00 
Cm-247 5.05E+00 5.05E+00 5.06E+00 5.07E+00 5.08E+00 5.12E+00 5.14E+00 5.20E+00 
Cm-248 2.13E+01 2.13E+01 2.13E+01 2.13E+01 2.14E+01 2.15E+01 2.16E+01 2.18E+01 
Cf-252 1.24E+01 1.24E+01 1.24E+01 1.24E+01 1.24E+01 1.24E+01 1.25E+01 1.26E+01 

D.2 References 

1. ICRP Report No. 107, "Nuclear Decay Data for Dosimetric Calculations," ICRP 107, 
Annals of the ICRP Vol. 38, No.3, 2008. 

2. Stabin M.G., Konijnenberg M. W., 2000.  “Re-evaluation of absorbed fractions for 
photons and electrons in spheres of various sizes,” J. Nucl. Med. 41:149-160. 

3. MCNP, 2017.  MCNP User’s Manual – Code Version 6.2, Ed. C. J. Werner, Los Alamos 
National Laboratory. 
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APPENDIX E:  ASSUMED F1 VALUES AND INHALATION CLASS 
NRCDose3 contains 203 radionuclides which can be assumed to exist in one of multiple 
ingestion and inhalation forms.  The following information outlines the ingestion and inhalation 
forms that are available for selection in NRCDose3. 

E.1 NRCDose3 – ICRP-30 Dosimetric Methodology 

Table E-1 outlines the f1 values and the ingestion and inhalation classes that are available for 
selection in NRCDose3, when the ICRP-30 [Ref. 1] methodology has been selected.  The 
default form is noted, for both ingestion and inhalation. 

Table E-1 NRCDose3 – ICRP-30 f1 Values and Ingestion and Inhalation Classes 

Nuclide 
Ingestion Inhalation 

f1 Default Form f1 Default Class Form 

H-3 1 X All forms 1 X V Water vapor 

Be-10 0.005 X All forms 
0.005  W All others 

0.005 X Y Oxides, halides and 
nitrates 

C-14 1 X Organic 

1  c Organic forms 

1  m Monoxides 
1 X d Dioxide 

N-13  X   X   

F-18 1 X All forms 

1 X D See assignment of 
associated element 

1  W See assignment of 
associated element 

1  Y See assignment of 
associated element 

Na-22 1 X All forms 1 X D All forms 

Na-24 1 X All forms 1 X D All forms 

P-32 0.8 X All forms 
0.8 X D  

0.8  W Phosphates of particular 
element 

S-35 
0.8  All inorganic 

Forms 0.8  D Sulfides and sulfides of 
associated elements 

0.1 X Elemental 
0.8  W Elemental 
1 X V Gases 

Cl-36 1 X All forms 
1  D See assignment of 

associated element 

1 X W See assignment of 
associated element 

Ar-39     X   
Ar-41     X   
Ca-41 0.3 X All forms 0.3 X W All forms 
Ca-45 0.3 X All forms 0.3 X W All forms 
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Table E-1 NRCDose3 – ICRP-30 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide 
Ingestion Inhalation 

f1 Default Form f1 Default Class Form 

Sc-46 0.0001 X All forms 0.0001 X Y All forms 

Cr-51 
0.1  Hexavalent 

State 0.1  D All others 

0.01 X Trivalent state 
0.1  W Halides and nitrates 
0.1 X Y Oxides and hydroxides 

Mn-54 0.1 X All forms 
0.1  D All others 

0.1 X W Oxides, hydroxides, 
halides and nitrates 

Mn-56 0.1 X All forms 
0.1  D All others 

0.1 X W Oxides, hydroxides, 
halides and nitrates 

Fe-55 0.1 X All forms 
0.1  D All others 

0.1 X W Oxides, hydroxides and 
halides 

Fe-59 0.1 X All forms 
0.1  D All others 

0.1 X W Oxides, hydroxides and 
halides 

Co-57 
0.05 X 

Oxides, 
hydroxides and 
trace inorganic 

0.05  W All others 

0.3  
Organic 
complexed and 
other inorganics 

0.05 X Y Oxides, hydroxides, 
halides and nitrates 

Co-58 
0.05 X 

Oxides, 
hydroxides and 
trace inorganic 

0.05  W All others 

0.3  
Organic 
complexed and 
other inorganics 

0.05 X Y Oxides, hydroxides, 
halides and nitrates 

Co-60 
0.05 X 

Oxides, 
hydroxides and 
trace inorganic 

0.05  W All others 

0.3  
Organic 
complexed and 
other inorganics 

0.05 X Y Oxides, hydroxides, 
halides and nitrates 

Ni-59 0.05 X All forms 

0.05  D All others 

0.05 X W Oxides, hydroxides and 
carbides 

10  V Vapors 

Ni-63 0.05 X All forms 

0.05  D All others 

0.05 X W Oxides, hydroxides and 
carbides 

10  V Vapors 
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Table E-1 NRCDose3 – ICRP-30 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide 
Ingestion Inhalation 

f1 Default Form f1 Default Class Form 

Ni-65 0.05  All forms 

0.05  D All others 

0.05 X W Oxides, hydroxides and 
carbides 

10  V Vapors 

Cu-64 0.5 X All forms 

0.5  D All others 

0.5  W Sulfites, halides and 
nitrates 

0.5 X Y Oxides and hydroxides 

Zn-65 0.5 X All forms 0.5 X Y All forms 
Zn-69m 0.5 X All forms 0.5 X Y All forms 
Zn-69 0.5 X All forms 0.5 X Y All forms 

Ga-67 0.001 X All forms 

0.001  D All others 

0.001 X W 
Oxides, hydroxides, 
carbides, halides and 
nitrates 

Se-75 
0.8  All others 0.8  D All others 

0.05 X Elemental 0.8 X W Oxides, hydroxides, 
carbides and elemental 

Se-79 
0.8  All others 0.8  D All others 

0.05 X Elemental 0.8 X W Oxides, hydroxides, 
carbides and elemental 

Br-82 1 X All forms 
1 X D See bromide assignment 

of associated element 

1  W See bromide assignment 
of associated element 

Br-83 1 X All forms 
1 X D See bromide assignment 

of associated element 

1  W See bromide assignment 
of associated element 

Br-84 1 X All forms 
1 X D See bromide assignment 

of associated element 

1  W See bromide assignment 
of associated element 

Br-85  X All forms  X   
Kr-83m  X   X   
Kr-85m  X   X   
Kr-85  X   X   
Kr-87  X   X   

Kr-88  X   X   
Kr-89  X   X   
Rb-86 1 X All forms 1 X D All forms 
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Table E-1 NRCDose3 – ICRP-30 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide 
Ingestion Inhalation 

f1 Default Form f1 Default Class Form 

Rb-87  X All forms  X   

Rb-88 1 X All forms 1 X D All forms 
Rb-89 1 X All forms 1 X D All forms 

Sr-85 
0.3 X Soluble salts 0.3 Y D All others 

0.01  SrTiO3 0.01  Y SrTiO3 

Sr-89 
0.3 X Soluble salts 0.3 Y D All others 

0.01  SrTiO3 0.01  Y SrTiO3 

Sr-90 
0.3 X Soluble salts 0.3 Y D All others 

0.01  SrTiO3 0.01  Y SrTiO3 

Sr-91 
0.3 X Soluble salts 0.3 Y D All others 

0.01  SrTiO3 0.01  Y SrTiO3 

Sr-92 
0.3 X Soluble salts 0.3 Y D All others 

0.01  SrTiO3 0.01  Y SrTiO3 

Y-90 0.0001 X All forms 
0.0001  W All others 
0.0001 X Y Oxides and hydroxides 

Y-91m 0.0001 X All forms 
0.0001  W All others 
0.0001 X Y Oxides and hydroxides 

Y-91 0.0001 X All forms 
0.0001  W All others 
0.0001 X Y Oxides and hydroxides 

Y-92 0.0001 X All forms 
0.0001  W All others 
0.0001 X Y Oxides and hydroxides 

Y-93 0.0001 X All forms 
0.0001  W All others 
0.0001 X Y Oxides and hydroxides 

Zr-93 0.002 X All forms 

0.002  D All others 

0.002 X W Oxides, hydroxides, 
halides and nitrates 

0.002  Y Carbides 

Zr-95 0.002 X All forms 

0.002  D All others 

0.002 X W Oxides, hydroxides, 
halides and nitrates 

0.002  Y Carbides 

Zr-97 0.002 X All forms 

0.002  D All others 

0.002 X W Oxides, hydroxides, 
halides and nitrates 

0.002  Y Carbides 

Nb-93m 0.01 X All forms 
0.01  W All others 

0.01 X Y Oxides and hydroxides 
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Table E-1 NRCDose3 – ICRP-30 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide 
Ingestion Inhalation 

f1 Default Form f1 Default Class Form 

Nb-95 0.01 X All forms 
0.01  W All others 

0.01 X Y Oxides and hydroxides 

Nb-97 0.01 X All forms 
0.01  W All others 
0.01 X Y Oxides and hydroxides 

Mo-93 
0.8 X All others 0.8  D All others 

0.05  MoS2 0.05 X Y Oxides, hydroxides and 
MoS2 

Mo-99 
0.8 X All others 0.8  D All others 

0.05  MoS2 0.05 X Y Oxides, hydroxides and 
MoS2 

Tc-99m 0.8 X All forms 
0.8  D All others 

0.8 X W Oxides, hydroxides, 
halides and nitrates 

Tc-99 0.8 X All forms 
0.8  D All others 

0.8 X W Oxides, hydroxides, 
halides and nitrates 

Tc-101 0.8 X All forms 
0.8  D All others 

0.8 X W Oxides, hydroxides, 
halides and nitrates 

Ru-103 0.05 X All forms 
0.05  D All others 
0.05  W Halides 
0.05 X Y Oxides and hydroxides 

Ru-105 0.05 X All forms 
0.05  D All others 
0.05  W Halides 
0.05 X Y Oxides and hydroxides 

Ru-106 0.05 X All forms 
0.05  D All others 
0.05  W Halides 
0.05 X Y Oxides and hydroxides 

Rh-105 0.05 X All forms 
0.05  D All others 
0.05  W Halides 
0.05 X Y Oxides and hydroxides 

Pd-107 0.005 X All forms 
0.005  D All others 
0.005  W Nitrates 
0.005 X Y Oxides and hydroxides 

Pd-109 0.005 X All forms 

0.005  D All others 

0.005  W Nitrates 

0.005 X Y Oxides and hydroxides 
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Table E-1 NRCDose3 – ICRP-30 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide 
Ingestion Inhalation 

f1 Default Form f1 Default Class Form 

Ag-110m 0.05 X All forms 

0.05  D All others 

0.05  W Nitrates and sulfides 
0.05 X Y Oxides and hydroxides 

Ag-111 0.05 X All forms 
0.05  D All others 
0.05  W Nitrates and sulfides 
0.05 X Y Oxides and hydroxides 

Cd-109 0.05 X All forms 

0.05  D All others 

0.05  W Sulfates, halides and 
nitrates 

0.05 X Y Oxides and hydroxides 

Cd-113m 0.05 X All forms 

0.05  D All others 

0.05  W Sulfates, halides and 
nitrates 

0.05 X Y Oxides and hydroxides 

Cd-115m 0.05 X All forms 

0.05  D All others 

0.05  W Sulfates, halides and 
nitrates 

0.05 X Y Oxides and hydroxides 

Sn-113 0.02 X All forms 

0.02  D All others 

0.02 X W 
Oxides, hydroxides, 
halides, nitrates, sulfides 
and Sn3(PO4)4 

Sn-123 0.02 X All forms 

0.02  D All others 

0.02 X W 
Oxides, hydroxides, 
halides, nitrates, sulfides 
and Sn3(PO4)4 

Sn-125 0.02 X All forms 

0.02  D All others 

0.02 X W 
Oxides, hydroxides, 
halides, nitrates, sulfides 
and Sn3(PO4)4 

Sn-126 0.02 X All forms 

0.02  D All others 

0.02 X W 
Oxides, hydroxides, 
halides, nitrates, sulfides 
and Sn3(PO4)4 

Sb-124 
0.1  Tartar emetic 0.1  D All others 

0.01 X All others 0.01 X W 
Oxides, hydroxides, 
halides, sulfides, sulfates 
and nitrates 

Sb-125 

0.1  Tartar emetic 0.1  D All others 

0.01 X All others 0.01 X W 
Oxides, hydroxides, 
halides, sulfides, sulfates 
and nitrates 
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Table E-1 NRCDose3 – ICRP-30 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide 
Ingestion Inhalation 

f1 Default Form f1 Default Class Form 

Sn-126 0.02 X All forms 

0.02  D All others 

0.02 X W 
Oxides, hydroxides, 
halides, nitrates, sulfides 
and Sn3(PO4)4 

Sb-124 
0.1  Tartar emetic 0.1  D All others 

0.01 X All others 0.01 X W 
Oxides, hydroxides, 
halides, sulfides, sulfates 
and nitrates 

Sb-125 
0.1  Tartar emetic 0.1  D All others 

0.01 X All others 0.01 X W 
Oxides, hydroxides, 
halides, sulfides, sulfates 
and nitrates 

Sb-126 
0.1  Tartar emetic 0.1  D All others 

0.01 X All others 0.01 X W 
Oxides, hydroxides, 
halides, sulfides, sulfates 
and nitrates 

Sb-127 
0.1  Tartar emetic 0.1  D All others 

0.01 X All others 0.01 X W 
Oxides, hydroxides, 
halides, sulfides, sulfates 
and nitrates 

Te-125m 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides and 
nitrates 

Te-127m 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides and 
nitrates 

Te-127 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides and 
nitrates 

Te-129m 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides and 
nitrates 

Te-129 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides and 
nitrates 

Te-131m 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides and 
nitrates 

Te-131 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides and 
nitrates 

Te-132 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides and 
nitrates 
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Table E-1 NRCDose3 – ICRP-30 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide 
Ingestion Inhalation 

f1 Default Form f1 Default Class Form 

Te-133m 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides and 
nitrates 

Te-134 0.2 X All forms 
0.2  D All others 

0.2 X W Oxides, hydroxides and 
nitrates 

I-125 1 X All forms 1 X D All forms 
I-129 1 X All forms 1 X D All forms 
I-130 1 X All forms 1 X D All forms 
I-131 1 X All forms 1 X D All forms 
I-132 1 X All forms 1 X D All forms 
I-133 1 X All forms 1 X D All forms 
I-134 1 X All forms 1 X D All forms 
I-135 1 X All forms 1 X D All forms 
Xe-131m  X   X   
Xe-133m  X   X   

Xe-133  X   X   
Xe-135m  X   X   
Xe-135  X   X   
Xe-137  X   X   
Xe-138  X   X   
Cs-134m 1 X All forms 1 X D All forms 
Cs-134 1 X All forms 1 X D All forms 
Cs-135 1 X All forms 1 X D All forms 
Cs-136 1 X All forms 1 X D All forms 
Cs-137 1 X All forms 1 X D All forms 
Cs-138 1 X All forms 1 X D All forms 
Cs-139  X All forms  X   

Ba-133 0.1 X All forms 0.1 X D All forms 
Ba-139 0.1 X All forms 0.1 X D All forms 
Ba-140 0.1 X All forms 0.1 X D All forms 
Ba-141 0.1 X All forms 0.1 X D All forms 
Ba-142 0.1 X All forms 0.1 X D All forms 

La-140 0.001 X All forms 
0.001  D All others 
0.001 X W Oxides and hydroxides 

La-141 0.001 X All forms 
0.001  D All others 

0.001 X W Oxides and hydroxides 
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Table E-1 NRCDose3 – ICRP-30 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide 
Ingestion Inhalation 

f1 Default Form f1 Default Class Form 

La-142 0.001 X All forms 
0.001  D All others 

0.001 X W Oxides and hydroxides 

Ce-141 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides and 
fluorides 

Ce-143 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides and 
fluorides 

Ce-144 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides and 
fluorides 

Pr-143 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbide and fluorides 

Pr-144 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbide and fluorides 

Nd-147 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbides and fluorides 

Pm-147 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbides and fluorides 

Pm-148m 0.0003 X All forms 0.0003 X Y Oxides, hydroxides, 
carbides and fluorides 

Pm-148 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbides and fluorides 

Pm-149 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbides and fluorides 

Pm-151 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides, 
carbides and fluorides 

Sm-151 0.0003 X All forms 0.0003 X W All forms 
Sm-153 0.0003 X All forms 0.0003 X W All forms 
Eu-152 0.001 X All forms 0.001 X W All forms 
Eu-154 0.001 X All forms 0.001 X W All forms 
Eu-155 0.001 X All forms 0.001 X W All forms 
Eu-156 0.001 X All forms 0.001 X W All forms 
Tb-160 0.0003 X All forms 0.0003 X W All forms 
Ho-166m 0.0003 X All forms 0.0003 X W All forms 
Tm-170 0.0003 X All forms 0.0003 X W All forms 
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Table E-1 NRCDose3 – ICRP-30 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide 
Ingestion Inhalation 

f1 Default Form f1 Default Class Form 

Yb-169 0.0003 X All forms 
0.0003  W All others 

0.0003 X Y Oxides, hydroxides and 
fluorides 

Ta-182 0.001 X All forms 

0.001  W All others 

0.001 X Y 
Oxides, hydroxides, 
halides, carbides, nitrates 
and nitrides 

W-181 
0.01  Tungstic acid 0.3 X D All forms 
0.3 X All others     

W-185 
0.01  Tungstic acid 0.3 X D All forms 
0.3 X All others     

W-187 
0.01  Tungstic acid 0.3 X D All forms 
0.3 X All others     

Ir-192 0.01 X All forms 

0.01  D All others 

0.01  W Halides, nitrates and 
metallic form 

0.01 X Y Oxides and hydroxides 

Au-198 0.1 X All forms 
0.1  D All others 
0.1  W Halides and nitrates 
0.1 X Y Oxides and hydroxides 

Tl-201 1 X All forms 1 X D All forms 

Tl-204 1 X All forms 1 X D All forms 
Pb-210 0.2 X All forms 0.2 X D All forms 

Bi-210 0.05 X All forms 
0.05  D Nitrates 
0.05 Y W All others 

Po-210 0.1 X All forms 
0.1  D All others 

0.1 X W Oxides, hydroxides and 
nitrates 

Rn-222  X   X   
Ra-223 0.2 X All forms 0.2 X W All forms 
Ra-224 0.2 X All forms 0.2 X W All forms 
Ra-225 0.2 X All forms 0.2 X W All forms 
Ra-226 0.2 X All forms 0.2 X W All forms 
Ra-228 0.2 X All forms 0.2 X W All forms 

Ac-225 0.001 X All forms 

0.001  D All others 

0.001  W Halides and nitrates 

0.001 X Y Oxides and hydroxides 
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Table E-1 NRCDose3 – ICRP-30 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide 
Ingestion Inhalation 

f1 Default Form f1 Default Class Form 

Ac-227 0.001 X All forms 

0.001  D All others 

0.001  W Halides and nitrates 
0.001 X Y Oxides and hydroxides 

Th-227 0.0002 X All forms 
0.0002  W All others 
0.0002 X Y Oxides and hydroxides 

Th-228 0.0002 X All forms 
0.0002  W All others 
0.0002 X Y Oxides and hydroxides 

Th-229 0.0002 X All forms 
0.0002  W All others 
0.0002 X Y Oxides and hydroxides 

Th-230 0.0002 X All forms 
0.0002  W All others 
0.0002 X Y Oxides and hydroxides 

Th-232 0.0002 X All forms 
0.0002  W All others 
0.0002 X Y Oxides and hydroxides 

Th-234 0.0002 X All forms 
0.0002  W All others 
0.0002 X Y Oxides and hydroxides 

Pa-231 0.001 X All forms 
0.001  W All others 
0.001 X Y Oxides and hydroxides 

Pa-233 0.001 X All forms 
0.001  W All others 
0.001 X Y Oxides and hydroxides 

U-232 
0.05  Hexavalent 0.05  D UF6, UO2F2 and 

UO2(NO3)2 

0.002 X Insoluble forms 
0.05  W UO3, UF4 and UCl4 

0.002 X Y UO2, U3O8 

U-233 
0.05  Hexavalent 0.05  D UF6, UO2F2 and 

UO2(NO3)2 

0.002 X Insoluble forms 
0.05  W UO3, UF4 and UCl4 

0.002 X Y UO2, U3O8 

U-234 
0.05  Hexavalent 0.05  D UF6, UO2F2 and 

UO2(NO3)2 

0.002 X Insoluble forms 
0.05  W UO3, UF4 and UCl4 

0.002 X Y UO2, U3O8 

U-235 
0.05  Hexavalent 0.05  D UF6, UO2F2 and 

UO2(NO3)2 

0.002 X Insoluble forms 
0.05  W UO3, UF4 and UCl4 

0.002 X Y UO2, U3O8 

U-236 

0.05  Hexavalent 0.05  D UF6, UO2F2 and 
UO2(NO3)2 

0.002 X Insoluble forms 
0.05  W UO3, UF4 and UCl4 

0.002 X Y UO2, U3O8 
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Table E-1 NRCDose3 – ICRP-30 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide 
Ingestion Inhalation 

f1 Default Form f1 Default Class Form 

U-237 
0.05  Hexavalent 0.05  D UF6, UO2F2 and 

UO2(NO3)2 

0.002 X Insoluble forms 
0.05  W UO3, UF4 and UCl4 

0.002 X Y UO2, U3O8 

U-238 
0.05  Hexavalent 0.05  D UF6, UO2F2 and 

UO2(NO3)2 

0.002 X Insoluble forms 
0.05  W UO3, UF4 and UCl4 

0.002 X Y UO2, U3O8 
Np-237 0.001 X All forms 0.001 X W All forms 
Np-238 0.001 X All forms 0.001 X W All forms 
Np-239 0.001 X All forms 0.001 X W All forms 

Pu-236 
0.001  Others 0.001  W All others 
0.0001  Nitrates 

1E-05 X Y Oxides 
0.00001 X Oxides 

Pu-238 
0.001  Others 0.001  W All others 
0.0001  Nitrates 

1E-05 X Y Oxides 
0.00001 X Oxides 

Pu-239 
0.001  Others 0.001  W All others 
0.0001  Nitrates 

1E-05 X Y Oxides 
0.00001 X Oxides 

Pu-240 
0.001  Others 0.001  W All others 
0.0001  Nitrates 

1E-05 X Y Oxides 
0.00001 X Oxides 

Pu-241 
0.001  Others 0.001  W All others 
0.0001  Nitrates 

1E-05 X Y Oxides 
0.00001 X Oxides 

Pu-242 
0.001  Others 0.001  W All others 
0.0001  Nitrates 

1E-05 X Y Oxides 
0.00001 X Oxides 

Pu-244 
0.001  Others 0.001  W All others 
0.0001  Nitrates 

1E-05 X Y Oxides 
0.00001 X Oxides 

Am-241 0.001 X All forms 0.001 X W All forms 
Am-242m 0.001 X All forms 0.001 X W All forms 
Am-243 0.001 X All forms 0.001 X W All forms 
Cm-242 0.001 X All forms 0.001 X W All forms 
Cm-243 0.001 X All forms 0.001 X W All forms 
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Table E-1 NRCDose3 – ICRP-30 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide 
Ingestion Inhalation 

f1 Default Form f1 Default Class Form 

Cm-244 0.001 X All forms 0.001 X W All forms 

Cm-245 0.001 X All forms 0.001 X W All forms 
Cm-246 0.001 X All forms 0.001 X W All forms 
Cm-247 0.001 X All forms 0.001 X W All forms 
Cm-248 0.001 X All forms 0.001 X W All forms 

Cf-252 0.001 X All forms 
0.001  W All others 

0.001 X Y Oxides and hydroxides 

E.2 NRCDose3 – ICRP-72 Dosimetric Methodology 

Table E-2 outlines the f1 values and the ingestion and inhalation classes that are available for 
selection in NRCDose3, when the ICRP-72 [Ref. 2] methodology has been selected.  The 
default form is noted, for both ingestion and inhalation. 

  



 

E-14 

Table E-2 NRCDose3 – ICRP-72 f1 Values and Ingestion and Inhalation Classes 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

H-3 

1 OBT  1 OBT  V 

1 X 

1 HT  V 
1 CH3T  V 
1 HTO X V 

1  F 
0.2  M 

0.02  S 

Be-10 0.02 X 0.02  M 
0.02 X S 

C-14 1 X 

1 CO2 X V 
1 CO  V 
1 CH4  V 

1  V 
1  F 

0.2  M 
0.02  S 

N-13  X  X  

F-18 1 X 
1 X F 
1  M 
1  S 

Na-22 1 X 1 X F 
Na-24 1 X 1 X F 

P-32 1 X 1 X F 
1  M 

S-35 

1  1 SO2 Y V 

1 X 

1 CS2  V 
1  F 

0.2  M 
0.02  S 

Cl-36 1 X 1  F 
1 X M 

Ar-39  X  X  
Ar-41  X  X  

Ca-41 0.6 X 
0.6  F 
0.2 X M 

0.02  S 

Ca-45 0.6 X 
0.6  F 
0.2 X M 

0.02  S 
Sc-46 0.001 X 0.001 X S 

Cr-51 
0.2  0.2  F 

0.02 X 0.2  M 
0.2 X S 

Mn-54 0.2 X 0.2  F 
0.2 X M 

Mn-56 0.2 X 0.2  F 
0.2 X M 

Fe-55 0.6 X 
0.6  F 
0.2 X M 

0.02  S 
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Table E 2 NRCDose3 – ICRP-72 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Fe-59 0.6 X 
0.6  F 
0.2 X M 

0.02  S 

Co-57 0.6 X 
0.6  F 
0.2  M 

0.02 X S 

Co-58 0.6 X 
0.6  F 
0.2  M 

0.02 X S 

Co-60 0.6 X 
0.6  F 
0.2  M 

0.02 X S 

Ni-59 0.1 X 

0.1  V 
0.1  F 
0.1 X M 

0.02  S 

Ni-63 0.1 X 

0.1  V 
0.1  F 
0.1 X M 

0.02  S 

Ni-65 0.1 X 

0.1  V 
0.1  F 
0.1 X M 

0.02  S 

Cu-64 1 X 
1  F 
1  M 
1 X S 

Zn-65 1 X 
1  F 

0.2  M 
0.02 X S 

Zn-69 1 X 
1  F 

0.2  M 
0.02 X S 

Zn-69m 1 X 
1  F 

0.2  M 
0.02 X S 

Ga-67 0.01 X 0.01  F 
0.01 X M 

Se-75 1 X 
1  F 

0.2 X M 
0.02  S 

Se-79 1 X 
1  F 

0.2 X M 
0.02  S 

Br-82 1 X 1 X F 
1  M 

Br-83 1 X 1 X F 
1  M 
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Table E 2 NRCDose3 – ICRP-72 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Br-84 1 X 1 X F 
1  M 

BR-85  X  X  
KR-83M  X  X  
KR-85M  X  X  
KR-85  X  X  
KR-87  X  X  
KR-88  X  X  
KR-89  X  X  
Rb-86 1 X 1 X F 
Rb-87 1 X 1 X F 
Rb-88 1 X 1 X F 
Rb-89 1 X 1 X F 

Sr-85 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Sr-89 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Sr-90 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Sr-91 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Sr-92 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Y-90 0.001 X 0.001  M 
0.001 X S 

Y-91 0.001 X 0.001  M 
0.001 X S 

Y-91m 0.001 X 0.001  M 
0.001 X S 

Y-92 0.001 X 0.001  M 
0.001 X S 

Y-93 0.001 X 0.001  M 
0.001 X S 

Zr-93 0.02 X 
0.02  F 
0.02 X M 
0.02  S 

Zr-95 0.02 X 
0.02  F 
0.02 X M 
0.02  S 

Zr-97 0.02 X 
0.02  F 
0.02 X M 
0.02  S 
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Table E 2 NRCDose3 – ICRP-72 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Nb-93m 0.02 X 
0.02  F 
0.02  M 
0.02 X S 

Nb-95 0.02 X 
0.02  F 
0.02  M 
0.02 X S 

Nb-97 0.02 X 
0.02  F 
0.02  M 
0.02 X S 

Mo-93 1 X 
1  F 

0.2  M 
0.02 X S 

Mo-99 1 X 
1  F 

0.2  M 
0.02 X S 

Tc-99 1 X 
1  F 

0.2 X M 
0.02  S 

Tc-99m 1 X 
1  F 

0.2 X M 
0.02  S 

Tc-101 1 X 
1  F 

0.2 X M 
0.02  S 

Ru-103 0.1 X 

0.1  V 
0.1  F 
0.1  M 

0.02 X S 

Ru-105 0.1 X 

0.1  V 
0.1  F 
0.1  M 

0.02 X S 

Ru-106 0.1 X 

0.1  V 
0.1  F 
0.1  M 

0.02 X S 

Rh-105 0.1 X 
0.1  F 
0.1  M 
0.1 X S 

Pd-107 0.05 X 
0.05  F 
0.05  M 
0.05 X S 

Pd-109 0.05 X 
0.05  F 
0.05  M 
0.05 X S 

Ag-110m 0.1 X 
0.1  F 
0.1  M 

0.02 X S 
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Table E 2 NRCDose3 – ICRP-72 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Ag-111 0.1 X 
0.1  F 
0.1  M 

0.02 X S 

Cd-109 0.1 X 
0.1  F 
0.1  M 
0.1 X S 

Cd-113m 0.1 X 
0.1  F 
0.1  M 
0.1 X S 

Cd-115m 0.1 X 
0.1  F 
0.1  M 
0.1 X S 

Sn-113 0.04 X 0.04  F 
0.04 X M 

Sn-123 0.04 X 0.04  F 
0.04 X M 

Sn-125 0.04 X 0.04  F 
0.04 X M 

Sn-126 0.04 X 0.04  F 
0.04 X M 

Sb-124 0.2 X 
0.2  F 

0.02 X M 
0.02  S 

Sb-125 0.2 X 
0.2  F 

0.02 X M 
0.02  S 

Sb-126 0.2 X 
0.2  F 

0.02 X M 
0.02  S 

Sb-127 0.2 X 
0.2  F 

0.02 X M 
0.02  S 

Te-125m 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-127 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-127m 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-129 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 
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Table E 2 NRCDose3 – ICRP-72 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Te-129m 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-131 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-131m 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-132 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-133m 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

Te-134 0.6 X 

0.6  V 
0.6  F 
0.2 X M 

0.02  S 

I-125 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

I-129 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

I-130 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

I-131 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

I-132 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

Table E 2 NRCDose3 – ICRP-72 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide Ingestion Inhalation 
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f1 Default f1 Default Class 

I-133 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

I-134 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

I-135 1 X 

1 CH3I  V 
1 I2  V 
1 X F 

0.2  M 
0.02  S 

Xe-131m  X  X  
Xe-133m  X  X  
Xe-133  X  X  
Xe-135m  X  X  
Xe-135  X  X  
Xe-137  X  X  
Xe-138  X  X  

Cs-134 1 X 
1 X F 

0.2  M 
0.02  S 

Cs-134m 1 X 
1 X F 

0.2  M 
0.02  S 

Cs-135 1 X 
1 X F 

0.2  M 
0.02  S 

Cs-136 1 X 
1 X F 

0.2  M 
0.02  S 

Cs-137 1 X 
1 X F 

0.2  M 
0.02  S 

Cs-138 1 X 
1 X F 

0.2  M 
0.02  S 

CS-139  X  X  

Ba-133 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Ba-139 0.6 X 
0.6 X F 
0.2  M 

0.02  S 
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Table E 2 NRCDose3 – ICRP-72 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Ba-140 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Ba-141 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Ba-142 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

La-140 0.005 X 0.005  F 
0.005 X M 

La-141 0.005 X 0.005  F 
0.005 X M 

La-142 0.005 X 0.005  F 
0.005 X M 

Ce-141 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Ce-143 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Ce-144 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Pr-143 0.005 X 0.005  M 
0.005 X S 

Pr-144 0.005 X 0.005  M 
0.005 X S 

Nd-147 0.005 X 0.005  M 
0.005 X S 

Pm-147 0.005 X 0.005  M 
0.005 X S 

Pm-148 0.005 X 0.005  M 
0.005 X S 

Pm-148m 0.005 X 0.005  M 
0.005 X S 

Pm-149 0.005 X 0.005  M 
0.005 X S 

Pm-151 0.005 X 0.005  M 
0.005 X S 

Sm-151 0.005 X 0.005 X M 
Sm-153 0.005 X 0.005 X M 
Eu-152 0.005 X 0.005 X M 
Eu-154 0.005 X 0.005 X M 
Eu-155 0.005 X 0.005 X M 
Eu-156 0.005 X 0.005 X M 
Tb-160 0.005 X 0.005 X M 
Ho-166m 0.005 X 0.005 X M 
Tm-170 0.005 X 0.005 X M 
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Table E 2 NRCDose3 – ICRP-72 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Yb-169 0.005 X 0.005  M 
0.005 X S 

Ta-182 0.01 X 0.01  M 
0.01 X S 

W-181 0.6 X 0.6 X F 
W-185 0.6 X 0.6 X F 
W-187 0.6 X 0.6 X F 

Ir-192 0.02 X 
0.02  F 
0.02  M 
0.02 X S 

Au-198 0.2 X 
0.2  F 
0.2  M 
0.2 X S 

Tl-201 1 X 1 X F 
Tl-204 1 X 1 X F 

Pb-210 0.6 X 
0.6 X F 
0.2  M 

0.02  S 

Bi-210 0.1 X 0.1  F 
0.1 X M 

Po-210 1 X 
0.2  F 
0.2 X M 

0.02  S 
RN-222  X  X  

Ra-223 0.6 X 
0.6  F 
0.2 X M 

0.02  S 

Ra-224 0.6 X 
0.6  F 
0.2 X M 

0.02  S 

Ra-225 0.6 X 
0.6  F 
0.2 X M 

0.02  S 

Ra-226 0.6 X 
0.6  F 
0.2 X M 

0.02  S 

Ra-228 0.6 X 
0.6  F 
0.2 X M 

0.02  S 

Ac-225 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Ac-227 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Th-227 0.005 X 
0.005  F 
0.005  M 
0.005 X S 
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Table E 2 NRCDose3 – ICRP-72 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Th-228 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Th-229 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Th-230 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Th-232 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Th-234 0.005 X 
0.005  F 
0.005  M 
0.005 X S 

Pa-231 0.005 X 0.005  M 
0.005 X S 

Pa-233 0.005 X 0.005  M 
0.005 X S 

U-232 0.04 X 
0.04  F 
0.04  M 
0.02 X S 

U-233 0.04 X 
0.04  F 
0.04  M 
0.02 X S 

U-234 0.04 X 
0.04  F 
0.04  M 
0.02 X S 

U-235 0.04 X 
0.04  F 
0.04  M 
0.02 X S 

U-236 0.04 X 
0.04  F 
0.04  M 
0.02 X S 

U-237 0.04 X 
0.04  F 
0.04  M 
0.02 X S 

U-238 0.04 X 
0.04  F 
0.04  M 
0.02 X S 

Np-237 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Np-238 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Np-239 0.005 X 
0.005  F 
0.005 X M 
0.005  S 
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Table E 2 NRCDose3 – ICRP-72 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Pu-236 0.005 X 
0.005  F 
0.005  M 

0.0001 X S 

Pu-238 0.005 X 
0.005  F 
0.005  M 

0.0001 X S 

Pu-239 0.005 X 
0.005  F 
0.005  M 

0.0001 X S 

Pu-240 0.005 X 
0.005  F 
0.005  M 

0.0001 X S 

Pu-241 0.005 X 
0.005  F 
0.005  M 

0.0001 X S 

Pu-242 0.005 X 
0.005  F 
0.005  M 

0.0001 X S 

Pu-244 0.005 X 
0.005  F 
0.005  M 

0.0001 X S 

Am-241 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Am-242m 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Am-243 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cm-242 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cm-243 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cm-244 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cm-245 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cm-246 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cm-247 0.005 X 
0.005  F 
0.005 X M 
0.005  S 
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Table E 2 NRCDose3 – ICRP-72 f1 Values and Ingestion and Inhalation Classes 
(cont.) 

Nuclide Ingestion Inhalation 
f1 Default f1 Default Class 

Cm-248 0.005 X 
0.005  F 
0.005 X M 
0.005  S 

Cf-252 0.005 X 0.005 X M 

E.3 References 

1. ICRP Report No. 30, "Limits for Intakes of Radionuclides by Workers," ICRP 30, Annals 
of the ICRP Vol. 2, Nos. 3/4, 1979. 

2. ICRP Report No. 72, "Age-Dependent Dose to Members of the Public from Intake of 
Radionuclides, Part 5. Compilation of Ingestion and Inhalation Dose Coefficients,” ICRP 
72, Annals of the ICRP Vol. 21, No.1-3, 1996. 
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